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Preparing the Instrument

 

This chapter explains how to prepare the instrument for a run by assembling the polymer blocks, 
syringes, capillary array, buffer, and reservoirs.

 

Performing Spatial Calibration

 

This chapter explains how to calibrate the instrument by mapping the pixel positions of the signal 
from each capillary in the spatial dimension of the CCD camera. 

 

Performing Spectral Calibration

 

This chapter explains how to calibrate the instrument by creating a matrix that corrects for the 
overlapping fluorescence emission spectra of the dyes. 

 

3100/3100-

 

Avant

 

 Data Collection Software and DNA Sequencing

 

This chapter explains how to create a plate record, results group, instrument protocol and analysis 
protocol for sequencing and SeqScape

 

®

 

 analysis.
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 Data Collection Software and Fragment Analysis

 

This chapter explains how to create a plate record, results group, instrument protocol and analysis 
protocol for fragment analysis.

 

Running the Instrument

 

This chapter explains how to load the sample plate in the instrument and perform a run.

 

Maintaining the Instrument

 

This chapter explains how to clean the polymer blocks and syringes.

 

Audit Trails and Access Control

 

This chapter explains how to set up audit trails and control access.
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Preface

 

How to Use This Guide

 

Audience

 

This manual is written for principle investigators and laboratory staff who are planning 
to operate and maintain the ABI P

 

RISM

 

®

 

 3100 and 3100-

 

Avant

 

 Genetic Analyzers.

 

Assumptions

 

This guide assumes the following background:

• Familiarity with Microsoft

 

®

 

 Windows

 

®

 

 2000 operating system. 

• Knowledge of general techniques for handling DNA samples and preparing them 
for electrophoresis. 

• A general understanding of hard drives and data storage, file transfers, and copying 
and pasting.

If you want to integrate the ABI P

 

RISM

 

®

 

 3100 and 3100-

 

Avant

 

 Genetic Analyzers into 
your existing laboratory data flow system, you need networking experience.

 

Text Conventions

 

This guide uses the following conventions: 

•

 

Bold 

 

indicates user action. For example:

Type 

 

0

 

, then press 

 

Enter

 

 for each of the remaining fields.

•

 

Italic 

 

text indicates new or important words and is also used for emphasis. For 
example:

Before analyzing, 

 

always

 

 prepare fresh matrix.

• A right arrow bracket (>) separates successive commands you select from a drop-
down or shortcut menu. For example:

Select 

 

File > Open > Spot Set

 

.

Right-click the sample row, then select 

 

View Filter > View All Runs

 

.

 

User Attention
Words

 

Two user attention words appear in Applied Biosystems user documentation. Each word 
implies a particular level of observation or action as described below:

 

Note:

 

Provides information that may be of interest or help but is not critical to the use of 
the product.

 

IMPORTANT!

 

Provides information that is necessary for proper instrument operation, 
accurate chemistry kit use, or safe use of a chemical.



 

Preface

 

How to Obtain More Information

 

x
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Examples of the user attention words appear below:

 

Note:

 

The size of the column affects the run time.

 

Note:

 

The Calibrate function is also available in the Control Console.

 

IMPORTANT!

 

To verify your client connection to the database, you need a valid Oracle 
user ID and password.

 

IMPORTANT!

 

You must create a separate Sample Entry Spreadsheet for each 
96-well plate.

 

Safety Alert
Words

 

Safety alert words also appear in user documentation. For more information, see “Safety 
Alert Words” on page xii. 

 

How to Obtain More Information

 

Related
Documentation

 

The following related document is shipped with the system:

 

ABI P

 

RISM

 

®

 

 3100/3100-Avant Genetic Analyzers Quick Reference Card– 

 

Contains 
commonly used information and a flowchart of the ABI P

 

RISM

 

®

 

 3100/3100-

 

Avant

 

 Data 
Collection software.

 

Note:

 

For additional documentation, see “Support” on the back cover.

 

Send Us Your
Comments

 

Applied Biosystems welcomes your comments and suggestions for improving its user 
documents. You can e-mail your comments to:

 

techpubs@appliedbiosystems.com
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Safety and
EMC Compliance Information

 

This section includes the following topics: 

 

� Safety Conventions Used in This Document . . . . . . . . . . . . . . . . . . . . . . . . . . xii

� Symbols on Instruments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xiii

� Safety Labels on Instruments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xiv

� General Instrument Safety  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xv

� Chemical Safety  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xvi

� Chemical Waste Safety  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xvii

� Electrical Safety  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xviii

� Physical Hazard Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xviii

� Laser Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xix

� Workstation Safety  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xx

� Safety and Electromagnetic Compatibility (EMC) Standards  . . . . . . . . . . . . xxi

� Laboratory Space Required . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxii

� Laboratory Environmental Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . xxiii
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Safety Conventions Used in This Document

Safety Alert
Words

Four safety alert words appear in Applied Biosystems user documentation at points in 
the document where you need to be aware of relevant hazards. Each alert 
word–IMPORTANT, CAUTION, WARNING, DANGER–implies a particular level of 
observation or action, as defined below:

Definitions

IMPORTANT! – Indicates information that is necessary for proper instrument operation, 
accurate chemistry kit use, or safe use of a chemical.

 – Indicates a potentially hazardous situation that, if not avoided, may 
result in minor or moderate injury. It may also be used to alert against unsafe practices.

 – Indicates a potentially hazardous situation that, if not avoided, 
could result in death or serious injury.

 – Indicates an imminently hazardous situation that, if not avoided, 
will result in death or serious injury. This signal word is to be limited to the most 
extreme situations.

Except for IMPORTANTs, each safety alert word in an Applied Biosystems document 
appears with an open triangle figure that contains a hazard symbol. These hazard 
symbols are identical to the hazard icons that are affixed to Applied Biosystems 
instruments (see “Safety Symbols” on page xiii).

Examples

The following examples show the use of safety alert words:

IMPORTANT! You must create a separate a Sample Entry Spreadsheet for each 96-well 
microtiter plate.

The lamp is extremely hot. Do not touch the lamp until it has cooled 
to room temperature.

CHEMICAL HAZARD. Formamide. Exposure causes eye, skin, 
and respiratory tract irritation. It is a possible developmental and birth defect hazard. 
Read the MSDS, and follow the handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves.

ELECTRICAL HAZARD. Failure to ground the instrument 
properly can lead to an electrical shock. Ground the instrument according to the 
provided instructions.
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Symbols on Instruments

Electrical
Symbols on
Instruments

The following table describes the electrical symbols that may be displayed on 
Applied Biosystems instruments.

Safety Symbols The following table describes the safety symbols that may be displayed on 
Applied Biosystems instruments. Each symbol may appear by itself or in combination 
with text that explains the relevant hazard (see “Safety Labels on Instruments” on 
page xiv). These safety symbols may also appear next to DANGERS, WARNINGS, and 
CAUTIONS that occur in the text of this and other product-support documents.

Symbol Description

Indicates the On position of the main power switch.

Indicates the Off position of the main power switch.

Indicates the On/Off position of a push-push main power switch.

Indicates a terminal that may be connected to the signal ground reference of 
another instrument. This is not a protected ground terminal.

Indicates a protective grounding terminal that must be connected to earth 
ground before any other electrical connections are made to the instrument.

Indicates a terminal that can receive or supply alternating current or voltage.

Indicates a terminal that can receive or supply alternating or direct current or 
voltage.

Symbol Description

Indicates that you should consult the manual for further information and to 
proceed with appropriate caution.

Indicates the presence of an electrical shock hazard and to proceed with 
appropriate caution.

Indicates the presence of a hot surface or other high-temperature hazard and to 
proceed with appropriate caution. 

Indicates the presence of a laser inside the instrument and to proceed with 
appropriate caution.

Indicates the presence of moving parts and to proceed with appropriate caution.
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Safety Labels on Instruments
The following CAUTION, WARNING, and DANGER statements may be displayed on 
Applied Biosystems instruments in combination with the safety symbols described in 
the preceding section. 

English Francais

CAUTION Hazardous chemicals. Read the 
Material Safety Data Sheets (MSDSs) before 
handling.

ATTENTION Produits chimiques dangeureux. 
Lire les fiches techniques de sûreté de 
matériels avant la manipulation des produits.

CAUTION Hazardous waste. Read the waste 
profile (if any) in the site preparation guide for 
this instrument before handling or disposal.

ATTENTION Déchets dangereux. Lire les 
renseignements sur les déchets avant de les 
manipuler ou de les éliminer.

CAUTION Hazardous waste. Refer to 
MSDS(s) and local regulations for handling 
and disposal.

ATTENTION Déchets dangereux. Lire les 
fiches techniques de sûreté de matériels et la 
régulation locale associées à la manipulation 
et l'élimination des déchets.

WARNING Hot lamp. AVERTISSEMENT Lampe brûlante.

WARNING Hot. Replace lamp with an 
Applied Biosystems lamp.

AVERTISSEMENT Composants brûlants. 
Remplacer la lampe par une lampe 
Applied Biosystems.

CAUTION Hot surface. ATTENTION Surface brûlante.

DANGER High voltage. DANGER Haute tension.

WARNING To reduce the chance of electrical 
shock, do not remove covers that require tool 
access. No user-serviceable parts are inside. 
Refer servicing to Applied Biosystems 
qualified service personnel.

AVERTISSEMENT Pour éviter les risques 
d'électrocution, ne pas retirer les capots dont 
l'ouverture nécessite l'utilisation d'outils. 
L’instrument ne contient aucune pièce 
réparable par l’utilisateur. Toute intervention 
doit être effectuée par le personnel de service 
qualifié de Applied Biosystems.

DANGER Class 3B laser radiation present 
when open and interlock defeated. Avoid 
direct exposure to laser beam.

DANGER Class 3B rayonnement laser en cas 
d’ouverture et d’une neutralisation des 
dispositifs de sécurité. Eviter toute exposition 
directe avec le faisceau.

DANGER Class 3B laser radiation when 
open. Avoid direct exposure to laser beam.

DANGER Class 3B rayonnement laser en cas 
d’ouverture. Eviter toute exposition directe 
avec le faisceau.

DANGER Class 2(II) laser radiation present 
when open and interlock defeated. Do not 
stare directly into the beam

DANGER de Class 2(II) rayonnement laser en 
cas d'ouverture et d'une neutralisation des 
dispositifs de securite. Eviter toute exposition 
directe avec le faisceau.

DANGER Class 2(II) laser radiation present 
when open. Do not stare directly into the 
beam. 

DANGER de Class 2(II) rayonnement laser en 
cas d'ouverture. Eviter toute exposition 
directe avec le faisceau.

DANGER Class 2(II) LED when open and 
interlock defeated. Do not stare directly into 
the beam.

DANGER de Class 2(II) LED en cas 
d'ouverture et d'une neutralisation des 
dispositifs de securite. Eviter toute exposition 
directe avec le faisceau.
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General Instrument Safety

PHYSICAL INJURY HAZARD. Use this product only as 
specified in this document. Using this instrument in a manner not specified by 
Applied Biosystems may result in personal injury or damage to the instrument.

Moving and
Lifting the

Instrument

PHYSICAL INJURY HAZARD. The instrument is to be moved 
and positioned only by the personnel or vendor specified in the applicable site 
preparation guide. If you decide to lift or move the instrument after it has been installed, 
do not attempt to lift or move the instrument without the assistance of others, the use of 
appropriate moving equipment, and proper lifting techniques. Improper lifting can cause 
painful and permanent back injury. Depending on the weight, moving or lifting an 
instrument may require two or more persons.

Moving and
Lifting Stand-

Alone Computers
and Monitors

Do not attempt to lift or move the computer or the monitor without 
the assistance of others. Depending on the weight of the computer and/or the monitor, 
moving them may require two or more people.

Things to consider before lifting the computer and/or the monitor:

• Make sure that you have a secure, comfortable grip on the computer or the monitor 
when lifting.

• Make sure that the path from where the object is to where it is being moved is clear 
of obstructions.

• Do not lift an object and twist your torso at the same time.

• Keep your spine in a good neutral position while lifting with your legs.

• Participants should coordinate lift and move intentions with each other before 
lifting and carrying.

• Instead of lifting the object from the packing box, carefully tilt the box on its side 
and hold it stationary while someone slides the contents out of the box.

Operating the
Instrument

Ensure that anyone who operates the instrument has:

• Received instructions in both general safety practices for laboratories and specific 
safety practices for the instrument.

• Read and understood all applicable Material Safety Data Sheets (MSDSs). See 
“About MSDSs” on page xvi.

DANGER Class 2(II) LED when open. Do not 
stare directly into the beam.

DANGER de Class 2(II) LED en cas 
d'ouverture. Eviter toute exposition directe 
avec le faisceau.

CAUTION Moving parts. ATTENTION Parties mobiles.

English Francais
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Chemical Safety

Chemical Hazard
Warning

CHEMICAL HAZARD. Before handling any chemicals, refer to 
the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all 
relevant precautions.

CHEMICAL HAZARD. All chemicals in the instrument, including 
liquid in the lines, are potentially hazardous. Always determine what chemicals have 
been used in the instrument before changing reagents or instrument components. Wear 
appropriate eyewear, protective clothing, and gloves when working on the instrument.

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with 
shipments of hazardous chemicals to new customers. They also provide MSDSs with the 
first shipment of a hazardous chemical to a customer after an MSDS has been updated. 
MSDSs provide the safety information you need to store, handle, transport, and dispose 
of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to 
replace the appropriate MSDS in your files.

Obtaining MSDSs You can obtain from Applied Biosystems the MSDS for any chemical supplied by 
Applied Biosystems. This service is free and available 24 hours a day. 

To obtain MSDSs:

1. Go to https://docs.appliedbiosystems.com/msdssearch.html

2. In the Search field, type in the chemical name, part number, or other information 
that appears in the MSDS of interest. Select the language of your choice, then click 
Search.

3. Find the document of interest, right-click the document title, then select any of the 
following:

• Open – To view the document

• Print Target – To print the document

• Save Target As – To download a PDF version of the document to a destination 
that you choose

4. To have a copy of a document sent by fax or e-mail, select Fax or Email to the left 
of the document title in the Search Results page, then click RETRIEVE 
DOCUMENTS at the end of the document list.

5. After you enter the required information, click View/Deliver Selected Documents 
Now.

Chemical Safety
Guidelines

To minimize the hazards of chemicals:

• Read and understand the Material Safety Data Sheets (MSDS) provided by the 
chemical manufacturer before you store, handle, or work with any chemicals or 
hazardous materials. (See “About MSDSs” on page xvi.)
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• Minimize contact with chemicals. Wear appropriate personal protective equipment 
when handling chemicals (for example, safety glasses, gloves, or protective 
clothing). For additional safety guidelines, consult the MSDS.

• Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (for example, fume hood). For additional safety 
guidelines, consult the MSDS. 

• Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the 
manufacturer’s cleanup procedures as recommended on the MSDS.

• Comply with all local, state/provincial, or national laws and regulations related to 
chemical storage, handling, and disposal.

Chemical Waste Safety

Chemical Waste
Hazard

HAZARDOUS WASTE. Refer to Material Safety Data Sheets and 
local regulations for handling and disposal.

CHEMICAL WASTE HAZARD. Wastes produced by Applied 
Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

Chemical Waste
Safety Guidelines

To minimize the hazards of chemical waste:

• Read and understand the Material Safety Data Sheets (MSDSs) provided by the 
manufacturers of the chemicals in the waste container before you store, handle, or 
dispose of chemical waste.

• Provide primary and secondary waste containers. (A primary waste container holds 
the immediate waste. A secondary container contains spills or leaks from the 
primary container. Both containers must be compatible with the waste material and 
meet federal, state, and local requirements for container storage.) 

• Minimize contact with chemicals. Wear appropriate personal protective equipment 
when handling chemicals (for example, safety glasses, gloves, or protective 
clothing). For additional safety guidelines, consult the MSDS.

• Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (for example, fume hood). For additional safety 
guidelines, consult the MSDS.

• Handle chemical wastes in a fume hood.

• After emptying the waste container, seal it with the cap provided.

• Dispose of the contents of the waste tray and waste bottle in accordance with good 
laboratory practices and local, state/provincial, or national environmental and 
health regulations.

Waste Profiles A waste profile for the ABI PRISM® 3100 and 3100-Avant Genetic Analyzer is provided 
in the ABI PRISM® 3100 and 3100-Avant Genetic Analyzer Site Preparation Guide. 

Waste profiles show the percentage compositions of the reagents in the waste stream 
generated during installation and during a typical user application, even though the 
typical application may not be used in your laboratory.
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The waste profiles help you plan for the handling and disposal of waste generated by 
operation of the instrument. Read the waste profiles and all applicable MSDSs before 
handling or disposing of chemical waste.

Waste Disposal If potentially hazardous waste is generated when you operate the instrument, you must:

• Characterize (by analysis if necessary) the waste generated by the particular 
applications, reagents, and substrates used in your laboratory.

• Ensure the health and safety of all personnel in your laboratory.

• Ensure that the instrument waste is stored, transferred, transported, and disposed of 
according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and 
disposal limitations may apply.

Electrical Safety

ELECTRICAL SHOCK HAZARD. Severe electrical shock can 
result from operating the ABI PRISM® 3100 and 3100-Avant Genetic Analyzer without 
its instrument panels in place. Do not remove instrument panels. High-voltage contacts 
are exposed when instrument panels are removed from the instrument.

Power ELECTRICAL HAZARD. Grounding circuit continuity is vital for 
the safe operation of equipment. Never operate equipment with the grounding conductor 
disconnected.

ELECTRICAL HAZARD. Use properly configured and approved 
line cords for the voltage supply in your facility.

ELECTRICAL HAZARD. Plug the system into a properly 
grounded receptacle with adequate current capacity.

Overvoltage
Rating

The ABI PRISM® 3100 and 3100-Avant Genetic Analyzer system has an installation 
(overvoltage) category of II, and is classified as portable equipment.

Physical Hazard Safety

Moving Parts PHYSICAL INJURY HAZARD. Moving parts can crush and cut. 
Keep hands clear of moving parts while operating the instrument. Disconnect power 
before servicing the instrument.

PHYSICAL INJURY HAZARD. Do not operate the instrument 
without the arm shield in place. Keep hands out of the deck area when the instrument is 
spotting.



ABI PRISM 3100/3100-Avant Genetic Analyzers User Guide xix

Laser Safety
Solvents and Pressurized Fluids

Solvents and
Pressurized

Fluids

PHYSICAL INJURY HAZARD. Always wear eye protection 
when working with solvents or any pressurized fluids.

PHYSICAL INJURY HAZARD. To avoid hazards associated with 
high-pressure fluids in polymeric tubing:

• Be aware that PEEK™ tubing is a polymeric material. Use caution when working 
with any polymer tubing that is under pressure.

• Always wear eye protection when in proximity to pressurized polymer tubing.

• Extinguish all nearby flames if you use flammable solvents.

• Do not use PEEK tubing that has been severely stressed or kinked.

Laser Safety

Laser
Classification

The ABI PRISM® 3100 and 3100-Avant Genetic Analyzer uses an argon laser. Under 
normal operating conditions, the instrument laser is categorized as a Class 3B laser. 
When safety interlocks are disabled during certain servicing procedures, the laser can 
cause permanent eye damage, and, therefore, is classified under those conditions as a 
Class 3B laser.

The ABI PRISM® 3100 and 3100-Avant Genetic Analyzer complies with 21 CFR, 
1040.10 and 1040.11, as applicable.

The ABI PRISM® 3100 and 3100-Avant Genetic Analyzer has been tested to and 
complies with the “Radiation Control for Health and Safety Act of 1968 Performance 
Standard CFR 1040.”

The ABI PRISM® 3100 and 3100-Avant Genetic Analyzer has been tested to and 
complies with standard EN60825-1, “Radiation Safety of Laser Products, Equipment 
Classification, Requirements, and User’s Guide.”

Laser Safety
Requirements

To ensure safe laser operation:

• The system must be installed and maintained by an Applied Biosystems Technical 
Representative.

• All instrument panels must be in place on the instrument while the instrument is 
operating. When all panels are installed, there is no detectable radiation present. If 
any panel is removed when the laser is operating (during service with safety 
interlocks disabled), you may be exposed to laser emissions in excess of the Class 
3B rating.

• Do not remove safety labels or disable safety interlocks.
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Additional Laser
Safety

Information

Refer to the user documentation provided with the laser for additional information on 
government and industry safety regulations.

LASER HAZARD. Lasers can burn the retina causing permanent 
blind spots. Never look directly into the laser beam. Remove jewelry and other items that 
can reflect the beam into your eyes. Do not remove the instrument top or front panels. 
Wear proper eye protection and post a laser warning sign at the entrance to the laboratory 
if the top or front panels are removed for service.

LASER BURN HAZARD. An overheated laser can cause severe 
burns if it comes in contact with the skin. DO NOT operate the laser when it cannot be 
cooled by its cooling fan. Always wear appropriate laser safety goggles.

Workstation Safety
Correct ergonomic configuration of your workstation can reduce or prevent effects such 
as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your 
workstation to promote neutral or relaxed working positions.

MUSCULOSKELETAL AND REPETITIVE MOTION 
HAZARD. These hazards are caused by potential risk factors that include but are not 
limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy 
positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:

• Use equipment that comfortably supports you in neutral working positions and 
allows adequate accessibility to the keyboard, monitor, and mouse.

• Position the keyboard, mouse, and monitor to promote relaxed body and head 
postures.
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Safety and Electromagnetic Compatibility (EMC) Standards
This section provides information on:

• U.S. and Canadian Safety Standards

• Canadian EMC Standard

• European Safety and EMC Standards

• Australian EMC Standards

U.S. and
Canadian Safety

Standards

This instrument has been tested to and complies with standard UL 3101-1, “Safety 
Requirements for Electrical Equipment for Laboratory Use, Part 1: General 
Requirements.”

This instrument has been tested to and complies with standard CSA 1010.1, “Safety 
Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use, 
Part 1: General Requirements.”

Canadian EMC
Standard

This instrument has been tested to and complies with ICES-001, Issue 3: Industrial, 
Scientific, and Medical Radio Frequency Generators.

European Safety
and EMC

Standards

Safety

This instrument meets European requirements for safety (Low Voltage Directive 
73/23/EEC). This instrument has been tested to and complies with standards EN 61010-
1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and 
Laboratory Use, Part 1: General Requirements” and EN 61010-2-010, “Particular 
Requirements for Laboratory Equipment for the Heating of Materials.”

EMC

This instrument meets European requirements for emission and immunity (EMC 
Directive 89/336/EEC). This instrument has been tested to and complies with standard 
EN 61326 (Class B), “Electrical Equipment for Measurement, Control and Laboratory 
Use – EMC Requirements.”

Australian EMC
Standards

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits 
and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial, 
Scientific, and Medical (ISM) Radio-frequency Equipment.”
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Laboratory Space Required

Dimensions and
Weight

The ABI PRISM 3100 and 3100-Avant Genetic Analyzers and computer have the 
following dimensions: 

Typical
Laboratory

Layout

A typical laboratory layout is shown below.

Component Width Depth Height Weight

3100/3100-Avant Genetic 
Analyzer, crated

94 cm
(37 in.)

70 cm
(27.5 in.)

105 cm
(41.5 in.)

142 kg
(313 lb)

3100/3100-Avant Genetic 
Analyzer, uncrated

74 cm
(29.2 in.)

54.8 cm
(21.6 in.)

81 cm
(32 in.)

120 kg
(265 lb)

3100/3100-Avant Genetic 
Analyzer with all required 
clearances

148.6 cm
(58.5 in.)

67 cm
(26.4 in.)

111 cm
(44 in.)

–

Computer CPU 21 cm 
(8.3 in.)

44 cm 
(17.4 in.)

44 cm 
(17.4 in.)

10 kg 
(25 lb)

Monitor 42 cm 
(16.6 in.)

53 cm 
(20.9 in.)

44 cm 
(17.4 in.)

18 kg
(40 lb)

GR1771b
3100
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Laboratory Environmental Requirements

Altitude This instrument is for indoor use only and for altitudes not exceeding 2000 m (6500 ft) 
above sea level.

Temperature and
Humidity

The laboratory temperature should be maintained between 15 to 30 °C (59 to 86 °F), and 
remain stable at the set temperature (within ± 2 ˚C). The instrument can tolerate between 
20 to 80% relative humidity. Avoid placing the instrument adjacent to heaters or cooling 
ducts, or in direct sunlight.

Pollution Degree
and Overvoltage

Protection

The installation category (overvoltage category) for this instrument is II, and it is 
classified as portable equipment. The instrument has a pollution degree rating of 2 and 
may be installed in an environment that has nonconductive pollutants only.

Electrical Requirements

Power The following table specifies the electrical operating range for various parts of the 
world:

IMPORTANT! In Japan, the unit must have a dedicated 200-volt outlet. The unit will not 
operate properly with a 100-volt outlet. 

Power Line The electrical receptacle must have a dedicated 2.5 kVA power line and ground. 

Electrical Outlets The instrument requires a 30 amp receptacle to match one of the two power cord 
configurations that ship with the system. See the “Power Cords” section below.

The electrical receptacle must be located within 3 m (10 ft) of the back of the instrument. 
Do not use extension cords.

IMPORTANT! Despite the apparent dissimilarity between the capacity requirements for 
the power line (2.5 KVA) and the receptacle (30 A), these are the system requirements. 

Power Rating This instrument is rated for a maximum input of 2500 VA.

Power Cords In the USA, Canada, and Japan, the instrument is supplied with a detachable cord 
equipped with a Nema L6-30P plug.

In Europe and Australia, the instrument is supplied with a detachable electrical cord 
equipped with an IEC 309 plug.

Location Voltage (VAC) Frequency Maximum
Current (A)

Japan 200 to 229 
230 to 240

50/60 Hz ±1% 11.2

USA/Canada 60 Hz ±1%

Europe 50 Hz ±1%

Australia 50 Hz ±1%
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The computer, CPU and monitor, can be plugged into any standard electrical receptacles 
after they have been configured for the proper voltage.

Grounding Certain types of electrical noise are greatly exaggerated by poor or improper electrical 
ground connections. To prevent these problems, it is very important to have a dedicated 
ground line between the instrument and the building’s main electrical service.

Power Line
Regulator

In areas where the supplied power is subject to voltage fluctuations that exceed ±10% of 
the nominal voltage (see the section, “Power,” above) a power line regulator may be 
required. High or low voltages can have adverse effects on the electronic components of 
the instrument. 

Voltage
Fluctuations

Main supply voltage fluctuations not to exceed +/- 10% of the nominal voltage.

Voltage Spikes Short-duration, high-voltage spikes often cause random failures in microprocessor-
controlled instrumentation. These spikes can be caused by other devices using the same 
power source (refrigerators, air conditioners, and centrifuges) or by outside influences 
such as lightning. A dedicated line and ground between the instrument and the building’s 
main electrical service will prevent such problems.

If your environment contains devices that are electrically noisy, or you are in an area 
with frequent electrical storms, a line conditioner with a recommended capacity of 
1.0 kVA will enhance the reliability of your system.

Power Outages The instrument has not been designed to continue with a run after power failure. A run 
that has been interrupted by power failure must be restarted. For this reason, we 
recommend that you protect against power outage by installing an uninterruptible power 
supply (UPS) with an output capacity of 2.5 kVA (30 minutes at 2.4 kVA after full 
charge). We recommend the UPS from Franek Company. The order number for the 
appropriate UPS is FT1-B3100-DA. Franek’s phone number is 1-800-326-6480, their 
fax number is 714-554-6957, their website is www.Franek-tech.com, and their E-mail 
address is sales@Franek.tech.com.
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Introduction

A Typical Run This flowchart provides an overview of the steps required to perform a run on the 
ABI PRISM® 3100/3100-Avant Genetic Analyzers.

Spatial calibration done?

Power on computer, then
power on instrument

Launch ABI PRISM® 3100 or 
3100-Avant Data Collection 
software 

Set up instrument:
  • Prepare syringes
  • Install capillary array
  • Add/change polymer
  • Fill reservoirs

Prepare samples and store 
plate on ice

Create plate record files:
  • Instrument protocol
  • Analysis protocol
  • Results group
  • Files from analysis software

Assemble plate and place
 on autosampler

Search and select plate record,
then link plate  

Launch Autoanalysis Manager
for analysis using SeqScape®

and GeneMapper™ software

Start and monitor run

Perform calibration

Display and check calibrationDon't know

Yes No

Spectral calibration for dye set
 and array length done?

Perform calibration

Display and check calibration
Don't know

Yes No

Need to set active
spectral calibration?

Set active spectral calibration

Yes No

G
R
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c

Create and save plate record

View and archive data
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Instrument
Description

The following diagram shows inside the instrument’s doors:

Instrument Components

Number and Part Function

1. Anode buffer reservoir Contains 9 mL of 1X running buffer.

2. Buffer and water 
reservoirs (four)

Contains 16 mL of 1X running buffer or water.

3. Autosampler Holds the sample plates and reservoirs and moves to align 
the samples, water, or buffer with the capillaries.

4. Capillary array Enables the separation of the fluorescent-labeled DNA 
fragments by electrophoresis. It is a replaceable unit 
composed of 4 or 16 silica capillaries.

5. Detection cell Holds the capillaries in place for laser detection.

6. Lower polymer block Contains the anode electrode. The anode buffer reservoir 
connects to this block.

7. Oven Maintains uniform capillary array temperature.

8. Polymer-reserve syringe Contains and dispenses the polymer that fills the polymer 
blocks and the array-fill syringe. A 5-mL syringe.

9. Array-fill syringe Contains and dispenses the polymer under high pressure 
to fill the capillaries. A 250-µL syringe.

10. Upper polymer block Connects the two syringes and the detection end of the 
capillary array.

5. Detection cell 

4. Capillary array

3. Autosampler

10.Upper
polymer block

1. Anode buffer reservoir

9. Array-fill syringe

8. Polymer-reserve syringe

6. Lower polymer block

2. Buffer and water
reservoirs

7. Oven
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Summary of
Applications

*20 GT/injection, †1bp resolution at 99.99% accuracy 

Application Polymer Capillary 
Length

Run 
Time

Throughput (24 hrs)

Resolution Performance
3100-
Avant 3100

High throughput, small 
size fragment analysis

POP-4

22 cm 20 min 5,760* GT 23,040* GT 400 bp 0.50 SD†

Standard fragment 
analysis

36 cm

45 min 2,560* GT 10,240* GT 400 bp 0.15 SD

Ultra rapid sequencing 40 min 72,000 bp 288,000 bp 500 bp
98.5% base 

calling 
accuracy

Rapid sequencing POP-6 60 min 48,000 bp 192,000 bp 500 bp
98.5% base 

calling 
accuracy

Standard sequencing
POP-4

50 cm

100 min 34,500 bp 138,000 bp 600 bp
98.5% base 

calling 
accuracy

Long fragment analysis 65 min 1,760* GT 7,040* GT 500 bp 0.15 SD

Standard sequencing
POP-6

2.5 hrs 23,400 bp 93,600 bp 650 bp
98.5% base 

calling 
accuracy

Long fragment analysis 90 min 1,200* GT 4,800* GT 500 bp 0.15 SD

Long read sequencing POP-4 80 cm 3.5 hrs 22,800 bp 91,200 bp 950 bp
98.5% base 

calling 
accuracy
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Starting the 3100/3100-Avant System

Starting the Computer Workstation

1. Power on the monitor.

2. Power on the computer. 

3. Press Ctrl + Alt + Delete.

4. In the Log on to Windows dialog box:

a. Enter the user name. 

b. If applicable, enter a password.

c. Click .

IMPORTANT! You must start the computer 
workstation before starting the instrument.

4a

4b

4c

Note: If the computer is connected to a 
network, you do not need to log on to the 
network before starting the instrument.
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Starting the 
3100/3100-Avant Genetic Analyzer

1. On the instrument, ensure that the:

• Oven door is closed and locked

• Instrument doors are closed

2. On the computer, ensure that the:

• Computer is powered on (see “Starting the 
Computer Workstation” on page 6)

• Microsoft® Windows® 2000 operating 
system has loaded

3. Turn on the instrument by pressing the on/off 
button on the front of the instrument.

4. Ensure the green status light is on and constant 
before proceeding. 

Note: If the doors are open during power on, the 
red failure light will illuminate.

Note: The computer must be on and running the 
Windows 2000 operating system because the 
instrument must copy the firmware from the 
computer.

Press the on/off button to start the instrument

Status lights 

Note: While the instrument is booting up and 
performing self-checks, the yellow status light 
blinks. 

Note: If the green light does not come on, start 
the data collection software and look at the log. 
The pathway to the log is:

E:\AppliedBiosystems\UDC\Data Collection\
Log\Instrument Name
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3100/3100-Avant Data Collection Software

Starting the 3100/3100-Avant Data 
Collection Software

1. Select Start > Programs > Applied Biosystems 
> Data Collection > Run Data Collection 3100 
v2.0 or Run Data Collection 3100-Avant v2.0.

The Service Console displays. By default, all 
applications are off as indicated by the red 
circles. However, they launch automatically with 
the 3100/3100-Avant Data Collection software.

As each application automatically activates, the 
red circles (off) change to yellow triangles 
(activating), to green squares (on) when they are 
fully functional.

When all the applications are running (all green 
squares–this could take several minutes), the 
Data Collection Viewer window displays. 

Off

On 

Activating
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2. Click the + to expand subfolders in the left 
window pane. All application folders—except 
for Run History— are now visible and ready to 
access.

Audit Trail and Access Control

The new Data Collection Software v2.0 incorporates 
Audit Trail and Access Control features to assist users 
with 21CFR Part 11 compliance. When the software 
is installed, the default configuration for these features 
are deactivated.

To activate these features and set up the software, 
refer to “Audit Trails and Access Control” on 
page 241.

3100 Data Collection Viewer window 3100-Avant Data Collection Viewer window

Model Name 
(default)

Instrument Name

Model Name 
(default)

Instrument Name
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Preparing the Instrument 

Attaching the Polymer Blocks to the 
Instrument

1. Open the instrument doors.

2. If necessary, clean the polymer blocks and the 
tubing as instructed on page 223.

3. Connect the polymer tubing to the upper polymer 
block by inserting one ferrule and nut into the 
upper polymer block and rotate counter 
clockwise until finger tight.

4. Push the upper polymer block onto the two guide 
pins on the instrument. Leave a 1-inch gap 
between the block and the back of the 
instrument. 

5. Install the lower polymer block. Ensure the block 
is pushed all the way against the instrument.
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6. Connect the polymer tubing the lower polymer 
block by inserting the other ferrule and nut into 
the lower polymer block and rotate clockwise 
until finger tight.

7. Install clean drip trays, if they are not already on 
the instrument.

Selecting a Capillary Array

Use the tables below to select the correct capillary 
array length for your sequencing or fragment analysis 
application.

GR2191b

IMPORTANT! Do not overtighten.

Fragment Analysis Applications or Kits Capillary
Length (cm)

 ABI PRISM® SNaPshot® Multiplex System
22

36

• ABI PRISM® Linkage Mapping Set v2.5

• ABI PRISM® Mouse Mapping Set v1.0

• Custom oligos

22

36

50

• AmpFlSTR® COfiler® Kit

• AmpFlSTR® Profiler® Plus Kit

• AmpFlSTR® Profiler Plus ID® Kit

• AmpFlSTR® SGM Plus® Kit

• Other 4-Dye AmpFlSTR Kits

• AmpFlSTR® Identifiler® Kit

• AmpFlSTR® SEfiler® Kit

• Other 5-Dye AmpFlSTR Kits

36

Sequencing Applications Capillary 
Length (cm)

Ultra rapid sequencing 36

Rapid sequencing 36

Standard sequencing 50

Long read sequencing 80
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Installing or
Replacing the

Capillary Array

If necessary, install a capillary array using the Install Capillary Array wizard. For 
instructions, see “Installing, Removing, or Replacing a Capillary Array” on page 211.

Alternatively, you can install the capillary array without using the wizard. Update the 
capillary array information using the Update Capillary Array Info utility. For 
instructions, see “Manually Installing a Capillary Array” on page 212.

.

Selecting the
Polymer

There are two polymer types available for use on the 3100/3100-Avant system: 
ABI PRISM® POP-4™ and ABI PRISM® POP-6™. Use the following table to select the 
correct polymer for your application and capillary array length.

IMPORTANT! The capillary array length defined in either wizard must match the array 
length you are using for correct autoanalysis results. 

IMPORTANT! If you installed or replaced an array that is a different length than the one 
you were using, you must reset the active spectral calibration (see page 59) or create a 
new spectral calibration for the dye set and array length combination (see 
Chapter 3, page 41).

Polymer types: Sequencing Applications

Sequencing Run Type Capillary
Length Polymer

Ultra rapid sequencing 36 POP-4

Standard sequencing 50

Long read sequencing 80

Rapid sequencing 36 POP-6

Standard sequencing 50

Fragment Analysis Applications 

Fragment Analysis Kit Capillary
Length Polymer

 ABI PRISM SNaPshot Multiplex System
22 POP-4

36

• ABI PRISM® Linkage Mapping Set v2.5

• ABI PRISM® Mouse Mapping Set v1.0

• Custom oligos

22

36

50

50 POP-6
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When to Add or
Change Polymer

If syringes containing polymer are on the instrument, use the table below to determine 
whether to add or change the polymer before proceeding with instrument preparation.

• AmpFlSTR® COfiler® Kit

• AmpFlSTR® Profiler® Plus Kit

• AmpFlSTR® Profiler Plus ID® Kit

• AmpFlSTR® SGM Plus® Kit

• Other 4-Dye AmpFlSTR Kits

• AmpFlSTR® Identifiler® Kit

• AmpFlSTR® SEfiler® Kit

• Other 5-Dye AmpFlSTR Kits

36 POP-4

Fragment Analysis Applications (continued)

Fragment Analysis Kit Capillary
Length Polymer

Su M T W Th F S IMPORTANT! Always replace polymer on the instrument that is older than 1 week.

If polymer on the instrument is ... Then ...

less than 1 week old, and sufficient in 
quantity to complete your runsa

a. A 3100 run uses 50-80 µL of polymer and a 3100-Avant run uses ~20 µL of polymer. 

Ensure that there are no air bubbles, and then 
proceed with instrument preparation.

less than 1 week old, and insufficient in 
quantity to complete your runs

Fill the syringes and the upper polymer block 
with polymer by following the Change 
Polymer wizard (see page 207).

more than 1 week old 1. Remove and clean the polymer blocks and 
syringes (see “Polymer Blocks” on 
page 223 and “Syringes” on page 216).

2. Fill the syringes and the upper polymer 
block with polymer by following the 
Change Polymer wizard (see page 207).

wrong type (changing between POP-4 and 
POP-6 polymers)
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Preparing and Installing the Syringes

1. If necessary, clean and inspect the syringes as 
instructed on page 217.

2. Prime and fill the syringes as instructed on 
page 219.

3. Install the syringes using the Change Polymer 
wizard. For instructions, see “Adding and 
Changing the Polymer” on page 207.

IMPORTANT! Wear gloves while 
performing the following procedure, 
and any other time you handle the 
capillary array, glass syringes, septa, 
or buffer reservoirs. 

CHEMICAL HAZARD. POP 
polymer may cause eye, skin, and respiratory tract 
irritation. Please read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves. Use for research and development 
purposes only.

IMPORTANT! The polymer type defined in the 
wizard must match the polymer you are using. 

Install the 
polymer-reserve 
syringe

Install the array-
fill syringe

IMPORTANT! Ensure that there are no air 
bubbles in the upper polymer block and polymer 
block tubing before proceeding. To remove any 
air bubbles, see page 228.
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Preparing Buffer and Filling the Reservoirs

Required Materials

The following materials are required to prepare 1X 
running buffer:

• 10X Genetic Analyzer Buffer (P/N 402824)

• Quality deionized water

• 50 mL graduated cylinder

Preparing Buffer for a Single Run

1. Add 5 mL of 10X Genetic Analyzer buffer into a 
graduated cylinder.

2. Add deionized water to bring the total volume up 
to 50 mL.

3. Mix well.

Storing the Buffer

The 1X running buffer can be stored at: 

• 2 to 8 °C for up to 1 month

• Room temperature for 1 week

CHEMICAL HAZARD. 10X 
Genetic Analyzer Buffer with EDTA may cause eye, 
skin, and respiratory tract irritation. Read the MSDS, and 
follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

50 mL 
total

45 mL DI H2O

5 mL 10X Genetic 
Analyzer buffer

50 mL graduated cylinder

Buffer Storage Conditions

Option A Option B

Su M T W Th F S

2 °C to 
8 °C

1 month

20 °C to 
25 °C

7 days

Su M T W Th F S
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Replacing the Buffer

Replace the 1X running buffer in the anode buffer 
reservoir and the cathode buffer reservoir daily, or 
before each batch of runs. 

Filling the Water and Cathode Buffer 
Reservoirs

1. Verify the oven and instrument doors are closed.

2. Press the Tray button on the outside of the 
instrument to bring the autosampler to the 
forward position.

3. Wait until the autosampler has stopped moving, 
then open the instrument doors. 

IMPORTANT! Failing to replace buffer may lead to 
loss of resolution and data quality.

IMPORTANT! Replenishing buffer and placing the 
plate requires that the autosampler be in the forward 
position, with the capillary tips removed from the 
buffer solution. Do not leave the autosampler in this 
position for an extended time because the capillaries 
can dry out. 

IMPORTANT! Wear gloves while 
performing the following procedure, 
and any other time you handle the 
capillary array, glass syringes, septa, 
or buffer reservoirs.

Tray button 
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4. Remove the cathode buffer reservoir and water 
reservoirs from the instrument.

5. Dispose of remaining fluids and rinse out the 
reservoirs with deionized water.

6. Rinse the cathode reservoir with 1X running 
buffer, and then fill to the line with 1X running 
buffer (about 16 mL).

7. Fill the three water reservoirs to the line with 
quality deionized water (about 16 mL). 

 8. Place a clean reservoir septa on each reservoir, 
and dry the outside of the reservoirs using a 
lint-free wipe.

9. Place the reservoirs into position on the 
autosampler as shown below.

10. Close the instrument doors.

Remove

Note: The waste is very dilute; however, you 
should follow your company’s waste disposal 
practices for appropriate disposal procedures. 

G
R
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b

Fill line

Be sure that the septa fit snugly and 
flush on the tops of the reservoirs in order to prevent 
damaging the capillary tips.

Septa is lying flat on 
the reservoir 

Fill line

Water reservoir
(rinse)

Cathode reservoir
(1X running buffer)

Water reservoir
(waste)

Water reservoir 
(spare)

Home position

Note: Closing the doors returns the autosampler 
to the last known position, placing the tips of the 
capillaries in water or buffer.
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Filling the Anode Buffer Reservoir

Change the anode buffer:

• Every 24 hours

• Before each run or batch of runs

• Every time you fill the polymer block with new 
polymer

1. Remove the anode buffer reservoir by firmly 
pulling down and twisting slowly. 

2. Discard the used buffer appropriately.

3. Clean and rinse the reservoir with deionized 
water, and then rinse with buffer.

4. Fill the anode buffer reservoir to the fill line with 
fresh 1X running buffer (about 9 mL). 

5. Put the anode buffer reservoir on the instrument.

6. If the reservoir fills with fluid, repeat this 
procedure to discard and replace the running 
buffer. 

Change the Anode Buffer

Every 24 hours Before each run 
or batch of runs

GR2190

Every time you add 
new polymer 

Fill line

Note: The meniscus should line up with the fill 
line.

Note: The reservoir could fill during bubble 
clearing of the polymer blocks.
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Plate Mapping

Introduction Samples are scheduled for injection based on plate configuration to help arrange samples 
with high priority, run a plate that is partially filled and/or run a multiple application 
plate.

The instrument injects samples using a system that schedules runs based on the 
following criteria:

1. The order the plates are linked (3100 instrument only), see page 155 for linking plate 
information.

2. The priority value for samples in the plate record.

If all priorities are set to 100 (default), runs are scheduled as outlined below. Refer to 
“Run Priority Scheduling” on page 262 for information on how a change in the priority 
value changes run scheduling.

96-Well Plate Mapping

3100 Instrument For a 96-well plate, injections are made from every well in two consecutive rows, 
starting with an odd row. A full 96-well plate requires six runs to inject all samples.

In the following example of a 96-well plate, the gray circles represent samples and the 
number in the well indicates capillary number. It takes three runs to inject 48 samples.

Below is an example of incorrect sample placement. To inject 32 samples using this 
configuration would require four runs.

ABCDEFGH

1

13579111315

246810121416

13579111315

246810121416

13579111315

246810121416

2
3

4
5

6

Run 1

Run 2

Run 3

ABCDEFGH

1
2

3
4

5
6

7
8

13579111315

246810121416

13579111315

246810121416

13579111315

246810121416

13579111315

246810121416

Run 1

Run 2

Run 3

Run 4
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3100-Avant
Instrument

For a 96-well plate, injections are made from four consecutive wells in a row. A full plate 
of 96 sample requires 24 runs to inject all samples once.

In the following example of a 96-well plate, the gray circles represent samples and the 
number in the well indicates capillary number. It takes four runs to inject 16 samples. 

384-Well Plate Mapping

3100 Instrument For a 384-well plate, injections are made from every other well and every other row. A 
full plate of 384 sample requires 24 runs to inject all samples once.

Below is an example of the injection pattern for the first four injections, starting with 
well A01. The light gray circles represent samples and the dark gray circles indicate the 
injection pattern.

ABCDEFGH

1

12341234

12341234

2
3

4

Run 4 Run 3

Run 1Run 2

G
R

1316c

ABCDEFGHIJKLMNOP

1
2

3
4

5
6

7
8

9

G
R

1316c

ABCDEFGHIJKLMNOP

1
2

3
4

5
6

7
8

9

Run 1 Run 2

G
R

1316c

ABCDEFGHIJKLMNOP

1
2

3
4

5
6

7
8

9

G
R

1316c

ABCDEFGHIJKLMNOP

1
2

3
4

5
6

7
8

9

Run 4Run 3
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3100-Avant
Instrument

For a 384-well plate, injections are made from every other well. A full plate of 384 
sample requires 96 runs to inject all samples once.

Below is an example of the injection pattern for the first six injections, starting with well 
A01. The light gray circles represent samples and the dark gray circles indicate the 
injection pattern.

ABCDEFGHIJKLMNOP

1
2

3
4

5
6

7
8

9
10

11
12

13
14

15
16
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1
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3
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5
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7
8

9
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14

15
16

1

ABCDEFGHIJKLMNOP

1
2

3
4

5
6

7
8

9
10

11
12

13
14

15
16

1

Run 1 Run 2 Run 3

ABCDEFGHIJKLMNOP

1
2

3
4

5
6

7
8

9
10

11
12

13
14

15
16

1

ABCDEFGHIJKLMNOP

1
2

3
4

5
6

7
8

9
10

11
12

13
14

15
16

17
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3
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5
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7
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9
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1
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Preparing and Loading Samples
References for Sample Preparation

For information on required materials, sample 
preparation, and plate centrifugation, refer to the 
appropriate guide as follows:

Loading the Samples

1. Dispense 10 to 30 µL of the denatured samples 
into the wells of a 96 well plate or 
5 to 15 µL into the wells of a 384 well plate.

2. Seal the plate:

a. Place the plate on a clean, level surface.

b. Lay the septa flat on the plate.

c. Align the holes in the septa strip with the 
wells of the plate, then firmly press 
downward onto the plate.

3. Briefly centrifuge the plate.

4. Remove the plate from the centrifuge and verify 
that each sample is positioned correctly in the 
bottom of its well.

5. If the reagents of any well contain bubbles or are 
not located at the bottom of the well, repeat 
steps 3 and 4.

6. Leave the plate on ice until you are ready to 
prepare the plate assembly and place the 
assembly on the autosampler.

CHEMICAL HAZARD. All 
chemicals on the instrument, including liquid in the 
lines, are potentially hazardous. Please read the 
MSDS, and follow the handling instructions. Wear 
appropriate eyewear, protective clothing, and gloves 
when working on the instrument.For samples of … Refer to the...

DNA sequencing  Individual kit protocols

Fragment analysis 

IMPORTANT! Do not heat plates that are 
sealed with septa.

0:05<1500 × g

Prepared standard

Sample is at the 
bottom of the well
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1
Where to Go Next

Use the table below to determine which chapter to proceed to next.

Do you need to… Proceed to …

Create a valid spatial calibration for the array you are using? Chapter 2, page 26

Create a spectral calibration for the array length and dye set you 
are using?

Chapter 3, page 37

Set the active spectral calibration? You must set the active 
spectral, if you changed the array length. 

IMPORTANT! If you do not have a spectral for the dye set and 
array length you are using, perform a new spectral calibration.

Chapter 3, page 59

Set up the software for sequencing analysis runs? Chapter 4, page 73

Set up the software for SeqScape analysis runs? Chapter 4, page 99

Set up the software for fragment analysis runs? Chapter 5, page 123

Perform maintenance, use wizards? Chapter 7, page 195

Activate/modify the audit trail and access control features? Chapter 8, page 241
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Performing Spatial Calibration

This chapter covers:

� Spatial Calibration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Spatial Calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
When to Perform the Calibration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
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Spatial Calibration

Overview

Spatial
Calibration

A spatial calibration maps the pixel positions of the signal from each capillary in the 
spatial dimension of the CCD camera. 

When to Perform
the Calibration

A spatial calibration must be performed after each time you:

• Install or replace a capillary array

• Temporarily remove the capillary array from the detection block

• Move the instrument

Performing and Evaluating a Spatial Calibration

Performing a
Spatial

Calibration

1. In the Tree pane of the Data Collection Software, click 
 GA Instruments >  ga3100 or ga3100-Avant >  instrument 

name >  Spatial Run Scheduler.

Spatial 
profile

Start and 
Accept or 
Reject 
Spatial 
profile here

Positions (pixel) 
of each capillary
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2. In the Spatial Protocols section, select one of the 
following:

• If the capillaries contain fresh polymer, 
select Protocol > SpatialNoFill_1

• Otherwise, select Protocol  > SpatialFill_1 

3. Click . 

The calibration run lasts approximately:

• 2 min without filling the capillaries

• 6 min with filling the capillaries

Evaluating a Spatial Calibration

1. Evaluate the spatial calibration profile.

While viewing the calibration profile, use the 
following criteria to evaluate the data:

Select one

Note: You do not need to fill the capillaries each 
time you perform a spatial calibration. 

Start spatial calibration

Note: The spatial profile window turns black 
when you start a spatial calibration. 

Spatial calibration profile for 3100 system

Spatial calibration profile for 3100-Avant system

Peak
Attribute Criteria

Height Similar heights for all peaks.

Orange
crosses

One orange cross marking the top 
of every peak. No misplaced 
crosses.

Shape Single sharp peak for each 
capillary.

Small shoulders are acceptable.

Spacing Position values are 13–16 higher 
than the previous one for every 
capillary. Theoretical spacing 
between capillaries is 15.
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2. Examine each row in the 16 or 4 Capillary 
Positions table and verify that the values in the 
Left spacing and Right spacing columns are 13 
to 16 pixels.

To move a cross: 

a. Type a new value in the Positions (pixels) 
box for the capillary of interest. 

b. Click outside of that box or press Enter.

Accepting or Rejecting a Spatial 
Calibration

1. Accept or reject the spatial calibration as 
follows:

If the calibration:

• Passed, click  to write the 
calibration data to the database and .ini file.

• Failed, click , then go to “If the 
Spatial Calibration Fails” on page 29.

Left spacing and
Right spacing columns

Accept and 
Reject buttons
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Troubleshooting 

If the Spatial Calibration Fails 

If the calibration failed, or if you do not like the appearance of the profile, try one or more of the following actions:

1. Click , then go to step 1 on page 26 and 
repeat the spatial calibration.

2. If the calibration fails:

a. Open the Instrument door.

b. Open the oven door.

c. Open the detection cell door.

d. Remove the bundle tip of the capillary array from 
the upper polymer block.

e. Add one drop of methanol to a sterile swab or lint-
free wipe.

f. Gently clean the front surface of the detection cell 
using the sterile swab or lint-free wipe.

g. Replace the bundle tip of the capillary array into 
the upper polymer block.

h. Close the detection cell door.

i. Close the oven door.

j. Close the Instrument door.

k. Go to step 1 on page 26 to repeat the calibration.

3. If the calibration fails again:

a. Perform “Adding and Changing the Polymer” on 
page 207 to fill the capillaries with polymer.

b. Go to step 1 on page 26 to repeat the spatial 
calibration.

4. If the calibration fails again:

a. Perform steps 2a through 2c.

b. Reposition the capillary array window in the 
detection cell.

c. Perform steps 2h through 2j.

d. Go to step 1 on page 26 to repeat the calibration.

5. If the calibration fails again, replace the capillary array 
as explained on “Installing and Removing the 
Capillary Array” on page 210.

CHEMICAL HAZARD. Methanol is a 
flammable liquid and vapor. Exposure may cause eye, skin, and 
respiratory tract irritation, and central nervous system 
depression and blindness. Read the MSDS, and follow the 
handling instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

Detection cell door

Bundle tip of the 
capillary array

GR2144

Front surface of the 
detection cell
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Examples of Spatial Profiles

Passing Profile
from a 3100
Instrument

Passing Profile
from a

3100-Avant
Instrument

Failing Profile
from a 3100
Instrument
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Where to Go Next
Use the table below to determine which chapter to proceed to next.

Do you need to… Proceed to …

Create a spectral calibration for the array length and dye set you 
are using?

Chapter 3, page 37

Set the active spectral calibration? You must set the active 
spectral, if you changed the array length. 

IMPORTANT! If you do not have a spectral for the dye set and 
array length you are using, perform a new spectral calibration.

Chapter 3, page 59

Set up the software for sequencing analysis runs? Chapter 4, page 73

Set up the software for SeqScape runs? Chapter 4, page 99

Set up the software for fragment analysis runs? Chapter 5, page 123

Perform maintenance, use wizards? Chapter 7, page 195

Activate/modify the audit trail and access control features? Chapter 8, page 241

Learn more about troubleshooting? Appendix C, page 279
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Performing Spectral Calibration
for Sequencing and
Fragment Analysis

This chapter covers:

� Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
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Overview
Spectral calibration creates a matrix. This matrix is used during a run to reduce raw data 
from the instrument to the 4-dye or 5 -dye data stored in the sample files. Performing a 
spectral calibration is similar to performing a sample run, except that calibration 
standards are run in place of samples, and a spectral calibration module is used in place 
of a run module.

When to Perform
the Calibration

You must perform a spectral calibration:

• Whenever you use a new dye set on the instrument

• Change capillary array length (or polymer type for fragment analysis)

• After the laser or CCD camera has been realigned/replaced by a service engineer

• If you begin to see a decrease in spectral separation (pull-up and/or pull-down 
peaks) in the raw or analyzed data

What Happens? Spectral standards are run in all 16 or 4 capillaries. Then, the data collection software:

• Collects the data and stores it into 16 or 4 separate temporary files

• Analyzes the data and generates a mathematical description of the spectral overlap 
for each capillary

• Stores the spectral calibration data for the dye set run

Changing
Capillary Array

Lengths and
Polymer Type

For each dye set, a single spectral calibration can not be used for all capillary array 
lengths (and polymer type, for fragment analysis). 

• For every sequencing dye set, you must create a separate spectral calibration for 
each capillary array length you use.

• For every fragment analysis dye set, you must create a separate spectral calibration 
for each capillary array length and polymer type combination you use.

Refer to “Activating a Spectral Calibration” on page 59, for information on how to 
switch calibrations, once calibrations are performed for each dye set on each capillary 
length.

Supported
Sequencing
Chemistries

ABI PRISM® BigDye® Terminator v1.0, v2.0 and v3.0 chemistry kits have been 
discontinued. While these chemistries can be still run on the 3100 series instruments 
using supported basecaller, and mobility files, and run modules they are no longer fully 
supported.

Any new developments on the 3100series instruments in terms of the creation of new 
basecaller and mobility files, and run modules will be made solely in support of the 
ABI PRISM® BigDye® Terminator v1.1 and v3.1chemistry kits. For more information, 
please contact Applied Biosystems Technical Support.
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Determining the
Correct Dye Set
and Calibration

Standard

There are two types of spectral calibration standards:

• Matrix standards 

– A tube that contains a single labeled fragment for each of the four or five dyes

– Four separate tubes, each containing fragments labeled with one of the four dyes

• BigDye® v3.1 or BigDye® v1.1 Terminator Sequencing Standard 

A tube the contains a standard chemistry reaction that contains multiple labeled 
fragments for each of the four dyes

Use the tables below to determine the correct dye set and matrix standard set for the 
application and instrument you are using.

.

Dye Sets and Calibration Standards for Sequencing Chemistry Using the ABI PRISM® 3100 Genetic Analyzer

Sequencing Chemistry Dye Set Spectral Calibration Standard

• ABI PRISM® BigDye® v3.1Terminator

• ABI PRISM® BigDye® v3.1 Primer 

Z_BigDyeV3 BigDye® v3.1 Matrix Standards

BigDye® v3.1 Terminator Sequencing Standard

• ABI PRISM® BigDye® v1.1 Terminator

• ABI PRISM® BigDye® v1.1 Primer

E_BigDyeV1 DS-01Matrix Standards

BigDye® v1.1 Terminator Sequencing Standard

ABI PRISM® dRhodamine Terminator dRhodamine Matrix Standards

Dye Sets and Calibration Standards for Sequencing Chemistry Using the ABI PRISM® 3100-Avant Genetic Analyzer

Sequencing Chemistry Dye Set Spectral Calibration Standard

ABI PRISM BigDye® v3.1Terminator Z_BigDyeV3 BigDye v3.1 Matrix Standards

BigDye v3.1 Terminator Sequencing Standard

ABI PRISM BigDye v1.1 Terminator E_BigDyeV1 DS-01 Matrix Standards

BigDye® v1.1 Terminator Sequencing Standard

ABI PRISM dRhodamine Terminator dRhodamine Matrix Standards

Dye Sets and Calibration Standards for Fragment Analysis Chemistry using the 3100/3100-Avant Genetic Analyzers  

Fragment Analysis Chemistry Dye Set Spectral Calibration Standard

Custom oligos D DS-30 Matrix Standards

• ABI PRISM Mouse Mapping Set v1.0

• Custom oligos

D DS-31 Matrix Standards

• AmpFlSTR® COfiler® Kit

• AmpFlSTR® Profiler® Plus Kit

• AmpFlSTR® Profiler Plus ID® Kit

• AmpFlSTR® SGM Plus® Kit

• Other 4-Dye AmpFlSTR Kits

F DS-32 Matrix Standards
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 ABI PRISM® SNaPshot® Multiplex System E5 DS-02 Matrix Standards

• ABI PRISM® Linkage Mapping Set v2.5

• Custom Oligos

• AmpFlSTR® Identifiler® Kit

• AmpFlSTR® SEfiler® Kit

• Other 5-Dye AmpFlSTR Kits

G5 DS-33 Matrix Standards

Dye Sets and Calibration Standards for Fragment Analysis Chemistry using the 3100/3100-Avant Genetic Analyzers 

Fragment Analysis Chemistry Dye Set Spectral Calibration Standard
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Preparing the Spectral Calibration Chemistry
 Preparing the Calibration Standard 

1. Prepare one of the following:

• ABI PRISM BigDye Terminator v1.1 or v3.1 
Sequencing Standard:

– Remove a tube of the Sequencing 
Standard from the freezer.

– Add 170 µL of Hi-Di™ formamide to 
resuspend the tube of BigDye Terminator 
v1.1 or v3.1 Sequencing Standard.

– Skip to step 2.

• Matrix standards:

– Remove a tube of the matrix standard 
from the refrigerator.

– Mix thoroughly, then spin briefly in a 
microcentrifuge.

– Follow the matrix standard insert for 
matrix standard and Hi-Di formamide 
ratios.

2. Vortex thoroughly.

3. Briefly centrifuge the mixture.

4. Heat the standard tube at 95 °C for 5 minutes to 
denature the DNA. 

5. Cool the tubes on ice for 2 minutes.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and respiratory tract 
irritation. It is a possible reproductive and birth defect 
hazard. Read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

00:00:05

Vortex

00:00:05

<1500×g

00:05:00

95 °C

00:02:00

0 °C
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Sealing and Preparing the Plate 
Assemblies

1. Add the denatured standard to the wells of a 96-
or 384-well reaction plate:

• If using 3100 instrument:

– 96-well plate – Add 10 µL of denatured 
standard to wells A1 through H2.

– 384-well plate – Add 5 µL of denatured 
standard into alternating wells of the 
plate:

Row 1: A1, C1, E1, …K1, M1, O1

Row 2: Empty

Row 3: A3, C3, E3, …K3, M1, O1

• If using 3100-Avant instrument:

– 96-well plate – Add 10 µL of denatured 
standard to wells A1, B1, C1 and D1.

– 384-well plate – Add 5 µL of denatured 
standard into alternating wells of the 
plate: 

Row 1: A1, C1, E1 and G1

2. Seal the plate:

a. Place the plate on a clean, level surface.

b. Lay the septa flat on the plate.

c. Align the holes in the septa strip with the 
wells of the plate, then firmly press 
downward onto the plate.

GR1315c

A

B

C

D

E

F

G

H

1 2 3 4 5 6 7 8 9 10 11 12

GR1316c

A

B

C

D

E

F

G

H

I

J

K

L

M

N

O

P

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

Prepared standard 
(from step 5 on page 37)

96-Well
Plate

Add 10 µL prepared standard 

384-Well
Plate

Add 5 µL prepared standard 
into alternating wells 

3100-Avant

3100

3100-Avant

3100

WARNING Do 
not use warped or damaged plates.

IMPORTANT! Do not heat plates that are sealed 
with septa.
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3. To prevent damage to the capillary array, inspect 
the plate and septa to verify the septa fits snugly 
and flush on the plate.

4. Briefly centrifuge the plate.

5. Remove the plate from the centrifuge and verify 
that each sample is positioned correctly in the 
bottom of its well.

If the reagents of any well contain bubbles or are 
not located at the bottom of the well, repeat 
steps 4 and 5.

6. Assemble the plate assembly:

a. Place the sample plate into the plate base. 

b. Snap the plate retainer onto the plate and 
plate base.

Septa and we
not aligned

Septa and we
not aligned

0:05<1500 × g

Prepared standard

Sample is at the 
bottom of the well

G
R

20
50

b

Assembled 
components 

6a
6b
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7. Verify that the holes of the plate retainer and the 
septa strip are aligned. If not, re-assemble the 
plate assembly (see step 6).

Plate retainer 
holes and septa
holes are not 
aligned

IMPORTANT! Damage to the array tips will 
occur if the plate retainer and septa strip holes do 
not align correctly.
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Creating a Spectral Instrument Protocol

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 
ga3100-Avant >  Protocol Manager. This 
opens the Protocol Manager window.

2. In the Instruments Protocols pane, click . 
The Protocol Editor dialog box opens.

Create instrument 
protocols here

Create analysis 
protocols here
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3. Complete the Protocol Editor dialog box:

a. Type a name for the protocol.

b. Type a description for the protocol 
(optional).

c. Select Spectral in the Type drop-down list.

d. Using the information in the tables below, 
select the correct Dye Set for your run.

3a

3b

3c

3d

3e

3f

3g

3h

Dye Sets for Sequencing Chemistry

Instrument Chemistry Dye Set

3100 only ABI PRISM® BigDye® v1.1 Primer E_BigDyeV1

3100/3100-Avant ABI PRISM® BigDye® v1.1 Terminator 

ABI PRISM® dRhodamine Terminator

ABI PRISM® dGTP BigDye® Terminator

3100 only ABI PRISM® BigDye® v3.1 Primer Z_BigDyeV3

3100/3100-Avant ABI PRISM® BigDye® v3.1 Terminator

ABI PRISM® dGTP BigDye® v3.0 Terminator

Dye Sets for Fragment Analysis Applications or Kits 

Instrument Application or Kit Dye Set Matrix Standard 
Set

3100 and 
3100-Avant

Custom oligos D DS-30

• ABI PRISM Mouse Mapping Set v1.0

• Custom oligos

D DS-31
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e. Use the table below, to select the Polymer 
and Array Length you are using from the 
appropriate drop-down list.

f. In the Chemistry drop-down list, use the 
tables on page 44 select the correct 
chemistry file. 

3100/3100-Avant • AmpFlSTR® COfiler® Kit

• AmpFlSTR® Profiler® Plus Kit

• AmpFlSTR® Profiler Plus ID® Kit

• AmpFlSTR® SGM Plus® Kit

• Other 4-Dye AmpFlSTR Kits

F DS-32

 ABI PRISM® SNaPshot® Multiplex System E5 DS-02

• ABI PRISM® Linkage Mapping Set v2.5

• Custom Oligos

• AmpFlSTR® Identifiler® Kit

• AmpFlSTR® SEfiler® Kit

• Other 5-Dye AmpFlSTR Kits

G5 DS-33

Dye Sets for Fragment Analysis Applications or Kits (continued)

Instrument Application or Kit Dye Set Matrix Standard 
Set

Polymer
Type

Array
Length (cm)

POP4 22

36

50

80

POP6 36

50

IMPORTANT! Failure to select the correct 
chemistry file for the spectral calibration 
samples the you are using results in a failing 
spectral run.

Note: The Chemistry file for fragment 
analysis dye sets automatically defaults to 
the Matrix Standard.
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g. In the Run Module drop-down list, select 
the run module for your run from the table.

h. Click .

Chemistry Files for Sequencing Dye Sets

Dye Set  Standard Type Chemistry File

Z_BigDyeV3 BigDye® v3.1 Matrix Standards Matrix Standard

BigDye® v3.1 Terminator Sequencing Standard Sequence Standard

E_BigDyeV1 DS-01 Matrix Standard

BigDye® v1.1 Terminator Sequencing Standard Sequence Standard

dRhodamine matrix standards Matrix Standard

Chemistry Files for Fragment Analysis Dye Sets

Dye Set Matrix Standard Set Chemistry File

D DS-30 Matrix Standard

D DS-31

F DS-32

E5 DS-02

G5 DS-33

Note:  The modules list is filtered based on 
the polymer type, then the array length you 
selected in step e on page 43. You may have 
only one run module option available.

Polymer
Type

Array
Length (cm) Run Module

POP4 22 Spect22_POP4_1

36 Spect36_POP4_1

SpectSQ36_POP4_1

50 Spect50_POP4_1

80 Spect80_POP4_1

POP6 36 Spect36_POP6_1

50 Spect50_POP6_1
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Performing a Spectral Calibration

Creating the Plate Record

1. In the tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 
3100-Avant >  instrument name >  Run 
Scheduler.

2. In the Run Scheduler view:

a. In the Scan or Type Plate ID field enter a 
new plate name.

b. Click .

3. In the Create new plate dialog box, click .

4. Complete the New Plate dialog box:

a. Enter a name for the plate.

b. Optional: Enter a description for the plate 
record.

c. In the Application drop-down list, select 
Spectral Calibration. 

d. In the Plate Type drop-down list, select 96-
Well or 384-Well

e. Enter a name for the owner.

f. Enter a name for the operator.

g. Click .

Run Scheduler

2a

2b

4a

4b

4c

4d

4e

4f

4g
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5. In the Spectral Calibration Plate Editor dialog 
box, enter the following information:

a. In the Sample Name column of row A, enter 
a sample name, then click the next cell. The 
value 100 automatically display in the 
Priority column.

b. In the Comments column of row A, enter 
any additional comments or notations for 
the sample at the corresponding position of 
the plate.

c. In the Instrument Protocol 1 column of 
row A, select a protocol from the list.

6. Highlight the entire row.

7. Select Edit > Fill Down Special.

Based on the plate type (96- or 384-well) and 
capillary array (16 or 4 capillaries) you are using, 
the software automatically fills in the appropriate 
well numbers for a single run (see page 265).

8. Click . 

You have successfully created the plate record for 
the spectral calibration plate.

5a 5b 5c
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Placing the Plate Assembly into the 
Instrument

1. Verify the oven and front doors are closed.

2. Press the Tray button.

3. Open the front doors.

4. Place the plate assembly on the autosampler in 
position A or B for the 3100 instrument and 
position B for the 3100-Avant instrument.

5. Ensure the plate assembly fits flat in the 
autosampler. Failure to do so may allow the 
capillary tips to lift the plate assembly off of the 
autosampler.

6. Close the instrument doors.

G
R

21
42

G
R

21
42

3100-Avant instrument 

3100 instrument 

Note: There is only one orientation for the plate, 
with the notched end of the plate base away 
from you.

Note: Closing the doors returns the autosampler 
to the home position, placing the tips of the 
capillaries in buffer.
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Running the Spectral Calibration Plate 

1. In the tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 3100-
Avant >  instrument name >  Run 
Scheduler >  Plate Viewer.

2. Search for your plate record. There are two 
options:

• If you have a limited number of plates in the 
database, click .

• Perform an advanced search by selecting 
Advanced in the Type of Search drop-down 
list (see page 163).
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.3. Link the plate.

a. Select the plate record you want to run.

b. Click the plate position indicator that 
corresponds to the plate you are link.

The plate map color will change from 
yellow to green when it is successfully 
linked.

4. In the toolbar of the Data Collection Software 
window, click  to begin the run.

5. The Processing Plates dialog box opens, then 
click .

3a

3b

Note: The 3100-Avant instrument has only 
one plate position to link a plate record.

Note: The instrument may pause before running 
the plate to raise the oven temperature.

Run Type
Capillary 
Length

(cm)

Approximate 
Run Time

(min)

Spect22_POP4_1 22 20

Spect36_POP4_1

36

28

SpectSQ36_POP4_1 45

Spect36_POP6_1 50

Spect50_POP4_1
50

70

Spect50_POP6_1 95

Spect80_POP4_1 80 140
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Viewing the Pass/Fail Status After the Run

After the instrument completes the spectral 
calibration run, the pass or fail status of each capillary 
is recorded in the Events Messages section of the 
Instrument Status window.

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 
ga3100-Avant >  instrument name >
  Instrument Status >  Event Log.
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2. In the Events Messages section of the window, 
view the status of each capillary.

Dye set G5 status results

For a good-quality calibration, each capillary 
should have a:

• Q-value above 0.95 

• Condition number within range of:

3. If the entire spectral calibration failed, see “If All 
Capillaries Fail” on page 57.

Cap # Pass/fail status Q-value Condition #

Dye Set Condition Number 
Range

Sequencing Analysis

Z_BigDyeV3 3 to 5

E_BigDyeV1

Fragment Analysis

D 4 to 8.5

F 6 to 12

E5 2.5 to 4

G5 7 to 12
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Evaluating the Spectral Calibration Data

Evaluating the Spectral Profile and Raw 
Data

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 
ga3100-Avant >  instrument 
name >  Spectral Viewer.

IMPORTANT! Review and evaluate the spectral 
calibration profile for each capillary, even if the 
Spectral Calibration Results box indicated that they 
all passed. 

Note: Pages 61 to 64 contain examples of passing 
sequencing spectral calibration profiles and pages 65 
to 68 contain examples of passing fragment analysis 
spectral calibration profiles. 

Spectral 
profile

Rename or 
set the 
active 
spectral 
calibration 
here

Raw data 
(matrix 
standards)

Plate diagram
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2. In the Dye Set drop-down list, select the dye set 
you just created.

3. In the plate diagram, select a well on the plate 
diagram to view the capillary spectral results.

4. Evaluate the spectral profile and raw data for the 
selected capillary:

a. Verify that the order of the peaks in the 
spectral profile from left to right are:

– 4-dye: blue-green-yellow-red

– 5-dye: blue-green-yellow-red-orange

Do the peaks in the profile appear in the 
correct order?

Yes – Go to step b.

No – The calibration run has failed. Go to 
page 56.

Note: If the spectral calibration failed (no 
spectral profiles created), see the troubleshooting 
table on page 57.

Passed (dark green)

Selected (light green)

Failed (tan)

Capillary status:

Well A1

Note: If a capillary fails, it is automatically 
assigned the spectral profile of its nearest passing 
capillary to the left. If there are no passing 
capillaries to the left, it is assigned the profile of 
the nearest passing capillary to the right. 

Blue Green Yellow Red

Example of a 4-dye spectral profile

Blue Green Yellow Red Orange

Example of a 5-dye spectral calibration profile
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b. Verify that the order of the peaks in the raw 
data profile from left to right are:

Sequencing

– 4-dye: red-yellow-blue-green

Fragment Analysis

– 4-dye: red-yellow-green-blue

– 5-dye: orange-red-yellow-green-blue

Are the peaks in the wrong order or are 
there any extraneous peaks that adversely 
affect the spectral profile?

Yes – The calibration run has failed. Go to 
page 56.

No – Go to step c.

c. Verify that the peaks in the spectral profile 
do not contain gross overlaps, dips, or other 
irregularities (see “Tip: Magnifying the 
Spectral Profile or Raw Data” on page 55).

Are the peaks in the spectral profile separate 
and distinct?

Yes – The capillary has passed. Go to 
step 5.

No – The calibration run has failed. Go to 
page 56.

5. Repeat steps 3 and 4 for each capillary in the 
array.

Example of a 4-dye sequencing raw data profile

Example of a 5-dye fragment analysis raw data profile

Orange Red  Yellow Green Blue

Red  Yellow Blue Green

Peaks are distinct, regular and in the proper order – pass

Red peak is not distinct, regular or in the proper order – fail
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6. Rename the spectral run. The spectral file default 
name is the day, date and time of the run.

a. Click .

b. In the Rename Calibration dialog box, enter 
a descriptive name for the spectral 
calibration including the dye set, array 
length and polymer type (optional).

c. Click .

Tip: Magnifying the Spectral Profile or Raw Data

1. In the Tree pane of the Data Collection 
Software, click 

 GA Instruments >  ga3100 or 
ga3100-Avant >   instrument 
name >  Spectral Viewer.

2. In the spectal profile or raw data display, 
click-drag the cursor to create a box 
around the area of interest.

Selecting an area to magnify in a spectral profile

3. Release the mouse button. 

The data collection software displays the 
selected region.

4. Press R to reset the view.

Magnified area of that spectral profile
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Troubleshooting  

If a Capillary Fails

If a capillary fails, it is automatically assigned the spectral profile of its nearest passing capillary to the left. If there are no 
passing capillaries to the left, it is assigned the profile of the nearest passing capillary to the right. 

For applications where pull-up and pull-down peaks cause critical errors, we recommend that you repeat the spectral 
calibration and use a unique spectral for each capillary.

Manually Overriding a Spectral Profile

To override a spectral calibration profile:

1. Review the data.

2. In the plate diagram, select the capillary spectral 
profile you want to override.

3. Click Override Spectral. The Override Spectral 
dialog box opens.

4. Select a new capillary value from the drop-down list.

5. Click OK.

6. Click Save.

7. In “Save the modified spectral calibration” dialog 
box, enter a new name, then click Save.

When a Calibration Fails

If the spectral calibration failed, or if you do not like the appearance of the passed calibration, try one or more of the 
following:

• Verify that the correct chemistry and run module were selected. If not, correct, and then repeat the run.

• Verify the freshness of the reagents used.

Capillary 10 
selected
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If All Capillaries Fail

If all capillaries fail, no spectral profiles are created. However, the raw data can still be viewed.

Viewing the Raw Data for a Failed Spectral 
Calibration

1. In the Tree pane of the Data Collection Software, click 
  GA Instruments >  ga3100 or ga3100-Avant 
 >  instrument name >  Spectral Viewer, then 
review the spectral data.

You observe:

– The window displays data from the previous 
passing spectral calibration.

– This System Status is blinking red.

2.  Click  Instrument Status >  Event Log to 
view the Event and Errors messages.

3. Click   Spectral Viewer.

4. In the Dye Set drop-down list, select the dye set for 
the failed calibration.

5. In the List of Calibrations drop-down list, select the 
failing run. The failing run has a asterisk (*) next to its 
name.

Troubleshooting  (continued)

System failure, check 
Event Log
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The window is updated with the information from the 
failed E5 spectral calibration.

6. Use the list of questions below when reviewing the 
raw data to determine the cause of the failure. 

– How many peaks? 

– Any extraneous peaks?

– Peak order?

– Peak shape and signal strength?

– Negative peaks?

– Additional peaks (positive or negative) under the 
main color peak?

Note: It is helpful to magnify the raw data for the review 
process (see “Tip: Magnifying the Spectral Profile or 
Raw Data” on page 55).

Raw data

Maginfied raw data

Troubleshooting  (continued)

Raw data

Failed
capillaries

No spectral
profile
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Activating a Spectral Calibration
If you want to use a different spectral calibration for a 
specific dye set and capillary array length, you can 
select the active spectral calibration for a dye set from 
any previous spectral calibration runs. 

• Sequencing analysis applications that require a 
separate spectral calibration (for the same dye 
set) for different capillary array lengths

• Fragment analysis applications that require a 
separate spectral calibration (for the same dye 
set) for different capillary array lengths and 
polymer type

• Repeat spectral calibrations where the original 
calibration is better than the second one

To set active spectral calibration

1. In the tree pane of the Data Collection Software, 
click 

 GA Instruments >  ga3100 or ga3100-
Avant >  instrument name >  Spectral 
Viewer.

2. In the Dye Set drop-down list, select a dye set.

IMPORTANT! If you installed or replaced an array that is 
a different length than you were using, you must set the 
active spectral calibration for that dye set and arrary 
length combination. If one does not exist, perform a new 
spatial calibration, then set the active spectral 
calibration. 

A run will not start without the correct spectral 
calibration for a specific dye set and capillary array 
length.

IMPORTANT! If the Spectral Viewer window is 
blank and deactivated, then either:

• no spectral calibrations are in the database

or, 

• you changed the arrary length and do not 
have a spectral for that dye set and array 
length combination. you will have to create 
one
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3. In the List of Calibrations for Dye Set drop-down 
list, select the spectral calibration you want to 
use.

4. Click .
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Examples of Passing Sequencing Spectral Calibrations

Dye Set Z Created
from Matrix

Standard
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Dye Set Z Created
from a

Sequencing
Standard
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Dye Set E Created
from Matrix

Standard Set
DS-01
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Dye Set E Created
from a

Sequencing
Standard
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Examples of Passing Fragment Analysis Spectral 
Calibrations

Dye Set G5
Created from

Matrix Standard
Set DS-33
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Dye Set F Created
from Matrix

Standard Set
DS-32
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Dye Set D
Created from

Matrix Standard
Set DS-30
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Dye Set E5
Created from

Matrix Standard
Set DS-02
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Where to Go Next
Use the table below to determine which chapter to proceed to next.

Do you need to… Proceed to …

Set up the software for sequencing analysis runs? Chapter 4, page 73

Set up the software for SeqScape analysis runs? Chapter 4, page 99

Set up the software for fragment analysis runs? Chapter 5, page 123

Perform maintenance, use wizards? Chapter 7, page 195

Activate/modify the audit trail and access control features? Chapter 8, page 241

Learn more about on plate record feature? Appendix A, page 261

Learn more about troubleshooting? Appendix C, page 279
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3100/3100-Avant Data Collection Software and 
Sequencing Analysis Software v5.1

The Applied Biosystems Sequencing Analysis Software v5.1 must be installed and 
registered with the 3100/3100-Avant Genetic Analyzer Data Collection Software before 
you can create the files required for autoanalysis. Please refer to the Applied Biosystems 
DNA Sequencing Analysis Software v5.1 User Guide (P/N 4346366) for 
further information.

Important Notes • A unique name must be assigned to the instrument computer before 
3100/3100-Avant Data Collection software is installed. Do not rename the 
computer once 3100/3100-Avant Data Collection software has been installed. 
Doing so may cause the 3100/3100-Avant Data Collection software to malfunction. 

File-Naming
Convention

Some alphanumeric characters are not valid for user names or file names. The invalid 
characters are below:

spaces 

\ / : * ? " < > | 

Using Sequencing Analysis Software

You may choose to perform autoanalysis of sequencing samples by utilizing features of 
the 3100/3100-Avant Data Collection and Applied Biosystems Sequencing Analysis 
Software v5.1.

Autoanalysis Autoanalysis can only be performed on the same instrument computer that collected the 
sample files. Additionally, if you perform autoanalysis on samples, but wish to 
edit/review results on another computer, you must transfer the Analysis Protocol to the 
Sequencing Analysis Software v5.1 database. If you wish to analyze samples on another 
computer, you must transfer the files to that location.

When completing the Plate Record, you need to fill in Instrument Protocol information 
for Data Collection to complete the run. Additionally, when creating a new Results 
Group for a set of samples to be autoanalyzed, you must check the “Do Autoanalysis” 
check box in the Analysis tab of the Results Group Editor, and choose an Analysis 
Protocol for each run. 

Manual Analysis If the run is not set up for autoanalysis, refer to the Applied Biosystems DNA Sequencing 
Analysis Software v5.1 User Guide (PN 4346366) for information on performing manual 
analysis.

IMPORTANT! An error message is displayed if you use any of these characters. You 
must remove the invalid character to continue.
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Workflow for
Autoanalysis

Using Sequencing
Analysis Software

Register software and 
create user IDs

Is 
Sequencing 

Analysis  
registered and have 

user IDs been 
created?

Set up instrument and 
prepare samples

Do
you have an 

Instrument Protocol, 
Analysis Protocol. 

and Results 
Group?

Search for plate record, 
then link plate

Start and monitor run

Create and save 
plate record

No

No

Yes

Yes

Review data in Sequencing 
Analysis software

Create 
Instrument Protocol

Create 
Analysis Protocol

Create 
Results Group
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About Plate Records and Sequencing Analysis

Overview A plate record is similar to a sample sheet or an injection list that you may have used 
with other ABI PRISM instruments. 

Plate records are data tables in the instrument database that store information about the 
plates and the samples they contain. Specifically, a plate record contains the following 
information:

• Plate name, type, and owner

• Position of the sample on the plate (well number)

• Sample name, see page 91

• Mobility file (in Analysis Protocol), see page 84

• Comments about the plate and about individual samples

• Name of the run module and Dye set information (run modules specify information 
about how samples are run) (in Instrument Protocol), see page 79

• Name of the Analysis Protocol—Analysis Protocols specify how data is analyzed at 
the end of the run (in Analysis Protocol), see page 84

When to Create a
Plate Record

A plate record must be created for each plate of samples for the following types of runs: 

• Spectral calibrations

• Sequencing analysis

• SeqScape analysis

• Fragment analysis

• Mixed (sequencing, SeqScape and/or fragment analysis samples) see “Multi-
application (Mixed) Plate Record” on page 269

Additionally, Plate Records must be created in advance of placing the plates on the 
instrument. However, plate records, for subsequent plates can be created while a run is in 
progress.

About
Sequencing

Analysis Plate
Record

The Plate Editor displays an empty plate record for the selected application that is 
chosen in the New Plate dialog box. The data fields within a given plate record vary 
depending on the selected application. This section describes the data fields that are 
present in a sequencing analysis Plate Record.

The table below and the flow chart on page 76 describes what each file specifies:

Parameters Description See Page

Instrument Protocol Contains everything needed to run the instrument. 79

Analysis Protocol Contains everything needed to analyze sequencing 
data.

83

Results Group Defines the file type, the file name, file save locations, 
analysis software and autoanalysis.

89
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Elements of a Sequencing Analysis plate record

Results Group
 Name

Analysis software 
and autoanalysis

Plate Record

Plate Manager

Results Group

Basecaller and 
DyeSet/Primer file

Bases called
(pure or mixed)

Post classification
(QVs)

Post analysis
processing
(clear range)

Analysis Protocol

Instrument 
Protocol Name

Run type 
(Regular)

Instrument Protocol

Run module

Dye set

File storage 
location

File and run folder
name preferences

Analysis Protocol
 Name

IMPORTANT! In order for data collection and autoanalysis to be successful, each run of 
samples must have an Instrument Protocol, an Analysis Protocol, and a Results Group 
assigned within a plate record.
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Blank Sequencing Analysis plate record

The following table describes the columns inserted in a Plate Record for a sequencing 
analysis run. 

1 2 3 4 5 6

Default is one sample run, to add 
additional runs see page 98

Number and Column Description

1. Sample Name  Name of the sample

2. Comment Comments about the sample (optional)

3. Priority A default value of 100 to each sample. Changing the value to a smaller number causes 
that set of 16 or 4 samples to run to before the others in the injection list.

4. Results Group Some options:

• New: Opens the Results Group Editor dialog box

• Edit: Opens the Results Group Editor dialog box for the Results Group listed in the cell

• None: Sets the cell to have no selected Results Group

• Select one of the available Results groups from the list

Note: You must have a Results Group selected for each sample entered in the Sample 
Name column.

See, “Results Group for Sequencing Analysis” on page 89.
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5. Instrument Protocol • New: Opens the Protocol Editor dialog box. 

• Edit: Opens the Protocol Editor dialog box for the Instrument Protocol listed in the cell.

• None: Sets the cell to have no selected protocol.

• List of Instrument Protocols: In alpha-numeric order.

Note: You must have an Instrument Protocol selected for each sample entered in the 
Sample Name column.

See, “Instrument Protocol for Sequencing Analysis” on page 79.

6. Analysis Protocol • New: Opens the Analysis Protocol Editor dialog box. 

• Edit: Opens the Analysis Protocol Editor dialog box for the Instrument Protocol listed in 
the cell. 

• None: Sets the cell to have no selected protocol.

• List of Analysis Protocols: In alpha-numeric order 

Note: You must have an Analysis Protocol selected for each sample entered in the 
Sample Name column.

See, “Analysis Protocol for Sequencing Analysis” on page 83.

Number and Column Description
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Creating Required Files for Automated Sequencing Analysis

If the Files Already Exist in Data Collection

If the appropriate instrument protocol, analysis 
protocol, and results group have been created, proceed 
to “Creating and Completing a Sequencing Analysis 
Plate Record” on page 96. 

Instrument Protocol for Sequencing Analysis

About Instrument Protocols

An instrument protocol contains all the settings 
necessary to run the instrument. An instrument 
protocol contains the protocol name, type of run, run 
module, and dye set.

Creating an Instrument Protocol

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 
ga3100-Avant >  Protocol Manager.

Create instrument 
protocols here

Create analysis 
protocols here
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2. In the Instruments Protocols section, click 
.

The Protocol Editor opens. 

3. Complete the Protocol Editor:

a. Type a name for the protocol.

b. Type a description for the protocol 
(optional).

c. Select Regular in the Type drop-down list.

d. Using the information in the table below, 
select the correct run module for your run. 

Note: To customize a run module, see “Tip: 
Customizing Run Modules” on page 82.  

3a

3b

3c

3d

3e

3f

Sequencing Run Capillary Array Length (cm) Run Module

Ultra rapid 36 UltraSeq36_POP4_1

Rapid 36 RapidSeq36_POP6_1

Standard 50 StdSeq50_POP4_1

StdSeq50_POP6_1

Long read 80 LongSeq80_POP4_1
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e. Using the information in the table below, 
select the correct Dye Set for your run.

f. Click .

Importing an Instrument Protocol

1. Click  in the Instrument Protocols pane 
of the Protocol Editor window.

2. Navigate to the protocol you want to import.

3. Double-click the protocol to import it.

The imported file is displayed as the top row in 
the Instrument Protocol pane.

Dye Set Chemistry Instrument

E_BigDyeV1 ABI PRISM® BigDye® v1.1 Primer 3100 only

ABI PRISM® BigDye® v1.1 Terminator 3100/3100-Avant

ABI PRISM® dRhodamine Terminator

ABI PRISM® dGTP BigDye® Terminator

Z_BigDyeV3 ABI PRISM® BigDye® v3.1 Primer 3100 only

ABI PRISM® BigDye® v3.1 Terminator 3100/3100-Avant

ABI PRISM® dGTP BigDye® v3.0 Terminator

Note: Import file type is .txt (text).
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Tip: Customizing Run Modules 

You can modify default run modules to suit your 
particular needs. 

1. Click  GA Instruments >  ga3100 or ga3100-
Avant >  instrument name >  Module 
Manager. 

2. Click .

The Run Module Editor dialog box opens.

3. Complete the Run Module Editor dialog box:

a. Enter a name for your new module.

b. In the Type drop-down list, select the type of 
module (Regular, Spatial or Spectral).

c. In the Template drop-down list, select a template 
module as a basis for the new module.

Note: You cannot edit a default module installed 
with 3100/3100-Avant Data Collection software.

d. Optional: Enter a description of your new run 
module.

3d

3c

3b

3f

3e

3a
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Analysis Protocol for Sequencing Analysis

About Analysis
Protocols

New to Data Collection is the implementation of analysis protocols. An analysis protocol 
contains all the settings necessary for analysis and post processing: 

• Protocol name – The name, description of the analysis protocol, and the sequence 
file formats to be used

• Basecalling settings – The basecaller, DyeSet/Primer file, and analysis stop point to 
be used

• Mixed Bases – Option: to use mixed base identification, and if so, define the percent 
value of the second highest to the highest peak

• Clear Range – The clear range to be used based on base positions, sample quality 
values, and/or number of ambiguities (Ns) present

e. Change to the desired module parameters using 
the table below as a guide to the allowable 
parameters.

f. Click OK.

Tip: Customizing Run Modules (continued)

Name Range Comment

Oven_Temperature 18-65 C Temperature setting for main oven throughout run.

PreRun_Voltage 0-15 kV Pre run voltage setting before sample injection.

PreRun Time 1-1000 sec Prerun voltage time.

Injection_Voltage 0-15 kV Injection voltage setting for sample injection.

Injection_Time 1-600 sec Sample injection time.

Run_Voltage 0-15 kV Final run voltage.

Voltage_Number_Of_Steps 0-100 steps Number of voltage ramp steps to reach Run_Voltage. We 
recommend that you do not change this value unless advised 
otherwise by Applied Biosystems support personnel.

Voltage_Step_Interval 0-60 sec Dwell time at each voltage ramp step. We recommend that you 
do not change this value unless advised otherwise by Applied 
Biosystems support personnel.

Data_Delay_Time 1-3600 sec Time from the start of separation to the start of data collection.

Run_Time 300-14000 sec Duration data is collected after Data_Delay_Time.

Note: If you created an appropriate analysis protocol in the Sequencing Analysis 
software, you can use it in data collection software. 

IMPORTANT! Do not delete an Analysis Protocol during a run while it is being used for 
that run. Autoanalysis will not be performed if you do so.



Chapter 4 3100/3100-Avant Data Collection Software and DNA Sequencing
Creating Required Files for Automated Sequencing Analysis

84 ABI PRISM 3100/3100-Avant Genetic Analyzers User Guide

Notes

Creating an Analysis Protocol

Refer to the Applied Biosystems DNA Sequencing 
Analysis Software v5.1 User Guide (P/N 4346366), 
chapter 8 for more information regarding analysis 
protocols

1. In the Analysis Protocol section of the Protocol 
Manager, click .

If more than one analysis application is installed 
on the data collection computer, the Analysis 
Applications dialog box opens. 

2. Select Sequencing Analysis, then click .

The Analysis Protocol Editor dialog box opens.



Creating Required Files for Automated Sequencing Analysis
Creating an Analysis Protocol

ABI PRISM 3100/3100-Avant Genetic Analyzers User Guide 85

Notes

4

3. In the General tab:

a. Enter a unique name and description for the 
new protocol.

b. Select the appropriate Sequence File 
formats settings.

4. Select the Basecalling tab.

a. Use Appendix B, “Basecallers and 
DyeSet/Primer Files,” to select the 
appropriate basecaller and DyeSet primer 
based on the chemistry, capillary array 
length and polymer type you are using.

3a

3b

Option If checked, the software 
creates…

Write .Seq File
check box

a .seq file for printing the 
sequence as text file or for 
using the file in other 
software.

• ABI format is used with 
Applied Biosystems 
software.

• FASTA format is used 
with other software

Write Standard 
Chromatogram 
Format file 
(.scf)

When selected, the 
software creates a .scf file 
that can be used with other 
software. When created, 
the .scf extension is not 
appended to the file name. 

Write Phred 
(.phd.1) File

When selected and the KB 
basecaller is used, the 
software creates a .phd.1 
file that can be used with 
other software.

4c

4d

4a

4b

Note:  Sequencing Analysis Software v5.1 
and 3100/3100-Avant Data Collection 
software filter .mob file choices to match 
the chosen .bcp file.
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b. In the Processed data pane, select True or 
Flat profile.

c. If desired, select one or more stop points for 
data analysis. 

d. Select your Threshold Quality option.

5. Select the Mixed Bases tab.

a. For mixed bases only, select Use Mixed 
Base Identification. 

b. Use the default setting of 25% or change the 
detection level by entering a new value or 
dragging the % line up or down.

Option Function

Used to display data as processed traces scaled uniformly so that the average 
height of peaks in the region of strongest signal is about equal to a fixed value. 
The profile of the processed traces will be very similar to that of the raw traces.

Used to display the data as processed traces scaled semi-locally so that the 
average height of peaks in any region is about equal to a fixed value. The profile of 
the processed traces will be flat on an intermediate scale (> about 40 bases).

Note: This option is applied to data that is analyzed with the KB basecaller only. 
If you use the ABI basecaller the profile option reverts to True Profile.

Option Function

When using the KB basecaller, use this setting assign a base to 
every position, as well as the QV.

When using the KB basecaller, use this setting assign Ns to base 
with QVs less than the set point. The QV will still be displayed.

Note: This function is active with the KB 
Basecaller only.

5a

5b

Note: Do not use less than 15% as your 
detection limit.
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6. Select the Clear Range tab.

Select one or more Clear Range methods. If you 
apply multiple methods, the smallest clear range 
results.

7. Click  to save the protocol and close the 
Sequence Analysis Protocol Editor dialog box.

Editing and Deleting Analysis Protocols

Editing an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to edit.

2.  Click .

3. Make changes in the General, Basecalling, 
Mixed Bases and Clear Range tabs, as 
appropriate.

4. Click  to save the protocol and close the 
Analysis Protocol Editor dialog box.

Note: The clear range is the region of sequence 
that remains after excluding the low-quality or 
error prone sequence at both the 5´ and 3´ ends.

Use with 
KB Basecaller

Use with ABI and 
KB Basecallers

Use with ABI and 
KB Basecallers
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Deleting an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to delete.

2. Click .

The Deletion Confirmation dialog box displays.

3. Click .

Exporting and Importing Analysis 
Protocols

Exporting an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to export.

2. Click .

The Export Confirmation dialog box displays.

3. Click .

IMPORTANT! Do not delete an Analysis Protocol 
during a run while it is being used for that run. 
Autoanalysis will not be performed if you do so. Also, 
You must first delete any plate records using the 
Analysis Protocol before you can delete or modify the 
Analysis Protocol for these plate records. 

Note: It is better to delete the Analysis Protocol 
from the Sequencing Analysis Software v5.1.
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Importing an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to import.

2. Click .

The Import Confirmation dialog box displays.

3. Click .

Results Group for Sequencing Analysis

A Results Group is a component within Data 
Collection that organizes samples and certain user 
settings under a single name. It is called a Results 
Group because it is used to analyze, name, sort, and 
deliver samples that result from a run. 

Creating a Results Group 

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  Results Group.

2. Click . 

The Results Group Editor window displays.
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3. Complete the General tab:

a. Type a Results Group Name. The name can 
be used in naming and sorting sample files. 
It must be unique (see page for a list of 
accepted characters).

b. Type a Results Group Owner (optional). The 
owner name can be used in naming and 
sorting sample files.

c. Type a Results Group Comment (optional).

4. Select the Analysis tab, then:

a. Select Sequencing Analysis from the 
Analysis Type drop-down list.

b. In the Analysis Actions section, select Do 
Autoanalysis, if you want your data 
automatically analyzed after a run.

3a

3b

3c

4a

4b

Note: Login ID and password are not required 
for Sequencing Analysis software.
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5. Select the Destination tab, then use the default 
destination or define a new location for data 
storage.

a. Click Use Custom Location, then click 
 to navigate to a different save 

location.

b. Click  to test the Location path 
name connection:

If it passes, a message box displays “Path 
Name test successful.”

If it fails, a message box displays “Could 
not make the connection. Please check that 
the Path Name is correct.” Click and retry to 
establish a connection.

c. Click .

6. Select the Naming tab.

Use the Naming tab to customize sample file and 
run folder names. 

The elements of the Naming tab are discussed in 
the following sections. 

Sample File Name Format Pane

Follow the procedure below to complete the Sample 
File Name Format pane.

5a

5b

5c

To use … Then …

default location skip to step 6

custom location complete steps a-c

Sample 
File Name 
Format pane

Run Folder 
Name 
Format pane

IMPORTANT! Sample name, run folder name, 
and path name, combined, can total no more than 
250 characters. See page 73 for accepted 
characters.
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1. Select the Naming tab.

2. Click the Prefix box (optional) to type a prefix 
for the file name. Anything that you type here is 
shown in the Example line (see graphic below). 

3. Click the Name Delimiter list choose the 
symbol that will separate the Format elements in 
the file name (see step 3 below). Only one 
delimiter symbol may be chosen.

4. Click the Format list and then select the 
components that you want in the sample name. 

For example, if a unique identifier is not included 
in the name, a warning message displays. The 
Results Group makes the file name unique. As 
you select the elements for the file name, they are 
reflected in the Example line. 

Note: Generally, all the samples from a single 
run are placed in the same run or results folder, 
so the name of every sample from a single run 
should be different. Most of the Format options 
will not be different between samples, so you 
need to take care to select at least one of the 
options that make the sample names unique 
within a run. 
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As you continue to select elements for the file 
name, additional elements display.

The names of the Format elements eventually 
truncate, but the Example field remains visible 
(up to 72 characters).

5. Click the Suffix box (optional) and type the 
suffix for the file name.

The File Extension field displays the file 
extension generated from the Analysis Type 
specified on the Analysis tab (see page 90). For 
example, Sequencing Analysis and produces 
sample files with an .ab1 extension.
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Run Folder/Sub-
Folder Name
Format Pane

Follow the same steps described above for the Sample File Name Format pane (see 
page 91) to change the sub-folder name within the run folder.

Saving a
Results Group

Click  from any tab once all the elements within the Results Group have been 
chosen. 

About Format
Elements (Unique

Identifiers)

While you may select a minimum of just one Format element for the Sample file and 
Run folder names in order to save a Results Group, selecting just the minimum may not 
provide enough information for you to identify the file or folder later.

For example, although acceptable, the ‘A34’ sample file name below (well position) may 
not be helpful when trying to locate and identify the file later. 

If you choose elements from the Format lists that do not create unique Sample file or 
Run folder names, a warning message displays below the Example line (see figure 2-22).

To remove the warning message and proceed within the Results Group Editor window, 
simply select a Format element that distinguishes one file from another (for example, the 
capillary number is unique while the instrument name is not).

IMPORTANT! You must select at least one Format element for the Sample file and the 
Run folder names in order to proceed within the Results Group.

Note: Even if you create a custom run folder location, a separate default run folder is 
generated that contains the log file.

Warning message
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Importing and
Exporting a

Results Group

Results Groups can be imported from, or exported to, tab-delimited text files. This 
allows easy sharing of identical Results Groups between instruments.

Importing a Results Group

1. In the Tree pane of the Data Collection Software, click 
 GA Instruments >  Results Group.

2. Click .

A standard File Import dialog box displays.

3. Navigate to the file you want to import.

Note: Import file type is .txt (text).

4. Click .

Note:  When you import or duplicate a Results Group, you are asked to type a 
name for the new Results Group and for the analysis application type.

Exporting a Results Group

1. In the Tree pane of the Data Collection Software, click 
 GA Instruments >  Results Group.

2. Click the Results Group name to select it.

3. Click .

A standard file export dialog box displays with the chosen Results Group name.

4. Navigate to the location where you want to save the exported file.

5. Click .

Duplicating a Results Group

1. Click the Results Group to select it.

2. Click . 

Note: If there is a name conflict with a Results Group that already exists at the 
save location, the Results groups can be duplicated in order to copy settings into a 
similar Results Group without the risk of user error when copying it manually (see 
procedure below).

Note: When you import or duplicate a Results Group, you are asked to type a name 
for the new Results Group and for the analysis application type.
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Creating and Completing a Sequencing Analysis Plate 
Record

Creating a Sequencing Analysis Plate 
Record

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 
ga3100-Avant >   Plate Manager.

2. Click .

The New Plate Dialog dialog box opens.

3. Complete the information in the New Plate 
Dialog:

a. Type a name for the plate.

b. Type a description for the plate (optional).

c. Select your sequencing application in the 
Application drop-down list.

d. Select 96-well or 384-well in the Plate Type 
drop-down list.

e. Type a name for the owner and operator.

f. Click . 

The Sequencing Analysis Plate Editor 
opens.

3a

3b

3c

3d

3e

3f

3f
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Completing a Sequencing Analysis Plate 
Record

1. In the Sample Name column of a row, enter a 
sample name, then click the next cell. The value 
100 automatically display in the Priority column.

2. In the Comments column, enter any additional 
comments or notations for the sample.

3. In the Priority column, change the priority value, 
if desired (see page 262).

4. In the Results Group 1 column, select a group 
from the drop-down list (see page 89).

5. In the Instrument Protocol 1 column, select a 
protocol from the drop-down list (see page 79).

6. In the Analysis Protocol 1 column, select a 
protocol from the drop-down list (see page 84).

7. To complete the rest of the plate record based on 
the samples loaded in your plate, do one of the 
following:

• For the same samples and protocols – 
Highlight the entire row, then select Edit > 
Fill Down Special.

Based on the plate type (96- or 384-well) 
and capillary array (16 or 4 capillaries) you 
are using, the software automatically fills in 
the appropriate well numbers for a single 
run (see page 265).

• For the same samples and protocols – 
Highlight the entire row, then select Edit > 
Fill Down.

• For the different samples and protocols – 
Complete the manually.

1 42 3

3 4
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8. If you want to do more than one run, then select 
Edit > Add Sample Run.

Additional Results Group, Instrument Protocol 
and Analysis Protocol columns are added to the 
right end of the plate record.

You can add additional runs by selecting Edit > 
Add Sample Run again.

9. Complete the columns for the additional runs.

10. Click .

IMPORTANT! After clicking OK within the 
Plate Editor, the completed plate record is stored 
in the Plate Manager database. Once in the Plate 
Manager database, the plate record can be 
searched for, edited, exported, or deleted.
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3100/3100-Avant Data Collection Software and 
SeqScape Software v2.1

The ABI PRISM® SeqScape Software v2.1 must be installed and registered with the 
3100/3100-Avant Genetic Analyzer Data Collection Software before you can create the 
files required for autoanalysis. Please refer to the ABI PRISM® SeqScape Software v2.1 
User Guide (P/N 4346367) for further information.

Important Note A unique name must be assigned to the instrument computer before 
3100/3100-Avant Data Collection software is installed. Do not rename the computer 
once 3100/3100-Avant Data Collection software has been installed. Doing so may cause 
the 3100/3100-Avant Data Collection software to malfunction. 

File-Naming
Convention

Some alphanumeric characters are not valid for user names or file names. The invalid 
characters are below:

spaces 

\ / : * ? " < > | 

Using SeqScape Software

Autoanalysis Sequencing data that is generated on the ABI PRISM®3100/3100-Avant Genetic 
Analyzers can be automatically analyzed for use in the SeqScape Software v2.1. 
Autoanalysis can be performed only on the same instrument computer that collected the 
sample files. You can configure the software packages to perform data collection and 
then data analysis without requiring user interaction. 

Autoanalysis requires three software packages:

• 3100 or 3100-Avant Data Collection software

The data collection software is used to run the instrument and collect fluorescent 
data from samples. For autoanalysis to occur, the software must be set up properly 
to allow communication with downstream software.

Data collection software uses a data service. Data used for data collection as well as 
that created in SeqScape software can be accessed through the data service in data 
collection software.

IMPORTANT! An error message is displayed if you use any of these characters. You 
must remove the invalid character to continue.
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• Autoanalysis Manager

The Autoanalysis Manager is software that is part of the integration between the 
data collection, SeqScape, and GeneMapper™ software. It can queue messages and 
track the status of their processing. Each message is considered a batch job, 
whether it contains a single sample, samples from a result group, or an entire run of 
samples.

Autoanalysis Manager is installed by Seqscape or GeneMapper software when 
loaded on a system with data collection software.

• A version of SeqScape software with no user interface

This version of SeqScape is identical to the regular version of the software except 
that no user interface exists. The Autoanalysis Manager opens and uses this version 
of software to analyze the data in the projects.

The automated processing version and the standard version of SeqScape software 
are installed from the SeqScape Software installation CD.

Manual Analysis If the run is not set up for autoanalysis, refer to the ABI PRISM® SeqScape Software v2.1 
User Guide (P/N 4346367) for information on performing manual analysis.

IMPORTANT! When installing SeqScape software v2.1 on a computer that is connected 
to a 3100/3100-Avant Genetic Analyzer, the data collection software must be running. If 
data collection software is not running, the SeqScape software does not register with the 
Data Service. Refer to the ABI PRISM® SeqScape Software v2.1 User Guide 
(P/N 4346367), Chapter 2 for information on properly installing the software.
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About Plate Records and Seqscape
Successful automatic analysis requires that the:

• SeqScape software is installed properly

• SeqScape software is registered and the appropriate user IDs have been created

• Autoanalysis Manager software is running

• The 3100/3100-Avant instrument is set up to run, and samples are prepared

• Files for a data collection software plate record are available

For data collection and autoanalysis to be successful, each run of samples must 
have an instrument protocol, an analysis protocol, and a results group assigned 
within a plate record.

The table below describes what each file specifies in the logical order of its use.

File Specifications

File Description Created in

Instrument Protocol Contains everything needed to run the 
instrument.

Data collection 
software

Analysis Protocol Contains everything needed to analyze 
sequencing data.

Data collection 
software or SeqScape 
software

Results Group Defines the file type, the file name, file save 
locations, default analysis protocols linked to 
sample injections, and user name and 
password.

Data collection 
software
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Work Flow for
Autoanalysis

Using SeqScape
Software

About SeqScape
Plate Record

The Plate Editor displays an empty plate record for the selected application that is 
chosen in the New Plate dialog box. The data fields within a given plate record vary 
depending on the selected application. This section describes the data fields that are 
present in a sequencing analysis Plate Record.

For data collection and autoanalysis to be successful, each run of samples must have an 
instrument protocol, an analysis protocol, and a results group assigned within a plate 
record.

Register software and 
create user IDs

Create 
Instrument Protocol

Create 
Analysis Protocol

Is 
SeqScape 

registered and have 
user IDs been 

created?

Set up instrument and 
prepare samples

Do
you have an 

Instrument Protocol, 
Analysis Protocol,

and Results 
Group?

Search for plate record, 
then link plate

Create and save 
plate record

No

No

Yes

1. Create data objects:
 - Analysis Protocol
 - Analysis Defaults
 - RDG
 -  Display Settings
2. Create a Project
 Template.
3. Create a new Project.

Have
you created the 

required data objects, a 
Project Template,and a new 

Project in SeqScape
software?

No

Yes

Yes

Create 
Results Group

Open 
Autoanalysis Manager

Start and monitor run

Autoanalysis Manager 
automatically processes 

the data

Review data in SeqScape 
software
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The table below and the flow chart on page 103 describes what each file specifies:

Elements of a SeqScape plate record 

Parameters Description See Page

Instrument Protocol Contains everything needed to run the instrument. 106

Analysis Protocol Contains everything needed to analyze sequencing 
data.

109

Results Group Defines the file type, the file name, file save locations, 
analysis software, and autoanalysis.

115

Results Group
 Name

Analysis software 
and autoanalysis

Plate Record

Plate Manager

Results Group

Basecaller and 
DyeSet/Primer file

Bases called
(pure or mixed)

Post classification
(QVs)

Post analysis
processing
(clear range)

Analysis Protocol*

Instrument 
Protocol Name

Run type 
(Regular)

Instrument Protocol

Run module

Dye set

File storage 
location

File and run folder
name preferences

Analysis Protocol 
Name

Filter settings

Project Template

Project

SeqScape software 
files:

Data Objects
- Analysis Protocol*
- Analysis Defaults
- RDG
- Display Settings
  (optional)

*You can create Analysis Protocols in either
   SeqScape or Data Colletion software

Data Collection 
software files:

IMPORTANT! In order for data collection and autoanalysis to be successful, each run of 
samples must have an Instrument Protocol, an Analysis Protocol, and a Results Group 
assigned within a plate record.
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Blank SeqScape plate record

The following table describes the columns inserted in a Plate Record for a SeqScape run. 

1 2 4 5 7 83 6 9

Default is one sample run, to add 
additional runs see page 121

Number and Column Description

1. Sample Name  Name of the sample

2. Comment Comments about the sample (optional)

3. Priority A default value of 100 to each sample. Changing the value to a smaller number 
causes that set of 16 or 4 samples to run to before the others in the injection list.

4. Project Select one of the available Project from the list, that was created in the SeqScape 

5. Project Template Completed automatically based on the Project selected.

6. Specimen Select one of the available Specimen from the list, that was created in the SeqScape

7. Results Group Some options:

• New: Opens the Results Group Editor dialog box

• Edit: Opens the Results Group Editor dialog box for the Results Group listed in 
the cell

• None: Sets the cell to have no selected Results Group

• Select one of the available Results groups from the list

Note: You must have a Results Group selected for each sample entered in the 
Sample Name column.

See, “Creating a Results Group” on page 115.
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8. Instrument Protocol • New: Opens the Protocol Editor dialog box. 

• Edit: Opens the Protocol Editor dialog box for the Instrument Protocol listed in 
the cell.

• None: Sets the cell to have no selected protocol.

• List of Instrument Protocols: In alpha-numeric order.

Note: You must have an Instrument Protocol selected for each sample entered in 
the Sample Name column.

See, “Creating an Instrument Protocol” on page 106.

9. Analysis Protocol • New: Opens the Analysis Protocol Editor dialog box. 

• Edit: Opens the Analysis Protocol Editor dialog box for the Instrument Protocol 
listed in the cell. 

• None: Sets the cell to have no selected protocol.

• List of Analysis Protocols: In alpha-numeric order 

Note: You must have an Analysis Protocol selected for each sample entered in the 
Sample Name column.

See, “Creating an Analysis Protocol” on page 110.

Number and Column Description
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Creating Required Files for Automated SeqScape Analysis

If the Files Already Exist

If the appropriate data collection and SeqScape files 
have been created, proceed to “Creating and 
Completing a SeqScape Plate Record” on page 119. 

Instrument Protocol for SeqScape

About Instrument Protocols

An instrument protocol contains all the settings 
necessary to run the instrument. An instrument 
protocol contains the protocol name, type of run, run 
module, and dye set.

Creating an Instrument Protocol

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 
ga3100-Avant >  Protocol Manager.

Create instrument 
protocols here

Create analysis 
protocols here
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2. In the Instruments Protocols section, click 
. 

The Protocol Editor opens. 

3. Complete the Protocol Editor:

a. Type a name for the protocol.

b. Type a description for the protocol 
(optional).

c. Select Regular in the Type drop-down list.

d. Using the information in the table below, 
select the correct run module for your run. 
(See “Tip: Customizing Run Modules” on 
page 82, if you want to modify a default 
module.)

3a

3b

3c

3d

3e

3f

Sequencing Run Capillary Array 
Length (cm) Run Module

Ultra rapid 36 UltraSeq36_POP4_1

Rapid 36 RapidSeq36_POP6_1

Standard 50 StdSeq50_POP4_1

StdSeq50_POP6_1

Long read 80 LongSeq80_POP4_1
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e. Using the information in the table below, 
select the correct Dye Set for your run.

f. Click .

Importing an Instrument Protocol

1. Select Import in the Instrument Protocols pane 
of the Protocol Editor window.

2. Navigate to the protocol you want to import.

3. Double-click the protocol to import it.

The imported file is displayed as the top row in 
the Instrument Protocol pane.

Dye Set Chemistry Instrument

E_BigDyeV1 ABI PRISM® BigDye® v1.1 Primer 3100 only

ABI PRISM® BigDye® v1.1 Terminator 3100/3100-Avant

ABI PRISM® dRhodamine Terminator

ABI PRISM® dGTP BigDye® Terminator

Z_BigDyeV3 ABI PRISM® BigDye® v3.1 Primer 3100 only

ABI PRISM® BigDye® v3.1 Terminator 3100/3100-Avant

ABI PRISM® dGTP BigDye® v3.0 Terminator

Note: Import file type is .txt (text).
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Analysis Protocol for SeqScape

About Analysis
Protocols

New to Data Collection is the implementation of analysis protocols. An analysis protocol 
contains all the settings necessary for analysis and post processing: 

• Protocol name – The name, description of the analysis protocol, and the sequence 
file formats to be used

• Basecalling settings – The basecaller, DyeSet/Primer file, and analysis stop point to 
be used

• Mixed Bases – Option: to use mixed base identification, and if so, define the percent 
value of the second highest to the highest peak

• Clear Range – The clear range to be used based on base positions, sample quality 
values, and/or number of ambiguities (Ns) present

• Filter – The settings used to reject sequences that are not used in the assembly

Note: If you created an appropriate analysis protocol in the SeqScape software, you can 
use it in data collection software. 

IMPORTANT! Do not delete an Analysis Protocol during a run while it is being used for 
that run. Autoanalysis will not be performed if you do so.
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Creating an Analysis Protocol

 

1. In the Analysis Protocol section of the Protocol 
Manager, click .

If more than one analysis application is installed 
on the data collection computer, the Analysis 
Applications dialog box opens. 

2. Select SeqScape, then click .

The Analysis Protocol Editor dialog box opens.

IMPORTANT! If you created an appropriate analysis 
protocol in SeqScape software, you can use it in data 
collection software. You can also create an analysis 
protocol in the SeqScape software, if desired.

Note: Refer to the ABI PRISM® SeqScape Software 
v2.1 User Guide (P/N 4346367) for more 
information.
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3. In the General tab, enter a unique name and 
description (optional) for the new protocol.

4. Select the Basecalling tab, then:

a. Use Appendix B, “Basecallers and 
DyeSet/Primer Files,” to select the 
appropriate basecaller and DyeSet primer 
based on the chemistry, capillary array 
length and polymer type you are using.

4c

4d

4a

4b

Note:  Sequencing Analysis Software v5.1 
and 3100/3100-Avant Data Collection 
software filter .mob file choices to match 
the chosen .bcp file.
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b. In the Processed data pane, select True or 
Flat profile.

c. If desired, select one or more stop points for 
data analysis. 

d. Select your Threshold Quality option.

5. Select the Mixed Bases tab, then:

a. For mixed bases only, select Use Mixed 
Base Identification. 

b. Use the default setting of 25% or change the 
detection level by entering a new value or 
dragging the % line up or down.

Option Function

Used to display data as processed traces scaled uniformly so that the average 
height of peaks in the region of strongest signal is about equal to a fixed value. 
The profile of the processed traces will be very similar to that of the raw traces.

Used to display the data as processed traces scaled semi-locally so that the 
average height of peaks in any region is about equal to a fixed value. The profile of 
the processed traces will be flat on an intermediate scale (> about 40 bases).

Note: This option is applied to data that is analyzed with the KB basecaller only. 
If you use the ABI basecaller the profile option reverts to True Profile.

Option Function

When using the KB basecaller, use this setting assign a base to 
every position, as well as the QV.

When using the KB basecaller, use this setting assign Ns to base 
with QVs less than the set point. The QV will still be displayed.

Note: This function is active with the KB 
basecaller only.

Note: Do not use less than 15% as your 
detection limit.
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6. Select the Clear Range tab, then, if desired, 
select one or more stop points for data analysis.

Note: The clear range is the region of the 
sequence that remains after excluding the low-
quality or error-prone sequence at both the 5´ 
and 3´ ends.

7. Select the Filter tab, then, if desired, change one 
or more of the settings.

8. Click  to save the protocol and close the 
Analysis Protocol Editor dialog box.
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Editing an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to edit.

2.  Click .

3. Make changes in the General, Basecalling, 
Mixed Bases and Clear Range tabs, as 
appropriate.

4. Click  to save the protocol and close the 
Analysis Protocol Editor dialog box.

Deleting an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis 
Protocol Manager, highlight the protocol you 
want to delete.

2. Click .

The Deletion Confirmation dialog box displays.

3. Click .

IMPORTANT! Do not delete an Analysis Protocol 
during a run while it is being used for that run. 
Autoanalysis will not be performed if you do so. Also, 
You must first delete any plate records using the 
Analysis Protocol before you can delete or modify the 
Analysis Protocol for these plate records. 

Note: It is better to delete the Analysis Protocol 
from the SeqScape Software v2.1.
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Results Group for SeqScape

A Results Group is a component within Data 
Collection that organizes samples and certain user 
settings under a single name. It is called a Results 
Group because it is used to analyze, name, sort, and 
deliver samples that result from a run. 

Creating a Results Group 

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  Results Group.

2. Click . 

The Results Group Editor window displays.

3. Complete the General tab:

a. Type a Results Group Name. The name can 
be used in naming and sorting sample files. 
It must be unique (see page for a list of 
accepted characters).

b. Type a Results Group Owner (optional). The 
owner name can be used in naming and 
sorting sample files.

c. Type a Results Group Comment (optional).

3a

3b

3c
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4. Select the Analysis tab, then:

a. Select SeqScape_ computer name in the 
Analysis Type drop-down list.

b. Select Do Autoanalysis in the Analysis 
Actions section.

c. Type a valid SeqScape Login ID and 
Password in the text boxes.

5. Select the Destination tab, then use the default 
destination or define a new location for data 
storage.

a. Click Use Custom Location, then click 
 to navigate to a different save 

location.

b. Click  to test the Location path 
name connection:

If it passes, a message box displays “Path 
Name test successful.”

If it fails, a message box displays “Could 
not make the connection. Please check that 
the Path Name is correct.” Click and retry to 
establish a connection.

c. Click .

4a

4bIMPORTANT! Failure to use the proper 
login and password causes your samples not 
to be analyzed automatically.

5a

5b

5c

To use … Then …

default location skip to step 6

custom location complete steps a-c
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6. Select the Naming tab, then define custom 
names for sample file and run folder name.

7. Click  to save and close the Results 
Group Editor.
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Importing and
Exporting a

Results Group

Results Groups can be imported from, or exported to, tab-delimited text files. This 
allows easy sharing of identical Results Groups between instruments.

Importing a Results Group

1. In the Tree pane of the Data Collection Software, click 
 GA Instruments >  Results Group.

2. Click .

A standard File Import dialog box displays.

3. Navigate to the file you want to import.

Note: Import file type is .txt (text).

4. Click .

Note:  When you import or duplicate a Results Group, you are asked to type a 
name for the new Results Group and for the analysis application type.

Exporting a Results Group

1. In the Tree pane of the Data Collection Software, click 
 GA Instruments >  Results Group.

2. Click the Results Group name to select it.

3. Click .

A standard file export dialog box displays with the chosen Results Group name.

4. Navigate to the location where you want to save the exported file.

5. Click .

Duplicating a Results Group

1. Click the Results Group to select it.

2. Click . 

Note: If there is a name conflict with a Results Group that already exists at the 
save location, the Results groups can be duplicated in order to copy settings into a 
similar Results Group without the risk of user error when copying it manually (see 
procedure below).

Note: When you import or duplicate a Results Group, you are asked to type a name 
for the new Results Group and for the analysis application type.
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Creating and Completing a SeqScape Plate Record

Creating a SeqScape Plate Record

1. Click the Plate Manager icon in the navigation 
pane.

2. Click .

The New Plate Dialog dialog box opens.

3. In the New Plate dialog box:

a. Type a name for the plate.

b. Type a description for the plate (optional).

c. Select SeqScape_computer name in the 
Application drop-down list.

d. Select 96-well or 384-well in the Plate Type 
drop-down list.

e. Type a name for the owner.

f. Type a name for the operator.

g. Click . 

The SeqScape Plate Editor opens.

3a

3b

3c

3d

3e

3f

3g 
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Completing a SeqScape Plate Record

1. In the Sample Name column of a row, enter a 
sample name, then click the next cell. The value 
100 automatically display in the Priority column.

2. In the Comments column, enter any additional 
comments or notations for the sample.

3. In the Priority column, change the priority value, 
if desired (see page 262).

4. In the Project column, select a project from the 
drop-down list. 

Based on the Project you select, the project 
template is filled in automatically.

5. In the Specimen column, select a specimen.

6. In the Results Group 1 column, select a group 
from the drop-down list (see page 115).

7. In the Instrument Protocol 1 column of the row, 
select a protocol from the drop-down list (see 
page 106).

8. In the Analysis Protocol 1 column of the row, 
select a protocol from the drop-down list (see 
page 110).

1 2 4 53

6 7 8



Creating and Completing a SeqScape Plate Record
Completing a SeqScape Plate Record

ABI PRISM 3100/3100-Avant Genetic Analyzers User Guide 121

Notes

4

9. To complete the rest of the plate record based on 
the samples loaded in your plate, do one of the 
following:

• For the same samples and protocols – 
Highlight the entire row, then select Edit > 
Fill Down Special.

Based on the plate type (96- or 384-well) 
and capillary array (16 or 4 capillaries) you 
are using, the software automatically fills in 
the appropriate well numbers for a single 
run (see page 265).

• For the same samples and protocols – 
Highlight the entire row, then select Edit > 
Fill Down.

• For the different samples and protocols – 
Complete the manually.

10. If you want to do more than one run, then select 
Edit > Add Sample Run.

Additional Results Group, Instrument Protocol 
and Analysis Protocol columns are added to the 
right end of the plate record.

You can add additional runs by selecting Edit > 
Add Sample Run again.

11. Complete the columns for the additional runs.

12. Click  to save, then close the plate record.

IMPORTANT! After clicking OK within the Plate 
Editor, the completed plate record is stored in the 
Plate Manager database. Once in the Plate 
Manager database, the plate record can be 
searched for, edited, exported, or deleted.
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Where to Go Next
Use the table below to determine which chapter to proceed to next.

Do you need to… Proceed to …

Set up the software for fragment analysis runs? Chapter 5, page 123

Start and monitor a run? Chapter 6, page 149

Perform maintenance, use wizards? Chapter 7, page 195

Activate/modify the audit trail and access control features? Chapter 8, page 241

Learn more about on plate record feature? Appendix A, page 261

Learn more about troubleshooting? Appendix C, page 279
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3100/3100-Avant Data Collection and GeneMapper Software

Important Notes • A unique name must be assigned to the instrument computer before 3100/3100-
Avant Data Collection software is installed. 

• Do not rename the computer once 3100/3100-Avant Data Collection software has 
been installed. Doing so may cause the 3100/3100-Avant Data Collection software 
to malfunction. 

File-Naming
Convention

Some alphanumeric characters are not valid for user names or file names. The invalid 
characters are below:

spaces 

\ / : * ? " < > | 

Autoanalysis You may choose to perform autoanalysis of fragment analysis samples by utilizing 
features of the 3100/3100-Avant Data Collection and GeneMapper software.

GeneMapper Software v3.5

Autoanalysis can be performed on the same instrument that collected the sample files or 
on a remote computer.

GeneMapper ID Software v3.1

Autoanalysis can only be performed on the same instrument that collected the sample 
files. If you wish to analyze samples on another computer, you must transfer the files to 
that location. 

If a user performs autoanalysis on samples, but wishes to edit/review results on another 
computer, they will need to transfer the GeneMapper software project, analysis methods, 
size standards, panel and bin set information to the other GeneMapper software 
database. There is no easy method for transferring all components of a project from one 
GeneMapper software database to another. All components need to be exported and 
imported individually. 

When completing the Plate Record, you need to fill in Instrument Protocol information 
for Data Collection to complete the run. Additionally, when creating a new Results 
Group for a set of samples to be autoanalyzed, you must check the Do Autoanalysis 
check box (and for remote analysis, define a default location for sample file storage).

Note: This chapter is written for both GeneMapper™ Software v3.5 and GeneMapper™ 
ID Software v3.1. The graphics used in this chapter are of the GeneMapper software 
v3.5.

IMPORTANT! An error message is displayed if you use any of these characters. You 
must remove the invalid character to continue.
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Manual Analysis For information on manual analysis, refer to GeneMapper Software Version 3.5 User 
Guide (PN 4343790) or GeneMapper ID Software Version 3.1 User Guide 
(PN 4338775).

About Fragment
Analysis and Data

Collection

When GeneMapper software is installed on a computer that has 3100/3100-Avant 
Genetic Analyzer Data Collection Software, two applications are available through the 
Results Group Editor (see page 136):

• GeneMapper-Generic

and,

• GeneMapper-<Computer Name>

GeneMapper-
Generic

GeneMapper-Generic enables you to generate .fsa files, but not perform autoanalysis. 
When completing the Sample Sheet, you need to fill in basic information for Data 
Collection to complete the run; all other GeneMapper software related fields are text 
entries. This is useful if you are using other software applications for analysis. This is 
also useful if you choose to analyze your samples in GeneMapper software on another 
computer, but do not have the same entries in the GeneMapper software database stored 
on the Data Collection computer. For example, if you have a customized size standard 
definition on the other GeneMapper software computer, you can type in that size 
standard name in the size standard text field and it will populate that column in your 
GeneMapper software project.

GeneMapper-
<Computer

Name>

GeneMapper-<Computer Name> is for autoanalysis. The Size Standard, Analysis 
Method, and Panel columns in the Sample Sheet window read directly from the 
GeneMapper software database. These components must be created in GeneMapper 
software prior to setting up the plate record for a run. There is no way to create a new 
entry for these columns once inside the plate editor dialog box. If you create a new 
GeneMapper software component while the plate record dialog box is open, the columns 
will not update. The plate record must be closed and reopened to update the 
GeneMapper software components. For more information see, “Creating Required Files 
for Automated Fragment Analysis” on page 131.
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Workflow for
Autoanalysis

Using
GeneMapper

Software

Register software and 
create user IDs

Create 
Instrument Protocol

Create 
Results Group

Is 
GeneMapper 

registered and have 
user IDs been 

created?

Open 
Autoanalysis Manager

Set up instrument and 
prepare samples

Do
you have an 

Instrument Protocol, 
and Results 

Group?

Search for plate record, 
then link plate

Start and monitor run

Create and save 
plate record

No

No

Yes

 Create definitions for:
 - Analysis Method
 - Panel
 - Size Standard
 - Bin Set
 - SNP Set

Have
you created 

definitions for 
Size Std, Panel, Analysis 
Method and SNP Set in 

GeneMapper
software?

No

Yes

Yes

Autoanalysis Manager 
automatically processes 

the data

Review data in 
GeneMapper software
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About GeneMapper Plate Records

Overview A plate record is similar to a sample sheet or an injection list that you may have used 
with other ABI PRISM® instruments. 

Plate records are data tables in the instrument database that store information about the 
plates and the samples they contain. Specifically, a plate record contains the following 
information:

• Plate name, type, and owner

• Position of the sample on the plate (well number)

• Comments about the plate and about individual samples

• Dye set information (in Instrument protocol)

• Name of the run module (run modules specify information about how samples 
are run) (in Instrument protocol)

When to Create a
Plate Record

A plate record must be created for each plate of samples for the following types of runs: 

• Spectral calibrations

• Fragment analysis

• SeqScape analysis

• Sequencing analysis

• Mixed (sequencing, Seqscape, and fragment analysis samples) see 
“Multi-application (Mixed) Plate Record” on page 269

Additionally, Plate Records must be created in advance of placing the plates on the 
instrument. However, Plate Records can be created while a run is in progress.

The 3100/3100-Avant Data Collection Software contains several new features that are 
briefly described here and in more detail throughout this section.

IMPORTANT! In order for data collection and auto-analysis to be successful, each run of 
samples must have an Instrument Protocol, a Results Group and files created in 
GeneMapper software assigned within a plate record.

Parameters Description See 
Page

Instrument 
Protocol

Contains everything needed to run the instrument. 131

Results Group Defines the file type, the file name, autoanalysis, and file save 
locations that are linked to sample injections.

136
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Elements of a GeneMapper plate record 

Blank GeneMapper plate record

Plate Record

Plate Manager

Analysis method

Bin set

Panel

GeneMapper software 
definitions:

Size standard

SNP Set

Results Group
 Name

Analysis software 
and autoanalysis

Results Group

Instrument 
Protocol Name

Run type 
(Regular)

Instrument Protocol

Run module

Dye set

File storage 
location

File and run folder
name preferences

Data Collection 
software files:

1 54 82 3 6 7 9 1110

Defaults to one sample run, to add additional runs see page 146
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The following table describes the columns inserted in a Plate Record for a fragment 
analysis run. 

Number and Column Description

1. Sample Name  Name of the sample

2. Comment Comments about the sample (optional)

3. Priority A default value of 100 to each sample. Changing the value to a 
smaller number causes that set of 16 or 4 samples to run to 
before the others in the injection list.

4. Sample Type Use to identify the sample as Sample, Positive Control, Allelic 
Ladder or Negative Control.

5. Size Standard

IMPORTANT! For GeneMapper-<Computer 
Name> ONLY: 

Size Standard, Panel, and Analysis Method must 
be created in GeneMapper software before 
creating a new plate

• GeneMapper-Generic (optional):

Manually enter size standards in the text field*

• GeneMapper-<Computer Name>:

Select a saved size standard from the drop-down list

6. Panel 

IMPORTANT! For GeneMapper-<Computer 
Name> ONLY: 

Size Standard, Panel, and Analysis Method must 
be created in GeneMapper software before 
creating a new plate

• GeneMapper-Generic (optional):

Manually enter panels in the text field*

• GeneMapper-<Computer Name>:

Select a saved panel from the drop-down list

7. Analysis Method

IMPORTANT! For GeneMapper <Computer 
Name> ONLY: 

Size Standard, Panel, and Analysis Method must 
be created in GeneMapper software before 
creating a new plate

• GeneMapper-Generic (optional):

Manually enter analysis methods in the text field*

• GeneMapper-<Computer Name>:

Select a saved analysis method from the drop-down list

8. SNP Set

IMPORTANT! For GeneMapper <Computer 
Name> ONLY: 

The SNP set is a file created in the GeneMapper 
software that links a SNP name to a marker name.

• GeneMapper-Generic (optional):

Manually enter SNP set in the text field*

• GeneMapper-<Computer Name>:

Use for SNPlex chemistry, select a saved SNP set the drop-
down list 

9. 3 User-defined columns Optional text entries

10. Results Group Some options:

• New: Opens the Results Group Editor dialog box

• Edit: Opens the Results Group Editor dialog box for the 
Results Group listed in the cell

• None: Sets the cell to have no selected Results Group

• Select one of the available Results groups from the list

Note: You must have a Results Group selected for each 
sample entered in the Sample Name column.

See, “Results Group for Fragment Analysis” on page 136.
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11. Instrument Protocol • New: Opens the Protocol Editor dialog box. 

• Edit: Opens the Protocol Editor dialog box for the 
Instrument Protocol listed in the cell.

• None: Sets the cell to have no selected protocol.

• List of Instrument Protocols: In alpha-numeric order.

Note: You must have an Instrument Protocol selected for 
each sample entered in the Sample Name column.

See, “Results Group for Fragment Analysis” on page 136.

Number and Column Description
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Creating Required Files for Automated Fragment Analysis

If the Files Already Exist

If the appropriate data collection and fragment 
analysis files have been created, proceed to “Creating 
and Completing a GeneMapper Plate Record” on 
page 144. 

Instrument Protocol for Fragment Analysis

About Instrument Protocols

An instrument protocol contains all the settings 
necessary to run the instrument. An instrument 
protocol contains the protocol name, type of run, run 
module, and dye set.

Creating an Instrument Protocol

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 
ga3100-Avant >  Protocol Manager.

Create instrument 
protocols here

Create analysis 
protocols here



Chapter 5 3100/3100-Avant Data Collection and Fragment Analysis
Creating Required Files for Automated Fragment Analysis

132 ABI PRISM 3100/3100-Avant Genetic Analyzers User Guide

Notes

2. In the Instruments Protocols section, click 
. 

The Protocol Editor opens. 

3. Complete the Protocol Editor:

a. Type a name for the protocol.

b. Type a description for the protocol 
(optional).

c. Select Regular in the Type drop-down list.

3a

3b

3c

3d

3e

3f
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d. Using the information in the table below, 
select the correct run module for your run. 
To customize a run module, see “Tip: 
Customizing Run Modules” on page 135.

Application or Kit Capillary Array 
Length Run Module

SNaPshot Multiplex System 22 cm SNP22_POP4_1

36 cm SNP36_POP4_1

• LMS v2.5

• ABI PRISM Mouse Mapping Set 
v1.0

• Custom oligos

22 cm FragmentAnalysis22_POP4_1

36 cm FragmentAnalysis36_POP4_1

• AmpFlSTR COfiler Kit

• AmpFlSTR Profiler Plus Kit

• AmpFlSTR SGM Plus Kit

• AmpFlSTR Profiler Plus ID Kit

• AmpFlSTR SEfiler Kit

• Other 4-Dye AmpFlSTR Kits

• AmpFlSTR Identifiler Kit

• Other 5-Dye AmpFlSTR Kits

36 cm HIDFragmentAnalysis36_POP4_1

• LMS v2.5

• ABI PRISM Mouse Mapping Set 
v1.0

• Custom oligos

50 cm FragmentAnalysis50_POP4_1

• LMS v2.5

• ABI PRISM Mouse Mapping Set 
v1.0

• Custom oligos

50 cm FragmentAnalysis50_POP6_1
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e. Using the information in the table below, 
select the correct Dye Set for your run.

f. Click .

Importing an Instrument Protocol

1. Click  in the Instrument Protocols pane 
of the Protocol Editor window.

2. Navigate to the protocol you want to import.

Application or Kit Dye Set Matrix Standard 
Set

Custom oligos D DS-30

• ABI PRISM Mouse Mapping Set v1.0

• Custom oligos

D DS-31

• AmpFlSTR® COfiler® Kit

• AmpFlSTR® Profiler® Plus Kit

• AmpFlSTR® SGM Plus™ Kit

• AmpFlSTR® Profiler Plus ID Kit

• Other 4-Dye AmpFlSTR Kits

F DS-32

 ABI PRISM® SNaPshot® Multiplex System E5 DS-02

• ABI PRISM® Linkage Mapping Set v2.5

• Custom Oligos

• AmpFlSTR® Identifiler™ Kit

• AmpFlSTR® SEfiler Kit

• Other 5-Dye AmpFlSTR Kits

G5 DS-33

Note: Import file type is .txt (text).
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3. Double-click the protocol to import it.

The imported file is displayed as the top row in 
the Instrument Protocol pane.

Tip: Customizing Run Modules 

You can modify default run modules to suit your 
particular needs. 

1. Click  GA Instruments >  ga3100 or ga3100-
Avant >  instrument name >  Module 
Manager. 

2. Click .

The Run Module Editor dialog box opens.

3. Complete the Run Module Editor dialog box:

a. Enter a name for your new module.

b. In the Type drop-down list, select the type of 
module (Regular, Spatial or Spectral).

c. In the Template drop-down list, select a template 
module as a basis for the new module.

Note: You cannot edit a default module installed 
with 3100/3100-Avant Data Collection software.

d. Optional: Enter a description of your new run 
module.

3d

3c

3b

3f

3e

3a
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Results Group for Fragment Analysis

A Results Group is a component within Data 
Collection that organizes samples and certain user 
settings under a single name. It is called a Results 
Group because it is used to analyze, name, sort, and 
deliver samples that result from a run. 

Creating a Results Group for Autoanalysis

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  Results Group.

2. Click . 

The Results Group Editor window displays.

e. Change to the desired module parameters using 
the table below as a guide to the allowable 
parameters.

f. Click OK.

Tip: Customizing Run Modules (continued)

Name Range Comment

Oven_Temperature 18-65 C Temperature setting for main oven throughout run.

PreRun_Voltage 0-15 kV Pre run voltage setting before sample injection.

PreRun Time 1-1000 sec Prerun voltage time.

Injection_Voltage 0-15 kV Injection voltage setting for sample injection.

Injection_Time 1-600 sec Sample injection time.

Run_Voltage 0-15 kV Final run voltage.

Voltage_Number_Of_Steps 0-100 steps Number of voltage ramp steps to reach Run_Voltage. We 
recommend that you do not change this value unless advised 
otherwise by Applied Biosystems support personnel.

Voltage_Step_Interval 0-60 sec Dwell time at each voltage ramp step. We recommend that you 
do not change this value unless advised otherwise by Applied 
Biosystems support personnel.

Data_Delay_Time 1-3600 sec Time from the start of separation to the start of data collection.

Run_Time 300-14000 sec Duration data is collected after Data_Delay_Time.
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3. Complete the General tab:

a. Type a Results Group Name. The name can 
be used in naming and sorting sample files. 
It must be unique (see page for a list of 
accepted characters).

b. Type a Results Group Owner (optional). The 
owner name can be used in naming and 
sorting sample files.

c. Type a Results Group Comment (optional).

4. Select the Analysis tab, then:

a. Click the Analysis Type and then select one 
of the following:

b. In the Analysis Actions section, use the 
table below to select an option.

3a

3b

3c

4a

4b

4c

4d

If You Select ... Then ...

None Only raw data files are 
generated

GeneMapper-
Generic

Autoanalysis is not enabled 
and only .fsa files are 
generated

GeneMapper-
<Computer Name>

Autoanalysis of completed 
runs is enabled

Steps b, c, and d below 
apply only to GeneMapper-
<Computer Name> (not 
GeneMapper-Generic).

If You Select … Then … Use with Setting from Automated 
Processing Tab (page 139)

Do Autoanalysis Samples are analyzed after each run of 
16 or 4 samples.

When every run completes

Do Autoanalysis and 
Results Entry Group 
Complete

Samples are analyzed after all samples 
using the same results group have been 
run.

Only when the result group is complete
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c. Type the Login ID.

d. Type the login password.

The login ID and password relate to the 
GeneMapper software UserName and Password. 
These items can only be created through the 
GeneMapper software Options Users tab.

5. Select the Destination tab, then use the default 
destination or define a new location for data 
storage.

a. Click Use Custom Location, then click 
 to navigate to a different save 

location.

b. Click  to test the Location path 
name connection:

If it passes, a message box displays “Path 
Name test successful.”

If it fails, a message box displays “Could 
not make the connection. Please check that 
the Path Name is correct.” Click and retry to 
establish a connection.

c. Click .

5a

5b

5c

To use a … Then …

default location skip to step 6

custom location 

Use for remote analysis 
using GeneMapper v3.5

complete steps a-c
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6. Select the Naming tab.

Use the Naming tab to customize sample file and 
run folder names. 

The elements of the Naming tab are discussed in 
the following sections, see page 140.

7. Select the Automated Processing tab.

In the “Autoanalysis is performed” section, use 
the table below to select when you want your 
samples autoanalyzed.

8. Click  to save the Results Group. 

Sample File Name Format pane

Run Folder Name Format pane

IMPORTANT! Sample name, run folder name, 
and path name, combined, can total no more than 
250 characters. See page 124 for accepted 
characters.

IMPORTANT! You must select at least one 
Format element for the Sample file and the Run 
folder names in order to proceed within the 
Results Group.

Select an autoanalysis option

If You Select … Then … Use with Settings from Analysis Tab
(page 137)

Only when the result group 
is complete

Samples are analyzed after all samples 
using the same results group have been 
run.

 Do Autoanalysis and Results Entry 
Group Complete

When every run completes Samples are analyzed after each run of 
16 or 4 samples.

Do Autoanalysis
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Sample File Name Format Pane

Follow the procedure below to complete the Sample 
File Name Format pane.

1. Click the Prefix box (optional) to type a prefix 
for the file name. Anything that you type here is 
shown in the Example line (see graphic below). 

2. Click the Name Delimiter list choose the 
symbol that will separate the Format elements in 
the file name (see step 3 below). Only one 
delimiter symbol may be chosen.

3. Click the Format list and then select the 
components that you want in the sample name. 

For example, if a unique identifier is not included 
in the name, a warning message displays. The 
Results Group makes the file name unique. As 
you select the elements for the file name, they are 
reflected in the Example line. 

Note: Generally, all the samples from a single 
run are placed in the same run or results folder, 
so the name of every sample from a single run 
should be different. Most of the Format options 
will not be different between samples, so you 
need to take care to select at least one of the 
options that make the sample names unique 
within a run. 
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As you continue to select elements for the file 
name, additional elements display.

The names of the Format elements eventually 
truncate, but the Example field remains visible 
(up to 72 characters).

4. Click the Suffix box (optional) and type the 
suffix for the file name.

The File Extension field displays the file 
extension generated from the Analysis Type 
specified on the Analysis tab (see page 137). For 
example, Sequencing Analysis and produces 
sample files with an .ab1 extension.

Run Folder/Sub-Folder Name Format Pane

Follow the same steps described above for the Sample 
File Name Format pane (see page 140) to change the 
sub-folder name within the run folder.

About Format Elements (Unique Identifiers)

While you may select a minimum of just one Format 
element for the Sample file and Run folder names in 
order to save a Results Group, selecting just the 
minimum may not provide enough information for 
you to identify the file or folder later.
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For example, although acceptable, the ‘A34’ sample file name below (well position) may 
not be helpful when trying to locate and identify the file later. 

If you choose elements from the Format lists that do not create unique Sample file or 
Run folder names, a warning message displays below the Example line.

To remove the warning message and proceed within the Results Group Editor window, 
simply select a Format element that distinguishes one file from another (for example, the 
capillary number is unique while the instrument name is not).

Warning message
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Importing and
Exporting a

Results Group

Results Groups can be imported from, or exported to, tab-delimited text files. This 
allows easy sharing of identical Results Groups between instruments.

Importing a Results Group

1. In the Tree pane of the Data Collection Software, click 
 GA Instruments >  Results Group.

2. Click .

A standard File Import dialog box displays.

3. Navigate to the file you want to import.

Note: Import file type is .txt (text).

4. Click .

Note:  When you import or duplicate a Results Group, you are asked to type a 
name for the new Results Group and for the analysis application type.

Exporting a Results Group

1. In the Tree pane of the Data Collection Software, click 
 GA Instruments >  Results Group.

2. Click the Results Group name to select it.

3. Click .

A standard file export dialog box displays with the chosen Results Group name.

4. Navigate to the location where you want to save the exported file.

5. Click .

Duplicating a Results Group

1. Click the Results Group to select it.

2. Click . 

Note: If there is a name conflict with a Results Group that already exists at the 
save location, the Results groups can be duplicated in order to copy settings into a 
similar Results Group without the risk of user error when copying it manually (see 
procedure below).

Note: When you import or duplicate a Results Group, you are asked to type a name 
for the new Results Group and for the analysis application type.
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Creating and Completing a GeneMapper Plate Record

Creating the GeneMapper Plate Record for 
Autoanalysis

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 
ga3100-Avant >  Plate Manager.

2. Click .

The New Plate Dialog dialog box opens.

3. Complete the information in the New Plate 
Dialog:

a. Type a name for the plate.

b. Type a description for the plate (optional).

c. Select your GeneMapper application in the 
Application drop-down list.

d. Select 96-well or 384-well in the Plate Type 
drop-down list.

e. Type a name for the owner. 

f. Type a name for the operator.

g. Click . 

The GeneMapper Plate Editor opens.

3a

3b

3c

3d

3e

3f

3g
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Completing a GeneMapper Plate Record 
for Autoanalysis

1. In the Sample Name column of a row, enter a 
sample name, then click the next cell. The value 
100 automatically display in the Priority column.

2. In the Comment column, enter any additional 
comments or notations for the sample.

3. In the Priority column, change the priority value, 
if desired (see page 262).

4. In the Sample Type column, select a sample type 
from the drop-down list. 

5. In the Size Standard column, select a size 
standard from the drop-down list.

6. In the Panel column, select a panel from the 
drop-down list.

7. In the Analysis Method column, select a method 
from the drop-down list.

8. In the Snp Set column, select a SNP set from the 
drop-down list.

9. Enter text for User-Defined columns 1 to 3.

10. In the Results Group 1 column, select a group 
from the drop-down list (see page 136).

11. In the Instrument Protocol 1 column, select a 
protocol from the drop-down list (see page 131).

1 2 4 53

6 87 9

9 1110
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12. To complete the rest of the plate record based on 
the samples loaded in your plate, do one of the 
following:

• For the same samples and protocols – 
Highlight the entire row, then select Edit > 
Fill Down Special.

Based on the plate type (96- or 384-well) 
and capillary array (16 or 4 capillaries) you 
are using, the software automatically fills in 
the appropriate well numbers for a single 
run (see page 265).

• For the same samples and protocols – 
Highlight the entire row, then select Edit > 
Fill Down.

• For the different samples and protocols – 
Complete the manually.

13. If you want to do more than one run, then select 
Edit > Add Sample Run.

Additional Results Group, Instrument Protocol 
and Analysis Protocol columns are added to the 
right end of the plate record.

You can add additional runs by selecting Edit > 
Add Sample Run again.

14. Complete the columns for the additional runs.

15. Click  to save, then close the plate record.

IMPORTANT! After clicking OK within the 
Plate Editor, the completed plate record is stored 
in the Plate Manager database. Once in the Plate 
Manager database, the plate record can be 
searched for, edited, exported, or deleted.



Where to Go Next
Completing a GeneMapper Plate Record for Autoanalysis

ABI PRISM 3100/3100-Avant Genetic Analyzers User Guide 147

Notes

5

Where to Go Next
Use the table below to determine which chapter to proceed to next.

Do you need to… Proceed to …

Start and monitor a run? Chapter 6, page 149

Perform maintenance, use wizards? Chapter 7, page 195

Activate/modify the audit trail and access control features? Chapter 8, page 241

Learn more about on plate record feature? Appendix A, page 261

Learn more about troubleshooting? Appendix C, page 279
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Running the Instrument
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Working with Plate Assemblies

Plate Assembly Components

Each 96- or 384-well assembly contains a:

• Plate retainer

• Plate septa

• sample plate

• Base plate

Preparing a Plate Assembly

1. Seal the plate:

a. Place the plate on a clean, level surface.

b. Lay the septa flat on the plate.

c. Align the holes in the septa strip with the 
wells of the plate, then firmly press 
downward onto the plate.

WARNING Do not 
use warped or damaged plates.

Plate retainer

Sample plate 

Plate base

Plate septa

G
R
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2. To prevent damage to the capillary array, inspect 
the plate and septa to verify the septa fits snugly 
and flush on the plate.

3. Assemble the plate assembly:

a. Place the sample plate into the plate base. 

b. Snap the plate retainer onto the plate and 
plate base.

4. Verify that the holes of the plate retainer and the 
septa strip are aligned. If not, re-assemble the 
plate assembly (see step 3).

Septa and well 
not aligned

Septa and well 
not aligned

G
R

20
50

b

Assembled 
components 

3a
3b

Plate retainer 
holes and septa
holes are not 
aligned

IMPORTANT! Damage to the array tips will 
occur if the plate retainer and septa strip holes do 
not align correctly.
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Placing the Plate onto the Autosampler

1. Close the oven and front doors.

2. Press the Tray button.

3. Open the front doors.

4. Place the plate assembly on the autosampler in 
position A or B for the 3100 instrument and 
position B for the 3100-Avant instrument.

5. Ensure the plate assembly fits flat in the 
autosampler. Failure to do so may allow the 
capillary tips to lift the plate assembly off of the 
autosampler.

6. Close the instrument doors.

G
R

21
42

G
R

21
42

3100-Avant instrument 

3100 instrument 

Note: There is only one orientation for the plate, 
with the notched end of the plate base away from 
you.

Note: Closing the doors returns the autosampler 
to the home position, placing the tips of the 
capillaries in buffer.
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Linking and Unlinking a Plate
The procedure below describes how to link a plate on 
the autosampler to the plate record you have created. 
This must be done before a plate can be run.

Searching for Plate Records 

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 
ga3100-Avant >  instrument name >   Run 
Scheduler.

Switch 
between 
Barcode 
and 
Advanced 
search

Mounted, 
unlinked 
plates

Empty plate record section
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2. Search for your plate record. There are two 
search options, Find All and Advanced.

• Find All

– Select Barcode in the Type of Search 
drop-down list.

– If you have a limited number of plates in 
the database, click . 

All plates in the database display in plate 
record section.

• Advanced 

– Select Advanced in the Type of Search 
drop-down list.

– Use the drop-down list to define search 
conditions for a category or multiple 
categories (Run Name, Results Group 
Name, Plate Name, etc.).

– For each category with a condition 
selected, type a value (primary search 
string) in the Value 1 column.

– Click . All plates in the database 
that match the search criteria display the 
in plate record section.

Search categories

Note: Use the Plate Name for the Plate 
ID category.
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Linking a Plate

Select the plate record you want to run, then click the 
plate position indicator that corresponds to the plate 
you are linking.

The plate position indicator changes from yellow to 
green when linked and the green run button  is 
active.

Note: The 3100-Avant instrument has only one plate 
position to link a plate record.

Troubleshooting  

If a Plate Does Not Link

Observation/Problem Cause Corrective Action

Plate does not link. Spatial calibration was not performed. 1. Preform a spatial calibration.

2. Relink the plate(s) in the Run 
Scheduler.

The plates in the Run Scheduler 
were linked, but now are 
unlinked.

Used a wizard after linking a plate, but before 
starting a run.

Relink the plate(s) in the Run 
Scheduler.
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The plate links, but System 
Status changes from green to 
red.

A different length capillary array was installed, 
and the appropriate active spectral calibration 
was not selected or does not exists. 

1. View the error messages in the 
Event Log.

1. In the Spectral Calibration Viewer, 
active the spectral calibration for 
the dye set and array length you 
are using (see page 59).

2. If one does not exist, create a new 
spectral calibration for the dye set 
and array length you are using, 
then set as the active spectral 
calibration (see page 41).

3. Relink the plate(s) in the Run 
Scheduler.

The capillary array length and/or polymer type 
selected in the Instrument Protocol does not 
match capillary array length and/or polymer 
type stored in the database.

Correct the Instrument Protocol,
or 

1. Use the wizards to update the 
information in the database.

2. Set (see page 59) or create an 
active spectral calibration (see 
page 41).

3. Relink the plate.

The database and/or drive E is full 1. View the error messages in the 
Event Log.

2. Proceed to “Working With Drives 
for Database and Sample Data 
Storage” on page 234.

3. Make more space.

4. Relink the plate(s) in the Run 
Scheduler.

Troubleshooting  (continued)

If a Plate Does Not Link

Observation/Problem Cause Corrective Action
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Unlinking a Plate Record

1. Click the plate record that you want to unlink.

2. Click . 

22

1
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Run Scheduling

Sample Run
Order

The instrument injects samples using a system that schedules runs based on the 
following criteria:

1. The order the plates are linked (3100 instrument only), see page 155 for linking plate 
information.

2. The priority value for samples in the plate record.

If all priorities are set to 100 (default), runs are scheduled as outlined below. Refer to 
“Run Priority Scheduling” on page 262 for information on how a change in the priority 
values changes run scheduling.

Capillary Array
Map

Below is the layout of the capillary numbers in the capillary array. The capillary array 
layout is the same for both 96- and 384-well plates.

Capillary numbers:

96-Well Plate Mapping

3100 Instrument For a 96-well plate, injections are made from every well in two consecutive rows, 
starting with an odd row. A full 96-well plate requires six runs to inject all samples once.

Note: Multiple injections (Instrument Protocol 2 - Instrument Protocol 5) are run before 
moving to the next set of wells.

Run 1 Run 2 Run 3 Run 4
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3100-Avant
Instrument

For a 96-well plate, injections are made from four consecutive wells. A full 96-well plate 
requires 24 runs to inject all samples once.

384-Well Plate Mapping

3100 Instrument For a 384-well plate, injections are made from every other well and ever other row. A full 
384-well plate requires 24 runs to inject all the samples once.

.

Run 1 Run 2 Run 3 Run 4

Note: Multiple injections (Instrument Protocol 2 - Instrument Protocol 5) are run before 
moving to the next set of wells.

Run 1 Run 2 Run 3 Run 4

Note: Multiple injections (Instrument Protocol 2 to 5) from the same well are run before 
moving to the next set of wells.
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3100-Avant
Instrument

For a 384-well plate, injections are made from every other well. A full 384-well plate 
requires 96 runs to inject all the samples once.

Run 1 Run 2 Run 3

Run 4 Run 5 Run 6

Note: Multiple injections (Instrument Protocol 2 to 5) from the same well are run before 
moving to the next set of wells.
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Viewing the Run Schedule

After a plate is linked, use the Run View window to 
verify that runs are scheduled correctly. 

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 
ga3100-Avant >  instrument name >  Run 
Scheduler >  Run View.

2. Select a row for any run. The corresponding 
wells to be injected for that run are highlighted in 
the plate diagram. 
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Running the Instrument

Launching the Run

Starting the Run

1. Verify the active spectral calibration matches 
your dye set and capillary array length. 

To change the active spectral calibration, refer to 
“Activating a Spectral Calibration” on page 59.

To create a new spectral calibration, refer to 
“Creating a Spectral Instrument Protocol” on 
page 41.

2. If you want to review the run schedule before 
beginning the run, click 

 GA Instruments >  ga3100 or ga3100-
Avant >  instrument name >  Run 
Scheduler >  Run View.

3. Click the green button in the toolbar.

4. The Processing Plates dialog box opens, then 
click .

5. The software automatically performs a run 
validation:

• if the validation passes, the run starts

• if any of the validation test fails, the run 
does not start (use the troubleshooting table, 
“Run Validation” on page 165)
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Troubleshooting  

Run Validation

Below are the validation tests, all tests must pass before the run starts.

Test Checks Look For Corrective Action

The capillary array length and/or polymer 
type in the Instrument Protocol against 
the capillary array length and/or polymer 
type in the database

1. System Status changes from 
green to red.

2. View the error messages in 
the Event Log.

Correct the Instrument Protocol,
or 

1. Use the wizards to update the 
information in the database.

2. Set (see page 59) or create an active 
spectral calibration (see page 41).

3. Relink the plate, then click .

The available space in the database and 
drive E

1. Proceed to “Working With Drives for 
Database and Sample Data Storage” 
on page 234.

2. Make more space.

3. Click .

A different length capillary array was 
installed, and the appropriate active 
spectral calibration was not selected or 
does not exists. 

1. In the Spectral Calibration Viewer, 
active the spectral calibration for the 
dye set and array length you are using 
(see page 59).

2. If one does not exist, create a new 
spectral calibration for the dye set and 
array length you are using, then set as 
the active spectral calibration (see 
page 41).

3. Click .
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Starting the Autoanalysis Manager for 
SeqScape and/or GeneMapper Software

The Autoanalysis Manager (AAM) software is used 
with SeqScape and/or GeneMapper software to 
automatically analyze the data.

To start the Autoanalysis Manager:

1. Select Start > Programs > Applied Biosystems 
> Autoanalysis Manager > Autoanalysis 
Manager 2.0.

The Autoanalysis Manager window opens.

2. Quit the SeqScape and/or GeneMapper software.

No other interaction with the AAM software is 
needed until the completion of the runs. See 
“Using the Autoanalysis Manager Software” on 
page 180 for information on how to use the 
Autoanalysis Manager.

Note: The Data Collection Messaging Service must 
be running in order for analysis messages to be 
received by the Autoanalysis Manager.

Note: Autoanalysis Manager does not start 
automatically. Autoanalysis Manager must be 
open to receive messages from 3100/3100-Avant 
Data Collection for autoanalysis in SeqScape 
and/or GeneMapper software.
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Basic Run Module
Steps

When the run starts, the following basic steps are performed automatically by 
the instrument. To customize a run module, see “Tip: Customizing Run Modules” on 
page 82. 

Note: A PostBatch Utility, which runs automatically, turns off the oven and the laser at 
end of a batch of runs.

Run Times

DNA Sequencing
Run Times

The following table lists the approximate run times of common DNA sequencing 
analysis runs:

 Module Steps Approximate Time

Turn Oven On N/A

Wait for oven to equilibrate
Initialize autosampler
Fill syringes

1 min 40 sec

Fill Array 3-4 min

PreRun 3 min

Inject samples 30 sec

Start separation
Ramp voltage

10 min

Collect Data Variable

Run ends: 
Leave oven on
Laser to idle

Until next run starts

Total time prior to separation:

• Cold start: ~16.5 min

• 2nd run: ~6.5 min

Type of Run Run Module Run Time

Ultra rapid DNA sequencing UltraSeq36_POP4_1 45 min

Rapid DNA sequencing RapidSeq36_POP4_1 1 h

Standard DNA sequencing StdSeq50_POP4_1 1 h 20min

StdSeq50_POP6_1 2 h 30 min

Long read DNA sequencing LongSeq80_POP4_1 3 h 40 min
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Fragment
Analysis Run

Times

The following table lists the approximate run times of common fragment analysis runs:

Controlling the Run 

Controlling the
Run Using the

Toolbar

Use the toolbar at the top of the data collection software window to control the run.

Type of Analysis Run Module Run Time

Fragment analysis FragmentAnalysis22_POP4_1  20 min

Fragment analysis FragmentAnalysis36_POP4_1 45 min

Fragment analysis FragmentAnalysis50_POP4_1  65 min

Fragment analysis FragmentAnalysis50_POP6_1 95 min

Fragment analysis HIDFragmentAnalysis36_POP4_1 45 min

SNP analysis SNP22_POP4_1 16 min

SNP analysis SNP36_POP4_1 25 min

Click ... Description

Start Run

Starts the run

Stop

Stops the current run, and all other 
scheduled runs

Stop After Current Run

Completes the current run, then stops 
all other scheduled runs

Skip to Next Run

Stops the current run, then starts the 
other scheduled runs

Pause Run

Pauses the current runa 

a. Pausing the instrument for too long, especially after sample injection, will adversely 
affect data quality. The best time to pause is before sample injection.



Set Up for Continuous Operation
Starting the Autoanalysis Manager for SeqScape and/or GeneMapper Software

ABI PRISM 3100/3100-Avant Genetic Analyzers User Guide 169

Notes

6

Set Up for Continuous Operation

Running
Continuously

The continuous run feature allows you to create, import, and link a plate during a run. 
This feature gives you the capability of running one or more plates, removing the 
plate(s) once samples have run, then link and run additional plates.

• Plates can only be mounted or unmounted when the instrument is paused.

• Plate records can be created before or after a pause.

• New plates are linked after a run has resumed.

Adding or
Replacing a Plate

During a Run

During a run, you can mount and unmount plates while the instrument is paused. The 
plate record can be created, then linked after the run has been resumed.

If the plate is in use, see “Replacing a Plate Currently in Use” on page 171.

IMPORTANT! Pausing the instrument for too long, especially after sample injection, 
will affect data quality. The best time to pause is before sample injection.
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Replacing or Adding a Plate to a Run

Use this procedure to replace a completed plate or add 
a new plate to an unused plate bay (3100 instrument 
only).

1. Prepare your plate and create the plate record.

2. Click  (Pause).

In the Pause dialog box, read the pause warning, 
then click  to pause the run.

The following dialog box opens when the run is 
paused.

3. Do not click OK to resume the run. Temporarily 
ignore the dialog box.

4. Remove the old plate, if applicable.

a. Press the Tray button to bring the 
autosampler forward.

b. Open the instrument door.

c. Remove the old plate.

5. Mount the new plate.

6. Close the door.

The instrument resumes when the autosampler 
completes the initialization and returns to the 
home position.

If the 3100 instrument does not resume 
automatically, open and close the door again.

7. Search for the plate record, then link the new 
plate.

The new plate runs after the current plate 
completes all scheduled injections.
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Replacing a Plate Currently in Use

Use this procedure to replace a plate in use. To avoid 
potential problems, it is best to allow the plate to 
complete the scheduled runs.

1. Follow steps 1 to 3 in the procedure “Adding or 
Replacing a Plate During a Run” on page 169.

2. Remove the plate.

a. Press the Tray button to bring the 
autosampler forward.

b. Open the 3100 instrument door.

c. Remove the old plate.

3. Mount the new plate.

4. Close the door.

The instrument resumes when the autosampler 
completes the initialization and returns to the 
home position.

If the 3100 instrument does not resume 
automatically, open and close the door again.

5. In the Completed Run dialog box, click  to 
continue if the samples have been injected, or 
click  to abort the run and return the 
instrument to an idle state.

6. Search for the plate record, then link the new 
plate.

IMPORTANT! If you click OK, the instrument 
will continue running the current run regardless 
if the samples have actually been injected or not. 
If the samples have not been injected, the 
samples will be injected from the new plate.

Note: If you unmount the currently running 
plate prior to the first frame of data being 
collected but after sample injection (clicked OK 
to continue), the plate status changes to 
processed even though the run is actually 
continuing. 
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Viewing Data During a Run

Run Scheduler > Plate View

In the tree pane of the Data Collection Software, click  GA Instruments >  ga3100 
or 3100-Avant >  instrument name >  Run Scheduler >  Plate View.

Note: The  Run Scheduler and  Plate View windows display the same 
information.
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Run Scheduler > Run View

In the tree pane of the Data Collection Software, click  GA Instruments >  ga3100 
or 3100-Avant >  instrument name >  Run Scheduler >  Run View to monitor 
the status of the scheduled runs.

Note: For default load maps, see page 160.
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Instrument Status 

In the tree pane of the Data Collection Software, click  GA Instruments >  ga3100 
or 3100-Avant >  instrument name >  Instrument Status to monitor the status of 
the instrument or the current run.

System Status must be 
‘Ready’ before a run starts

Array and polymer informationOpen the Event Log to monitor 
system messages

System Status changes from green to flashing 
red when errors occur, see Event Log.
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Instrument
Condition Group

Box

The color of the box provides a quick way to check the status of the item to the right. See 
the table below for a definition of each color.

Events Box The Events box lists the:

• Instrument’s recent actions

• Status of each capillary as passed or failed at the end of a spectral calibration 

• Calibration data at the end of a spatial calibration

Some of the events listed in the Events box provide information for service engineers.

Errors Box The Errors box lists errors that have occurred during the current run. 

Some of the error messages provide information for service engineers. A “fatal” error 
usually requires that you restart the data collection software.

For... A green box 
indicates...

A red box
indicates...

A yellow box 
indicates...

Laser Laser is off Laser is on Laser is idle

EP Electrophoresis is off Electrophoresis is on —

Oven Oven is off Oven is on —

Front Doors Doors are closed Doors are open —

Oven Door Door is closed Door is open —

Autosampler Autosampler is homed Autosampler is forward —
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Instrument Status > EPT Chart

In the tree pane of the Data Collection Software, click  GA Instruments >  ga3100 
or 3100-Avant >  instrument name >  Instrument Status >  EPT Chart. The 
EPT chart displays real-time electrophoresis (EP) data during a run.
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Instrument Status > Event Log

In the tree pane of the Data Collection Software, click  GA Instruments >  ga3100 
or 3100-Avant >  instrument name >  Instrument Status >  Event Log. The 
Event log itemizes events such as errors and general information for all data collection 
steps.

Clear error messages by clicking Clear Errors. The System Status light flashes red until 
all errors are cleared. Take corrective action based on error message, then repeat the 
action that caused the error.

Note: This view can also be used to monitor spectral calibration results in real time to 
verify the capillary-by-capillary processing status.

Clear Errors changes the System status from red to green (ready state).
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Capillaries Viewer

In the tree pane of the Data Collection Software, click  GA Instruments >  ga3100 
or 3100-Avant >  instrument name >  Capillaries Viewer. Use the Capillary 
Viewer to examine the quality of the raw data during a run for several capillaries at once.

Check Boxes Select the check boxes of the capillaries for which you want electropherograms 
displayed. The capillaries are displayed in the order in which the boxes are checked. The 
more boxes that are selected, the slower the refresh window rate.

Raw Data An electropherogram is a graph of relative dye concentration against time, plotted for 
each dye. The raw data displayed has been corrected for spectral overlap 
(multicomponented). 

How to Zoom To zoom in and out:

1. Click , then place the pointer over the area of interest and click to expand the 
view.

2. Click  to return to full view.

Select check boxes 
of capillaries to 
display

Raw, 
multicomponented 
data

Click individual colors to view or hide them
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Cap/Array Viewer

In the tree pane of the Data Collection Software, click  GA Instruments >  ga3100 
or 3100-Avant >  instrument name >  Cap/Array Viewer. Use the window during a 
run to examine the quality of your data, which is displayed as color data for the entire 
capillary array. You can view all the capillaries (vertical axis) as a function of time/scan 
numbers (horizontal axis).

How to Zoom To zoom in and out:

1. Click , then place the pointer over the area of interest and click to expand the 
view.

2. Click  to return to full view.

Click individual colors to view or hide them

Electrophero-
gram 
displays 

Raw data 
display for 
selected 
capillary (4) 

Capillary
order

0 End

4

1

Scan number
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Using the Autoanalysis Manager Software

Overview The Autoanalysis Manager software is used with SeqScape and/or GeneMapper 
software. The Autoanalysis Manager software is installed by the SeqScape or 
GeneMapper software installation CD. 

Autoanalysis occurs in the following sequence:

• When data collection software finishes a run, the Message Service sends the 
message “Run Completed.”

• The Autoanalysis Manager receives the message, and the job is submitted. The job 
appears in the General tab. 

• The Autoanalysis Manager polls for jobs every 2 minutes and opens the automated 
processing version of SeqScape and/or GeneMapper software to analyze the data. 

• At the end of analysis, the status in the Autoanalysis Manager is updated.

Files Created The data collection software stores the sample files in the location specified in the results 
group. The Autoanalysis Manager copies the files into the DataStore for SeqScape or 
GeneMapper processing.

To maintain sufficient storage space on your hard drive, delete the sample files created 
by data collection software that are no longer needed.

Autoanalyzing
Samples

Once an internal message from the instrument is received by the Autoanalysis Manager, 
it opens the automated processing version of SeqScape and/or GeneMapper software to 
autoanalyze the samples. The standard user version of SeqScape and/or GeneMapper 
software must be closed in order for autoanalysis to begin. 

If SeqScape and/or GeneMapper software is open, a dialog box message displays asking 
if you want to close the software in order to process the new runs. Do one of the 
following:

The message dialog box has a timer so that if you leave the SeqScape and/or 
GeneMapper software open but are not using it, once time expires, any pending changes 
to the current project are saved, SeqScape and/or GeneMapper software closes, and 
Autoanalysis Manager takes over.

If You Select... Then...

Yes Any pending changes to the current project are saved, GeneMapper 
software closes and the AutoAnalysis Manager takes over.

No The runs continue to collect and queue in the AutoAnalysis Manager 
until GeneMapper software is closed.
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Components

The Autoanalysis Manager has two or three tabs:

• General tab

• GeneMapper tab, if GeneMapper v3.5 or GeneMapper ID v3.1software is installed

• SeqScape tab, if SeqScape software is installed

General Tab The General tab shows the jobs that have been submitted and their status.

Command Buttons in the General Tab

The table below describes the functions of the command buttons in the General tab

Button Name Function

Delete Job Deletes an individual job/project from the Autoanalysis Manager 
list. 

Does not delete sample files, SeqScape or GeneMapper 
software project.

Delete Completed Jobs Deletes all completed jobs/projects from the Autoanalysis 
Manager list. Only successful jobs are deleted. 

Does not delete sample files, SeqScape or GeneMapper 
software projects.

Move Job Up The active job/project is always given a queue number of 1. Once 
job 1 is finished analyzing, job 2 becomes job 1 and all other 
numbers are changed accordingly. Use the Move Up/Down 
buttons if you want to rearrange the analysis order. 

Move Job Down
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GeneMapper Tab The GeneMapper tab shows the jobs that have been submitted and their status.

Command Buttons in the GeneMapper Tab

The table below describes the functions of the command buttons in the GeneMapper tab.

Button Name Function

Configure Schedule • Next Analysis Time:

Enables you to set a start time for autoanalysis. Before this 
time arrives, no autoanalysis of projects will occur. 

• Periods restricting automated analysis:

Enables you to set times during which autoanalysis will not 
occur. Useful if you know that you are going to be reviewing 
data during a certain time period and don’t want to be 
bothered by the “Runs ready for processing” dialog box. Runs 
build up in the queue until the restricting time period is over, 
then runs will be autoanalyzed. 

• Automatic Deletion of Completed Jobs:

Enables you to set the software to automatically delete 
successfully completed jobs. Jobs that failed or have not been 
analyzed will not be deleted. Only the Autoanalysis Manager 
job is deleted, sample files and GeneMapper software projects 
are not.

Edit Properties Enables you to change the following settings:

• Job/Project Name

• UserName: GeneMapper software UserName

• Password: Matching password for GeneMapper software 
UserName

• Queue position: Enter a new queue position number for the 
project 
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SeqScape 2.1 Tab The SeqScape 2.1 tab shows the jobs, project, and status information.

The table below describes the functions of the command buttons in the SeqScape 2.1 tab:

Requeue Job • Samples that need to be autoanalyzed have queue numbers 
listed in the # column.

• Samples that are already analyzed or failed, have a blank cell 
in the # column. 

To resubmit a job for autoanalysis, use the Requeue Job 
button to assign a queue number to that job.

Delete Job • Deletes an individual job/project from the AutoAnalysis 
Manager list. 

Does not delete sample files or GeneMapper software project.

Delete Completed Jobs • Deletes all completed jobs/projects from the AutoAnalysis 
Manager list. Only successful jobs are deleted. 

Does not delete sample files or GeneMapper software 
projects.

Button Name Function

Button Name Function

Details Displays the project in the navigation pane

Resubmit Submits a job for analysis

Edit Properties Edits the name and password (active only if analysis failed)

Delete Deletes a job from the Autoanalysis Manager
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Working with Data in The Run History View

Run History Components

Elements of the
Run History Utility

The Run History utility can be used only with completed runs stored in the local 
3100/3100-Avant Data Collection database. It does not provide real-time viewing of 
collecting runs.

In the left tree pane, click the icon next to the function to launch it.

Viewing Data from a Completed Run in the Data Collection Software

Overview There are two formats for viewing data within the 3100/3100-Avant Data Collection 
Software under the Run History icon: 

• In the Cap/Array Viewer window (in much the same way that you might view the 
gel file output from an ABI PRISM® slab gel instrument).

• In the Capillary Viewer window, capillary-by-capillary.

Elements Within the Run History Utility Icon

EPT Chart

Note: If Cleanup Database has been used, you cannot view 
processed data in Run History. 

Spatial Calibration Viewer 

Capillaries Viewer

Note: If Cleanup Database has been used, you cannot view 
processed data in Run History. 

Cap/Array Viewer

Note: If Cleanup Database has been used, you cannot view 
processed data in Run History. 

Spectral Viewer

Reextraction 

Note: If Cleanup Database has been used, you cannot view 
processed data in Run History. 
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Viewing Data from a Completed Run

1. In the tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 3100-
Avant >  Run History to select the run you 
want to view.

2. Search for your run by either Barcode or 
Advanced search. 

3. After choosing the run, click the Cap/Array 
Viewer or the Capillary Viewer from the left tree 
pane. 
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Viewing the Results of Autoextraction

Overview After a run is completed, extraction and analysis is performed automatically, according 
to the settings in the Plate Editor and the Results Group. The results of extraction and 
analysis can be viewed in the Reextraction Panel. Samples can be extracted again with 
the same settings, or with different Analysis Protocols or different Results Groups. This 
can be useful for many reasons:

• The destination location may not have been available during extraction.

• Some samples may have failed analysis and a different Analysis Protocol might be 
more successful.

• Samples might be saved in different locations, or with no analysis at all to 
save space.

Sample File
Destinations

Locations where sample files are placed during extraction:

• Default Destination, and default folder naming:    Data / instrument type / 
instrument name / run folder 

• Default Destination, custom folder naming:   Data/top custom 
folder/subfolders, etc.

• Custom Destination, default folder naming:   Destination/instrument 
type/instrument name/run folder

• Custom Destination, custom folder naming:   Destination/top custom 
folder/subfolders, etc.

Runs Stopped
Before Complete

Autoextraction

Runs that are stopped before completion display the status “Completed” in the Run 
Scheduler. In the Instrument Status the status is changed to “Ready.” Successfully 
extracted and analyzed runs display the status processed in the same Run View page. 

The auto extractor component of the 3100/3100-Avant Data Collection automatically 
extracts data from stopped runs. If autoextraction fails, click the Reextraction icon 

 to extract data.

Effects of
Changes Made in
the Reextraction

Panel

Changes made in the Reextraction Panel to a Results Group, Analysis protocol, 
Comments, etc., also change in the original plate record. The original plate information 
is overwritten.

Selecting and
Queuing Samples

for Extraction

You can queue individual samples for reextraction. This is especially useful for 
experimenting with different Analysis Protocols for samples that have failed 
initial extraction.

1. Click  (Run History).

2. Enter the plate name for a plate that has been completed, or click Search. Plates that 
have runs still pending cannot be reextracted. All the runs from that plate appear in 
the window. 
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3. Select a run from the list. 

4. Click  (Reextraction) in the left tree pane.

The Reextraction window displays

5. Click the check boxes in the Extract column to select the samples to be reextracted.

6. Click Extract to start the reextraction. 

Note: Reextracted sample files are saved in the original folder that data was 
extracted to.
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Elements of the Reextraction Window

All the samples are displayed with the results of extraction and analysis.

Reextraction
Window for
Sequencing

Analysis

Note: Sort the columns of the re-extraction panel by holding the shift key and then 
clicking on a column header.

Use check boxes to 
select samples to 
be reextracted Select a run Results of extraction and analysis

Click here to start extraction

These are used if several 
samples are highlighted
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Reextraction
Window for

Fragment
Analysis

Use check boxes to 
select samples to 
be reextracted Select a run Results of extraction 

Click here to start extraction

These are used if several 
samples are highlighted
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Results Column The results of extraction and analysis are color coded in the Results column. The 
following table lists the colors and their values for Sequencing Analysis.

The Results column, by default, shows only the beginning of any processing message. 
The entire message returned from extraction and autoanalysis is inside the cell and can 
be viewed by expanding the cell. The location of the stored sample is also found there. In 
addition, there is a tooltip view for each sample results message.

Drag the cell’s edge to expand the column

Color Value Notes

Red Extraction or analysis failed Descriptive messages can be viewed by 
resizing the Results column to view all text 
(click on the arrow)Yellow * Warnings for extraction or analysis

Green Successful extraction (with no analysis intended), or 
successful extraction and analysis.

* Note: The text message for samples that produce yellow is: “FAILURE: Analysis Failed

                                                                                                  Bad Data; Error Number=nnnnn

                                                                                                  WARNING...

Tooltip view. Access by placing the cursor over the sample of interest
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Expanded column

Quality Column The Quality column represents the quality values for an entire sequence. Quality Values 
are only assigned to analyzed samples when using the KB Basecaller. The following 
table lists the displayed colors and their associated value range.

The column is empty (white) if:

• Analysis was not performed

• Analysis failed

• ABI Basecaller was used for analysis. This basecaller does not assign 
Quality Values.

Results Group
and Analysis

Protocol Columns

The Results Group and the Analysis Protocol (Analysis Method in the GeneMapper™ 

software) can be edited and the changes used for reextraction.

Note: Select an entire column in the Reextraction window by clicking on the column 
header. For example, clicking on the Extract column header selects all samples. Clicking 
the Uncheck or Check buttons at the bottom of the window, enables or disables the check 
boxes for each sample. Additionally, the fill-down command (Ctrl+D) works the same 
here as in the Plate Editor for easier information input.

Color Quality Value Range

Red < 15

Orange ≥ 15 and < 20

Yellow ≥ 20 and < 30

Green > 30

Note: For more information on KB Basecaller and Quality Values, see the Applied 
Biosystems DNA Sequencing Analysis Software v5.1 User Guide, PN 4346366.
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Sorting The
Samples

The samples can be sorted according to any of the column properties by holding down 
the shift key while clicking on the column header. Shift-clicking again sorts them in the 
reverse order. This is most useful for sorting by capillary number, by well position, by 
results, by quality, and by the Extract column. For example, it is often useful to bring all 
of the samples that failed analysis or extraction to the top of the column where they can 
be examined without having to scroll down to each sample individually.

Reextracting
Selected Samples

To reextract selected samples:

1. Expand the Results column cells for any yellow or red results, to see a description 
of the warning or failure.

2. If desired, select a new Results Group, or edit the current one. This allows you to 
turn off autoanalysis, change the samples and folder naming options, the location 
where they are placed, the owner of the Results Group, etc. 

3. If desired, change the Analysis Protocol to experiment with different ways of 
analyzing the sample, using a different basecaller for example.

4. Check the check box in the Extract column for the samples you wish to 
extract again.

5. Click Extract.

IMPORTANT! Reextraction creates an entirely new sample file and does not replace 
the previously saved sample file. The presence of a previous sample file has no 
effect on the creation of a new sample file. If the same naming options that are used 
for reextraction are identical to those used previously, a number is appended to the 
filename. For example, if the first sample is, “sample 01.ab1” then the second 
sample would be, “sample 01 (1).ab1.”
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Viewing Analyzed Data

Locating Sample
Files

When a run is finished, the analyzed sample files are extracted into a run folder, to a 
location defined in the Destination tab and the name of your run folder defined in the 
Name tab of your Results Group.

The default location is: 

E:\AppliedBiosystems\UDC\Data Collection\Data\ destination location+run folder 
name

Locating Sample Files

If the data has been re-extracted, the data is in the location defined by the applied Results 
Group or the default destination location:

Viewing Sample
Files

After a run has been extracted to sample files, you can use the Sequencing Analysis 
Software v5.1, SeqScape, or the GeneMapper Software to view the electropherogram 
data, both raw and analyzed. All sequencing sample files contain the .ab1 extension, and 
all fragment analysis sample files contain the .fsa extension.

IMPORTANT! If the run is not set up for autoanalysis, refer to the Applied Biosystems 
DNA Sequencing Analysis Software v5.1 User Guide, SeqScape® Software v2.1 User 
Guide, or GeneMapper™ Software v3.5 User Guide for information on manual analysis.
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Instrument Maintenance

Maintenance Task
Lists

This section lists common tasks required to maintain your ABI PRISM® 3100/3100-Avant 
Genetic Analyzer in good working condition. The tasks are divided into tables based on 
how often you should perform each task.

IMPORTANT! Wear gloves any time you handle the capillary array, glass syringes, septa, 
or buffer reservoirs.

Daily Tasks Perform these tasks at least once per day.

Maintenance Task Frequency See Page

Ensure that the reservoir septa are firmly seated and flat. Before each run —

Ensure that the plate assembly were put together properly. 

The holes in the plate retainer must align with the holes in 
the septa or the capillary tips will be damaged.

Before each run 152

Ensure that the plate assembly is positioned on the plate 
deck properly. Plate should sit snugly on the deck. 

Never use warped plates.

Before each run —

Replenish the water and 1X running buffer reservoirs on 
the instrument.

Daily or before 
each run

15

Check for bubbles in the polymer block and polymer block 
channels and remove.

Daily or before 
each run

228

Check the loading-end header to ensure the capillary tips 
are not crushed or damaged.

Daily or before 
each run

—

Check the level of polymer in the polymer-reserve syringe 
to ensure there is enough for all your runs.

Daily or before 
each run

—

Check the polymer block to ensure it fits securely on the 
instrument.

Daily —

Clean the instrument surfaces. Daily —

Check for dried polymer around the polymer block and 
clean as necessary.

Daily —

Check for leaks around the syringes and screw nut. Daily —
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Weekly Tasks Perform these tasks at least once per week.

As-Needed Tasks Perform these tasks as needed.

Maintenance Task Frequency See Page

Clean the syringes. Weekly or as 
needed

216

Clean the water and buffer reservoirs with warm water. Weekly —

Clean the upper and lower polymer blocks. Weekly 224

Replace the polymer in the syringes, upper polymer block, 
and capillary array.

Weekly or as 
needed

207

Check the storage conditions of the used arrays. Weekly —

Check data base space. Delete plate records from the 
instrument database and archive sample files.

Weekly 234

Maintenance Task Frequency See Page

Clean the drip trays. As needed —

Change the array. As needed 209

Replace syringes 3 months —

Remove any dried polymer from the capillary tips. Use a 
lint-free wipe moistened with deionized water.

As needed —

Calibrate the autosampler Very rarely 231
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Routine Cleaning

General Cleaning 

1. Ensure the oven and instrument doors are closed.

2. Press the Tray button on the front of the 
instrument to move the autosampler to the 
forward position.

3. Wipe off any liquid on or around the autosampler 
using a lint-free tissue.

4. Clean off any polymer build-up (crystals) on the 
instrument including the capillary tips and the 
stripper plate with deionized water and lint-free 
tissue.

5. Clean out the drip trays with deionized water and 
lint-free tissue.

Moving and Leveling the Instrument
 Before Moving the Instrument

1. Remove the following components from the 
instrument:

• Any plate assemblies from the autosampler.

• Water and buffer reservoirs from the 
autosampler.

• Capillary array. For instruction see 
page 211.

• Syringes from the upper polymer block. For 
instruction see page 222.

• Upper polymer block. For instruction see 
page 223.

Tray button

IMPORTANT! Never use organic solvents to 
clean the instrument.

5

4

3

PHYSICAL INJURY HAZARD. 
Do not attempt to lift the instrument or any other heavy 
objects unless you have received related training. 
Incorrect lifting can cause painful and sometimes 
permanent back injury. Use proper lifting techniques 
when lifting or moving the instrument. Two or three 
people are required to lift the instrument, depending upon 
instrument weight.
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• Anode buffer reservoir.

• Lower polymer block. For instruction see 
page 223.

2. Switch off the breaker on the back of the 
instrument. 

3. Disconnect the power cord and the Ethernet 
cable.

Leveling the Instrument

1. Place the bubble level on the autosampler deck.

2. Turn the instrument legs to level the instrument.

IMPORTANT! While moving the instrument, 
avoid any shock or vibration.

To move the 
instrument corner ... Turn the leg ...

up right (clockwise)

down left (counterclockwise)
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Resetting the Instrument 

Reset the instrument when:

• There is a fatal error as indicated by the red 
status light

• The instrument does not respond to the 
ABI PRISM® 3100/3100-Avant Data Collection 
software

There are two ways to reset the 3100/3100-Avant 
Genetic Analyzer: 

• Press the Reset button on the front of the 
instrument to dump and reload the firmware and 
to reset the electronics. Try this method first.

• Shut down and restart the computer and the 
instrument. 

Resetting With the Reset Button

1. Close the instrument doors.

2. Using a long narrow implement, such as a 
straightened paper clip, press the Reset button on 
the front of the instrument.

Resetting by Powering Down

1. Close the instrument doors.

2. Power off the instrument by pressing the on/off 
button on the front of the instrument.

3. Restart the computer.

a. Select Start > Shutdown.

b. In the Shutdown Windows dialog box, select 
Restart, then click OK.

Reset button

On/off button

IMPORTANT! Wait until the computer has 
completely restarted before proceeding.
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4. Turn on the instrument, then wait for the solid 
green light.

5. Launch the data collection software (all 
applications in the Service Console start 
automatically).

Shutting Down the Instrument

Short- and Long-Term Shutdowns

Perform the appropriate shutdown procedure based on 
the information in the following table:

Performing a Short-Term Shutdown

1. Ensure the oven and instrument doors are closed.

2. Fill the capillaries with fresh polymer. For 
instructions, see page 214.

3. Push the Tray button to move the autosampler 
forward.

4. Open the doors, then remove the plates and 
reservoirs

5. Remove the cathode buffer reservoir and water 
reservoirs from the instrument.

Note: When the instrument is shut down, the 
firmware is not saved. Upon restart, the 
instrument reloads a copy of the firmware and 
the calibration file from the computer.

If the instrument will be 
unattended for ... Perform this shutdown procedure ...

no more than 1 week with a full 
buffer reservoir

Short-term

IMPORTANT! The key to a successful 
short-term shutdown is keeping the capillary 
array in 1X running buffer. This prevents the 
polymer from drying in the capillaries.

for more than 1 week Long-term
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6. Dispose of remaining fluids and rinse out the 
reservoirs with deionized water.

7. Rinse the cathode reservoir with 1X running 
buffer, and then fill to the line with 1X running 
buffer (about 16 mL).

8. Fill the three water reservoirs to the line with 
quality deionized water (about 16 mL). 

 9. Place a clean reservoir septa on each reservoir, 
and dry the outside of the reservoirs using a 
lint-free wipe.

10. Place the reservoirs into position on the 
autosampler as shown below.

11. Close the instrument doors.

12. Shut down the computer and turn off the 
instrument.

Note: The waste is very dilute; however, you 
should follow your company’s waste disposal 
practices for appropriate disposal procedures. 

G
R

18
57

b

Fill line

Be sure that the septa fit snugly and 
flush on the tops of the reservoirs in order to prevent 
damaging the capillary tips.

Septa is lying flat 
on the reservoir 

Fill line

Water reservoir
(rinse)

Cathode reservoir
(1X running buffer)

Water reservoir
(waste)

Water reservoir 
(spare)

Home position

Note: Closing the doors returns the autosampler 
to the home position, placing the tips of the 
capillaries in buffer.
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Performing a Long-Term Shutdown

1. Follow the procedure on page 215 to remove and 
store the capillary array off the instrument.

2. Remove from the instrument:

• Syringes from the upper polymer block. For 
instructions see page 222.

• Upper polymer block. For instructions see 
page 223.

• Lower polymer block. For instructions see 
page 223.

3. Remove the plate assembly and reservoirs from 
the autosampler:

4. Wipe the autosampler and drip trays with lint-
free tissue dampened with water.

5. Close the instrument doors.

6. Shut down the computer and power off the 
instrument.

7. Wash the syringes, polymer blocks, and 
reservoirs with warm water. Rinse with 
deionized water.

4

3

IMPORTANT! Make sure all parts are completely 
dry before long-term storage.



Chapter 7 Performing Instrument Maintenance
Fluids and Waste

206 ABI PRISM 3100/3100-Avant Genetic Analyzers User Guide

Notes

Fluids and Waste

Buffer

When to Change the Buffer

We recommend that you change the buffer before 
each batch of runs or at least every 24 hours.

Making Buffer for a Single Run

To prepare 50 mL of 1X running buffer:

1. Add 5 mL of 10X Genetic Analyzer buffer into a 
graduated cylinder.

2. Add deionized water to bring the total volume up 
to 50 mL.

3. Mix well.

Storing the Buffer

The 1X running buffer can be stored at: 

• 2 to 8 °C for up to 1 month

• Room temperature for 1 week

CHEMICAL HAZARD. 10X 
Genetic Analyzer Buffer with EDTA may cause eye, 
skin, and respiratory tract irritation. Read the MSDS, and 
follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

50 mL 
total 45 mL DI H2O

5 mL 10X Genetic 
Analyzer buffer

50 mL graduated cylinder

Buffer Storage Conditions

Option A Option B

Su M T W Th F S

2 °C to 
8 °C

1 month

20 °C to 
25 °C

7 days

Su M T W Th F S
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Polymer

Storing Polymer

Store any remaining POP™ polymer at 2 to 8 °C until 
the expiration date printed on the jar. 

When to Change the Polymer

We recommend that you change the polymer weekly. 
The polymer is good at 25 °C for about 7 days.

Adding and Changing the Polymer

To put fresh polymer on the instrument:

1. Click Wizards > Change Polymer Wizard.

Note: Excessively hot environments may shorten the 
working life of the polymer.

POP-4 or POP-6 Storage Conditions

Su M T W Th F S

20 °C to 25 °C 7 days

CHEMICAL HAZARD. POP 
Polymers causes eye, skin, and respiratory tract 
irritation. Read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

IMPORTANT! Wear gloves when you 
handle the polymer.
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2. If plates are linked in the Run Scheduler, the 
plates automatically are unlinked. In the Warning 
dialog box, click .

3. Follow the directions given in the wizard to put 
fresh polymer on the instrument.

4. Relink plate(s), if applicable.
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Capillary Array

Before Installing a Previously Used Capillary Array

Before you reinstall a capillary array, it is 
recommended that you:

• Clean the front of the detection cell

• Check that the cathode bar is dry

Cleaning the Detection Cell

This procedure is unnecessary for new arrays unless 
you have accidently touched the detection cell.

1. Put one drop of methanol on the front surface of 
the detection cell. 

2. Use short, gentle bursts of clean pressurized air 
to dry the cell. 

CHEMICAL HAZARD. Methanol 
is a flammable liquid and vapor. Exposure may cause 
eye, skin, and respiratory tract irritation, and central 
nervous system depression and blindness. Please read the 
MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves

Front surface of 
detection cell

GR2144

3100 capillary array

3100-Avant capillary array
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Checking the Cathode Bar

When putting a used array back on the instrument, be 
sure that the cathode bar is dry (see page 210). A wet 
bar could lead to arcing.

Installing and Removing the Capillary Array

When to Change a Capillary Array

A capillary array should last approximately 100 runs. 

The following problems may indicate that a new 
capillary array is required: 

• Poor sizing precision or allele calling

• Poor resolution and/or decreased signal intensity

ELECTRICAL SHOCK/FIRE 
HAZARD. Do not leave liquid in the cathode bar. 
This can lead to electric shock or even fire if not 
properly maintained.

Ensure the cathode bar is dry – especially in the center

G
R

21
46

3100 capillary array 3100-Avant capillary array
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Installing, Removing, or Replacing a 
Capillary Array

Follow the procedures in the Install Capillary Wizard 
to install, remove, or replace an array.

1. Close the oven and instrument doors, then press 
the Tray button.

2. Select Wizards > Install Capillary Wizard.

3. If plates are linked in the Run Scheduler, the 
plates automatically are unlinked. In the Warning 
dialog box, click .

4. Open instrument and oven doors.

5. Follow the directions given in the wizard to 
install or replace an array.

6. Click  when done.

7. Close and lock the oven door, then close the 
instrument doors.

8. Relink plate(s), if applicable.

IMPORTANT! Wear gloves when you 
handle the polymer blocks.

CHEMICAL HAZARD. POP 
polymer causes eye, skin, and respiratory tract irritation. 
Read the MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, and 
gloves.

IMPORTANT! The capillary array length defined in 
the wizard must match the array length you are using. 

IMPORTANT! If you installed or replaced an 
array that is a different length than the one you 
were using, you must reset the active spectral 
calibration (see Chapter 3, page 59) or create a 
new spectral calibration for the dye set and array 
length combination (see Chapter 3, page 37). 
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Manually Installing a Capillary Array 

You can manually install a capillary array, then use the 
Update Cap Array Info wizard to enter the capillary 
array length and serial number into the database.

1. Close the oven and instrument doors, then press 
the Tray button.

2. Open the instrument door and oven doors.

3. Install the capillary array.

4. Close and lock the oven door, then close the 
instrument doors.

5. Select Wizards > Update Cap Array Info.

6. If plates are linked in the Run Scheduler, the 
plates automatically are unlinked. In the Warning 
dialog box, click .

7. Complete the dialog box using your capillary 
array information, then click .

8. Relink plate(s), if applicable.

CHEMICAL HAZARD. POP 
polymer may cause eye, skin, and respiratory tract 
irritation. Please read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves. Use for research and development 
purposes only.

IMPORTANT! The capillary array length defined in 
the wizard must match the array length you are using.

IMPORTANT! If you installed or replaced an 
array that is a different length than the one you 
were using, you must reset the active spectral 
calibration (see Chapter 3, page 59) or create a 
new spectral calibration for the dye set and array 
length combination (see Chapter 3, page 33). 
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Capillary Array Maintenance

Caring for the Capillary Array

Follow these guidelines to properly care for the 
capillary array:

• Wear gloves and handle the capillary array 
gently.

• Do not touch the detection cell. If it is dirty, see 
“Cleaning the Detection Cell” on page 209.

• Keep the ends of the capillary array wet at all 
times.

• Always loosen the capillary array nut before 
pulling out the upper polymer block.

• Do not overtighten the capillary array nut.

Cleaning the Capillary Array

1. Flush the capillary array with fresh polymer as 
instructed in the “Installing and Removing the 
Capillary Array” on page 210.

2. Clean off any polymer buildup (crystals) on the 
instrument, including the capillary electrodes 
and the stripper plate, with deionized water and 
lint-free tissue.  

3. Clean the detection cell as instructed on 
page 209.

CHEMICAL HAZARD. POP 
polymer causes eye, skin, and respiratory tract irritation. 
Read the MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, and 
gloves.

2

Note: When cleaning the capillary electrodes, be 
careful not to bend them out of position. If the 
electrodes do get bent, follow the procedure 
“Verifying Capillary Alignment Using the 
Capillary Ruler” below.

IMPORTANT! Never use organic solvents to 
clean the instrument.
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Filling the Capillary Array with Polymer 
Using the Fill Capillary Wizard

1. Select Wizard > Fill Capillary Wizard.

The wizard opens.

2. If plates are linked in the Run Scheduler, the 
plates automatically are unlinked. In the Warning 
dialog box, click .

3. Follow the directions in the wizard, then click 
.

Verifying Capillary Alignment Using the 
Capillary Ruler 

1. Place the ruler beside the capillaries and detach a 
side of the ruler to the bottom of the holder.

2. Verify that all the capillaries match the lines of 
the ruler.

3. Place the capillary array holder on the flat 
surface and stand the ruler up at the end of 
capillaries.

4. Verify that the cross points of line on the ruler to 
match the end of capillaries. If some of 
capillaries are bent, adjust each capillary 
carefully.



Capillary Array
Verifying Capillary Alignment Using the Capillary Ruler

ABI PRISM 3100/3100-Avant Genetic Analyzers User Guide 215

Notes

7

Storing a Capillary Array on the Instrument

When to Use Store the capillary array on the instrument only when the capillary array will be unused 
for less than 1 week.

Storing the
Capillary Array on

the Instrument

To store the capillary array on the instrument, follow the instructions to perform a short-
term shutdown on page 203. 

Storing a Capillary Array off the Instrument

When to Use Store the capillary array off of the instrument when the capillary array will be 
unused for longer than 1 week.

Storing the
Capillary Array off

the Instrument

1. Fill the capillary array with fresh polymer using the Fill Capillary Array wizard or 
manual control commands.

2. Remove the syringe guard.

3. Remove both syringes from the upper polymer block and properly dispose of any 
remaining polymer.

4. Wash the syringes.

5. Remove the capillary array from the instrument using the Install/Replace Capillary 
Array wizard. For instructions see, “Installing and Removing the Capillary Array” 
on page 210. 

6. Replace the cover over the detection cell.

7. Fill a buffer reservoir with fresh 1X running buffer and cover with a septa strip. 
Insert the capillary tips into the buffer.

IMPORTANT! Before storing the capillary array for long periods, we recommend filling 
the capillaries with fresh polymer.

IMPORTANT! Wear gloves while performing the following procedure, and any other 
time you handle the capillary array, glass syringes, septa, or buffer reservoirs.

CHEMICAL HAZARD. POP polymer causes eye, skin, and 
respiratory tract irritation. Read the MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.
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8. Fill the shipping vial with fresh 1X running buffer and insert the detection end of 
the capillary array. 

9. Store the capillary array upright. 

10. Check the 1X running buffer level in the reservoir and tube weekly.

Syringes

Required
Materials

• Polymer-reserve syringe, 5-mL

• Array-fill syringe, 250-µL

• Syringe, 20-mL, silicone-free 

• Squeeze bottle, 1-L containing deionized water 

• POP-4 or POP-6 polymer 

• Lab wipes, lint-free

• Gloves

When to Clean
the Syringe

Clean the syringe:

• When a syringe is removed from the instrument, or at least once per week

• When replacing polymer, including when switching to a new type or lot of polymer

Guidelines for
Syringe Use

• Do not move the plunger when the barrel is dry. 

• Do not combine the barrels and plungers from different syringes.

• Do not draw or expel a full volume of fluid from the syringe faster than 5 sec.

Syringe Maintenance

Syringe Types The following table lists the name, volume, and function of the two syringes:

Replacing the
Syringes

To maintain optimal performance, we recommend that you replace syringes about every 
3 months.

Name Volume Function

Array-fill syringe 250 μL High-pressure syringe that displaces polymer into 
the capillary array

Polymer-reserve syringe 5 mL Stores polymer for multiple sequential runs
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Cleaning Syringes 

1. Remove the syringe guard.

2. Remove the syringes as described on page 222.

3. Clean the syringe thoroughly by rinsing the 
inside and outside of the syringe barrel and the 
syringe tip with warm water.

4. Inspect the components of the syringe for dried 
polymer (white residue). 

If the syringe contains dried polymer, repeat 
step 3.

5. Rinse the syringe barrel and tip with deionized 
water.

IMPORTANT! Be sure there is no 
dried polymer left in the syringes.

Dried 
polymer

Dried 
polymer

Dried 
polymer
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6. Assemble the syringe.

7. Confirm that two O-rings (one behind the ferrule 
and one around the ferrule) are attached 
correctly.

8. Confirm that the ferrule is firmly attached to the 
end of the syringe.

9. Use a lint-free wipe to dry the syringe.

Priming and Filling Syringes

DI H2O ≤ 70 °C

Aligned with barrel

Yes

No

IMPORTANT! Add a drop of deionized water to 
the tip of the plunger before inserting the 
plunger.

IMPORTANT! Align the tip of the plunger with 
the barrel of the syringe before inserting the 
plunger.

O-rings

Ferrule

Syringe

CHEMICAL HAZARD. POP 
polymer causes eye, skin, and respiratory tract irritation. 
Read the MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, and 
gloves.

IMPORTANT! Wear gloves when you 
handle the glass syringe.

≥ 5 sec
0.1 0.2 0.3 0.4 0.5-mL

≥ 5 secIMPORTANT! Do not draw or expel a full volume of 
fluid from the syringe faster than 5 sec.
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Priming and Filling the Polymer-Reserve 
Syringe 

1. Draw approximately 0.5 mL of room-
temperature polymer into a clean polymer-
reserve syringe 

2. Draw the plunger to the 5 mL mark to draw a 
volume of air into the syringe.

3. Invert the syringe six times to coat the walls with 
polymer. 

4. Slowly expel the polymer into an aqueous waste 
container.

5. Draw 5 mL of room-temperature polymer into 
the syringe. 

POP-4 or POP-6 
polymer 

6x

Aqueous 
Waste

Note: The syringe is now primed for use on the 
instrument. Priming ensures that residual water 
from the wash does not dilute the concentration 
of the polymer.

POP-4 or POP-6 
polymer 

IMPORTANT! Submerge the syringe tip in the 
polymer while filling to avoid creating air 
bubbles in the syringe.
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6. Invert the syringe and slowly expel a small 
amount of polymer out of the tip to remove any 
air bubbles.

Priming and Filling the Array-Fill Syringe

1. Draw approximately 100 µL of room-
temperature polymer into a clean array-fill 
syringe. 

2. Draw the plunger to the 250 µL mark to draw a 
volume of air into the syringe.

3. Invert the syringe six times to coat the walls with 
polymer. 

4. Slowly expel the polymer into an aqueous waste 
container.

5. Draw 250 µL of room-temperature polymer into 
the syringe. 

Expel a small amount of 
polymer

Air bubbles are expelled 
with polymer

Note: Do not return the unused portion of the 
polymer to the polymer jar.

6x

Aqueous 
Waste

Note: The syringe is now primed for use on the 
instrument. Priming ensures that residual water 
from the wash does not dilute the concentration 
of the polymer.

POP-4 or POP-6 
polymer 

IMPORTANT! Submerge the syringe tip in the 
polymer while filling to avoid creating air 
bubbles in the syringe.
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6. Invert the syringe and slowly expel a small 
amount of polymer out of the tip to remove any 
air bubbles.

Installing and Removing Syringes

Installing Syringes

1. Follow the procedures to remove, clean, dry, and 
replace the upper polymer block starting on 
page 223. 

2. Place the polymer-reserve syringe tip in the left 
port on the top of the upper polymer block and 
screw the syringe tip clockwise into the polymer 
block. 

3. The syringe should be finger tight in the block.

4. Place the array-fill syringe tip in the right port on 
the top of the upper polymer block and screw the 
syringe tip clockwise into the polymer block. 

5. The syringe should be finger tight in the block.

6. Replace the syringe guard.

Expel a small amount of 
polymer

Air bubbles are expelled 
with polymer

Note: Do not return the unused portion of the 
polymer to the polymer jar.

Install the 
polymer-
reserve syringe

IMPORTANT! Always hold the syringe by the 
metal sleeve – not the glass – when screwing the 
syringe into the block.

Install the 
array-fill 
syringe

IMPORTANT! Always hold the syringe by the 
metal sleeve—not the glass—when screwing the 
syringe into the block.

Syringe guard
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Removing Syringes

1. Remove the syringe guard.

2. Grasp the polymer-reserve syringe just above the 
fitting or at the base (not the glass barrel) and 
rotate the syringe counterclockwise.

3. Grasp the array-fill syringe and rotate the syringe 
counterclockwise.

4. Dispose of any remaining polymer properly.

Do not loosen this fitting while 
removing the syringe.

IMPORTANT! Be careful not to remove the 
fitting. There are several rings and check valves 
that could come out if this fitting is removed.
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Polymer Blocks

Removing the Polymer Blocks

Removing the Upper Polymer Block

1. Verify the oven and instrument doors are closed, 
then press the Tray button.

2. Remove the syringe guard.

3. Remove the syringes as described on page 221.

4. Disconnect the capillary array from the polymer 
block:

a. Open the oven, and detection block doors.

b. Loosen the capillary array nut.

c. Pull out the upper polymer block part way.

d. Remove the detection cell from the 
detection block. 

e. Remove the capillary array sleeve from the 
polymer block.

f. If the capillary array is to be reused, store it 
as described on page 215.

5. Disconnect the polymer block tube from the 
lower polymer.

6. Grasp the upper polymer block with two hands 
and pull it straight out.

Removing the Lower Polymer Block

1. Remove the anode reservoir and dispose of the 
buffer properly.

2. Grasp the lower polymer block and pull it 
straight out.

Note: The upper polymer block rides on two 
steel shafts and slides out easily after a spring 
moves past a check point.
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Cleaning the Polymer Blocks

When to Clean

Clean the upper and lower polymer blocks:

• Before replacing the polymer on the instrument

• When the polymer has been on the instrument 
for longer than 1 week

Cleaning the Upper Polymer Block

1. Rinse all the fittings with hot water. Soak any 
fittings that are covered with polymer.

2. Rinse the upper polymer block under hot water.

3. Fill the 20-mL silicone-free syringe with warm 
deionized water (≤70 °C). 

4. Fit the 6-mm syringe adaptor (P/N 4322928) 
onto the 20-mL silicone-free syringe 
(P/N 4324463).

Note: Polymer older than 1 week may cause a 
transient increase in current during electrophoresis 
due to urea decomposition.

IMPORTANT! Do not expose the polymer blocks to 
any organic solvents.

IMPORTANT! Do not use boiling water to rinse 
the fittings or the polymer block.

20-mL syringe

DI H2O ≤ 70 °C

6-mm Luer adaptor

20-mL silicone-free 
syringe
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5. Thread the 6-mm syringe adaptor into the 
stainless-steel check valve.

6. Force several syringe loads of hot water through 
each channel in turn by sealing their openings 
with your fingers. 

7. Remove the syringe from the polymer-reserve 
syringe port and attach it to the array-fill syringe 
port.

8. Force several syringe loads of hot water through 
each channel in turn by sealing their openings 
with your fingers.

GR2190

20-mL silicone-free syringe

6-mm syringe adaptor

Check valve

Upper polymer block

Polymer block tubing

Flush H2O through the 
polymer-reserve syringe 
port

Flush H2O through the 
array-fill syringe port

Note: Force deionized water through polymer 
block tubing also.
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9. Inspect the channels visually for dried polymer, 
which is white residue. Wash partially occluded 
channels with hot water until the dried polymer 
is gone.

10. Rinse the upper polymer block and all the fittings 
thoroughly using deionized water.

11. Remove any residual water from the upper 
polymer block by forcing air through the 
channels using the silicone-free syringe or 
shaking the polymer block. 

Cleaning the Lower Polymer Blocks

To clean the lower polymer block:

1. Verify that the buffer valve is open (in the up 
position).

2. Remove the polymer block tubing and fitting 
from the upper polymer block, if this was not 
done before.

Dried 
polymer

Dried 
polymer

Dried 
polymer

IMPORTANT! It may take a long time for the hot 
water to clear the obstruction. Do not use a sharp 
pointed instrument to clear the channel, even if 
the channel is completely occluded with dried 
polymer.

3x

IMPORTANT! Do not use the 5.0-mL glass 
syringe to force air through the channels. This 
will damage the syringe’s plunger and cause the 
syringe to leak.
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3. Remove the lower polymer block from the 
instrument.

4. Rinse all the fittings with hot water. Soak any 
fittings that are covered with polymer.

5. Hold the lower polymer block under hot water. 
Using your fingers, move the buffer valve in and 
out to ensure any encrusted polymer is cleaned 
out of its guide channel.

6. Fill the 20-mL silicone-free syringe with 
deionized water (≤70 °C). 

7. Fit the 6-mm syringe adaptor (P/N 4322928) 
onto the 20-mL silicone-free syringe 
(P/N 4324463).

8. Thread the 6-mm syringe adaptor into the 
polymer block where the polymer block tube 
fitting was originally located.

IMPORTANT! Do not use boiling water to rinse 
the fittings or the polymer block.

IMPORTANT! Do not remove any of the 
components from the lower polymer block.

20-mL syringe

DI H2O ≤ 70 °C

6-mm Luer adaptor

20-mL silicone-free 
syringe

GR2191

20-mL silicone-free syringe

6-mm syringe adaptor

Buffer 
valve

Lower polymer block
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9. Force several syringe loads of hot water through 
the channel. 

10. Inspect the channels visually for dried polymer, 
which is white residue. Wash partially occluded 
channels with hot deionized water until the dried 
polymer is gone.

11. Rinse the lower polymer block and all the fittings 
thoroughly using deionized water.

12. Remove any residual water from the lower 
polymer by forcing air through the channels until 
the channels are dry using the silicone-free 
syringe or shaking the polymer block.

Removing Air Bubbles from the Polymer Blocks

Clearing Air Bubbles

In the upper polymer block, bubbles tend to collect 
where the channels join after changing polymer, 
installing syringes and/or installing a capillary array.

The bubbles must be removed from the upper polymer 
block channel, polymer tubing and lower polymer 
block channel.

Dried 
polymer

Dried 
polymer

Dried 
polymer

IMPORTANT! It may take a long time for the hot 
water to clear the obstruction. Do not use a sharp 
pointed instrument to clear the channel, even if 
the channel is completely occluded with dried 
polymer.

IMPORTANT! Do not use the 5.0-mL glass 
syringe to force air through the channels. This 
will damage the syringe’s plunger and cause the 
syringe to leak.

Bubbles collect here
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To clear air bubbles from the upper polymer block:

1. Push down slowly on the array-fill syringe to 
move bubbles down the channel and into the 
polymer block tubing. 

2. Push down slowly on the polymer-reserve 
syringe to move bubbles down the channel and 
into the polymer block tubing.

3. Continue to push down slowly on the polymer-
reserve syringe to move the bubbles through 
polymer tubing and out the channel of the lower 
polymer block.

4. If the buffer jar is attached, replace the buffer if 
excess polymer is expelled into the anode buffer 
jar.

Polymer block 
tubing

Polymer flow

Note: Push slowly (or tap) to minimize the 
amount of polymer used.

Polymer flow

GR2191b

Polymer flow

IMPORTANT! Verify that all air bubbles are 
pushed out of the tubing assembly into the lower 
buffer reservoir before proceeding. There should 
be no bubbles in the tubing or channel of the 
lower polymer block.
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5. If air bubbles are still present in the polymer 
block, expel the bubbles as follows:

a. Hold down the anode buffer pin valve and 
simultaneously push down on the array-fill 
syringe to build pressure in the channels.

b. Release the anode buffer pin valve (while 
still pressing down on the array-fill syringe) 
to expel bubbles into the polymer block 
tube.

6. Repeat step 5 as necessary.

GR2148b 

Array fill 
syringe

Anode buffer 
pin valve
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Autosampler Calibration

When to Calibrate the Autosampler

Calibrate the autosampler only as needed.

Symptoms of autosampler alignment problems may 
include:

• Poor injection for a small number of capillaries

• Low signal strength

• No evidence of sample

Calibrating the Autosampler

1. Close the oven and instrument doors.

2. Select Wizards > Autosampler Calibration 
Wizard. 

3. If plates are linked in the Run Scheduler, the 
plates automatically are unlinked. In the Warning 
dialog box, click .

4. Follow the directions given in the wizard to 
calibrate the autosampler.

5. Click .

6. Cycle the instrument power off and on.

The new X, Y, and Z positions from the .ini file 
are uploaded to the instrument software.

IMPORTANT! The new X, Y, and Z positions are 
saved in the .ini file, which is store on the 
computer. The new values take effect only when 
the instrument power is cycled, and the values are 
uploaded to the instrument from the .ini file on 
the computer.
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Manual Control
Manual control is active only if the oven and instrument doors are closed.

Table of
Commands

The following table displays the manual control options as they are organized in the Data 
Collection software.

Command Function Command Options Value

Electrophoresis Set power supply • On

• Off

Set voltage A number between 0 and 15 kV

Laser Set state • Idle

• On

• Off

Set power A number between 0 and 25 mW

Open/Close shutter • Open

• Closed

Oven Set state • On

• Off

Set temperature A number between 18 and 65 °C

Autosampler Move forward N/A

Return N/A

Move up/down A number between –500 and 500 steps

Move to site • Buffer (left, front for 1X running buffer), home position

• Water1 (left, rear for deionized water)

• Water2 (right, front for deionized water)

• Waste (right, rear for deionized water)

Array-fill syringe Move home N/A

Move up A number between 1 and 1200 steps

Move down A number between 1 and 1200 steps

Polymer-reserve 
syringe

Move home N/A

Move up A number between 1 and 1200 steps

Move down A number between 1 and 1200 steps

Pin-valve Set position • Open

• Closed



Manual Control
Using Manual Control

ABI PRISM 3100/3100-Avant Genetic Analyzers User Guide 233

Notes

7

Using Manual Control

Manual control functions cannot be use during a run.

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 
ga3100-Avant >  instrument 
name>  Manual Control.

2. In the Send Defined Command For drop-down 
list, select a function.

3. In the Command Name drop-down list, select a 
command and enter a value, if required.

4. Click .

Manual 
control 
functions

Commands for selected function

Note: The command names are filtered based 
the function selected in step 2.
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Working With Drives for Database and Sample Data Storage

Checking Available Space on Drives D, E, and F

Before a run or batch of runs, the Data Collection software automatically checks the 
available space on drives C, D, and F to ensure sufficient space to store the database and 
sample file data you create. 

The Data Collection software send a warning message to remove data the drive is getting 
full and/or clean up the database when the database is getting full (~80% of capacity). 
An error is generated and displayed in the Instrument Status window in the Errors pane 
and in the Event Log window in the Errors pane. Also, the status light in the bottom left-
hand corner of the data collection window flashes red.

Full Database
Error

To view the error messages, click  GA Instruments >  ga3100 or ga3100-Avant > 
  instrument name >  Instrument Status>  Event Log.

Database full error message

Status light



Working With Drives for Database and Sample Data Storage
Using Manual Control

ABI PRISM 3100/3100-Avant Genetic Analyzers User Guide 235

Notes

7

Disk Drive Full
Error

To view the error messages, click  GA Instruments >  ga3100 or ga3100-Avant > 
  instrument name >  Instrument Status >  Event Log.

Disk drive full error message

Runs can not be started until the data is removed from the drive and/or database is 
cleaned up.

Cleaning Drives Ensure that you have sufficient drive space by regularly:

• Archiving data

• Deleting unneeded files

• Emptying the trash

• Defragmenting the drives

Status light
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Hard Disk Status

Manually Checking Available Disk Space 
on Drive E

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >   Database 
Manager.

The Database Manager view opens.

2. If there is insufficient space:

a. Archive the sample files to a CD-RW (see 
page 237) or another volume.

b. Delete the sample file data from the drive E 
and empty the contents of the Recycle Bin.

Check disk space status here
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Archiving Data

Creating a Data CD

A basic version of Roxio Easy CD Creator™ 5 
software was loaded on your Dell™ computer. Use 
this software to archive data to a CD. The software is 
also part of the CD set you received with your Dell 
computer.

To archive data:

1. Select Start > Programs > Roxio Easy CD 
Creator 5 > Applications > Easy CD Creator.

The Untitled - Easy CD Creator dialog box 
opens.

2. For help creating a data CD, select Help > 
Contents and Index.

3. In the left tree pane, select Making Data CDs 
for Archiving and Sharing > Making a Data 
CD.

Use the instruction to create the CD.
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Instructions for creating a data CD
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Defragmenting the Computer Hard Drives

The fragmentation of files decreases the performance 
of both the data collection software and the computer 
operating system. As the hard drive becomes 
fragmented, programs take greater time to access files 
because they must perform multiple seek operations 
to access the fragments. 

When to Defragment the Computer Hard 
Drive

Defragment the computer hard drive:

• at least once every month.
• before fragmentation reaches 10%.

Defragmenting the Drives

1. In the Windows desktop, right-click 
My Computer ( ), then select Manage.

2. In the Tree tab of the Computer Management 
dialog box, click  Computer Management 
(Local) >  Disk Fragmenter.

3. Select the E drive.

4. Click .

The computer displays the Defragmentation 
Complete dialog box upon completion of the 
defragmentation of the drive.

5. In the Defragmentation Complete dialog box, 
click .

6. In the Computer Management dialog box, 
click .
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Deleting Records from the Database 

Deleting Processed Frame Data

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  Database 
Manager.

The Database Manager view opens.

2. Click Cleanup Processed Plates.

The following dialog box opens.

3. Click .

The Cleanup Database utility deletes 
all run data and plate records in the database. Before 
running the utility, be sure that all runs have been 
extracted from the database.

Note: There is no need to re-import the spatial 
and spectral calibrations or the custom run 
modules.

Note: It may take several minutes to clean up the 
database if it is full or contains a lot of data.
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Audit 
Audit trails maintain a history of data changes made by the user. 

Data Changes
that Generate

Audit Records in
Data Collection

Software

An audit record is generated when data are changed. The following table lists the three 
general categories and the events within them that generate an audit record in Data 
Collection software.

Reason For
Change

When a change occurs and auditing is required, the Reasons For Change dialog displays 
and contains:

• The attribute that was changed, created, or deleted.

• The old and new values, if applicable, in the top half of the dialog box.

• A Text box to enter the reason for the change.

– When you click OK, changes to the attribute and the audit data are saved.

– When you click Cancel, no changes are saved and you return to the previous 
window.

Plate Record Run Module Results Group

An audit record is 
generated in Data 
Collection software 
when you ...

• Create, edit, or 
import a plate 
record

• Create a run 
module

• Edit the 
parameters of a 
run module

• Create, edit, or 
import a results 
group

Parameter changes

Reason for changes
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Enabling The Access Control and Audit Features

Enabling Access Control (Security)

1. Start the following:

– Data Collection services: Start > Programs > 
Applied Biosystems > Data Collection > 
Run Data Collection 3100 v2.0 or Run Data 
Collection 3100-Avant v2.0.

– Administrator application: Start > Programs 
> Applied Biosystems > Administrator.

2. In the left pane tree double-click Access Control 
Administration.

3. In the System Authentication dialog box, type 
Administrator for the login name and type your 
password if you have changed it; if not, type 
Administrator.

4. Select Applications > FoundationViewerApp.

5. Select the Challenge check box to activate it.

The Login and Password dialog box is now 
enabled.

6. Select File > Save.

7. Exit Access Control Administration.
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Enabling Audit

1. In the Navigator left pane tree, double- click 
Audit Map Configuration.

2. Select Enabled audit map object to activate it:

• DC Plate Record

• DC Run Module

• DC Results Group

3. Exit Audit Map Configuration.
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Starting AB Navigator
AB Navigator is the access point for these 
applications:

• Audit Map Configuration

• Audit Map History Viewer

• Access Control Administration r

1. Start the Data Collection Services, then start the 
Administrator application:

a. Data Collection services: Start > Programs 
> Applied Biosystems > Data Collection > 
Run Data Collection 3100 v2.0 or Run 
Data Collection 3100-Avant v2.0.

b. Administrator application: Start > 
Programs > Applied Biosystems > 
Administrator.

The System Authentification dialog box displays.

2. Enter login name and password, then click OK.

Default login name: “Administrator” 

Default password: “Administrator”

IMPORTANT! You must start Data Collection 
services in order for AB Navigator to function 
properly. 

Note: To change your password, see step 4 on 
page 257
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3. In the left pane tree, click Administration to 
expand the options.

Audit Map Configuration
The Audit Map Configuration Tool is used to manage 
Audit Maps. Audit Maps are used to control how 
auditing is done for a given data type. 

Some features of the Audit Map Configuration Tool:

• You can set the audit states of an audit map to 
On, Off, or Silent.

• There is no SAVE command. All changes to 
audit maps are saved automatically.

Starting the Audit Map Configuration Tool

1. Click the Audit Map Configuration icon in the 
left pane tree.

The System Authentification dialog box displays.
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2. In the System Authentication dialog box, type 
Administrator for the login name and type your 
password if you have changed it; if not, type 
Administrator.

Click OK.

The Audit Map Configuration window displays.

Audit Map Configuration Functions

Audit Map Configuration Functions:

If you want to ... Then ...

Enable or disable all the attributes in an 
audit map

Select or deselect a cell in the Enabled column in the Audit Map Objects 
pane.

Change the audit state of an attribute in 
this window only.

Select a different audit state in a cell under the State column in the 
Attributes pane. 

Audit states are: On or Silent.

Sort a row  Click on a column header.

Note: Disabled Audit Maps (Enabled column) display their attribute list in italics.
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Commands The following table lists the commands you can perform in the Audit Map Configuration 
Tool.

 Attribute States

When you click an Audit Map Object, the Attributes Pane (right) displays. 

Toolbar 
Menu Command Function

File Go To Displays a list of applications that are currently running; 
select an application to go to that application

Visual Print Displays Print Dialog

Visual Print 
Preview

Displays Print Preview

Exit Application Exits the Audit Map Configuration application

Exit AB 
Navigator

Exits the AB Navigator application

Auditing On Select auditing to be turned on for the Audit Map 
Configuration. 

When a change is made to an Audit Map’s enabled state 
or when a change is made to the state of an attribute, 
auditing occurs, and A Reason For Change (RFC) dialog 
displays.

Silent When a change is made to an Audit Map’s enabled state 
or when a change is made to the state of an attribute, 
auditing occurs. Although the RFC Dialog does not 
display, a ‘silent’ Audit Record is created.

When RFC Dialog 
Displays and 

You...
Then ...

Click OK The map or attribute state 
changes and an Audit Record 
is created.

Click Cancel The map or attribute state 
does not change.

Audit Map 
Objects
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Change Description

This function controls the Reason for Change dialog box. When it is on, any changes to 
the enabled Audit Map Object forces the user to type a reason for the change. 

To disable this feature for an enabled object—The DC Results Group in the example 
below—change the state to Off.

Parameter Change

This function records old and new values that are displayed in the upper half of the 
Reason for Change dialog box (see “Reason For Change” on page 242).

On, Off, and Silent The following table describes the On, Off, and Silent states for audit map attributes, 
Change Description and Parameter.

Audit Map Attributes

State Change Description Parameter

On Reason for change required Records old and new values

Off Reason for Change dialog box does not 
display

Does not record old or new value 
changes

Silent Reason for Change dialog box does not 
display

Records old and new values
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Audit History Viewer
The Audit History Viewer is used to view historical 
audit data. This tool is used as a read-only viewer for 
audit records. The tool provides data filtering so that 
audit records can be viewed in different formats. 

Audit records that you can view with the Audit 
History Viewer are:

• Date and time the audit record was created.

• The user who triggered the audit event.

• The attribute that was changed.

• The old and the new values.

• The reason for the change.

Starting the Audit History Viewer

1. Double-click the Audit History Viewer icon in 
the left pane tree.

2. In the System Authentication dialog box, type 
Administrator for the login name and type your 
password if you have changed it. If not, type 
Administrator.

3. Click OK.

The Audit History Viewer displays.

Note: The audit records are stored in a permanent 
data store.
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Viewing an Audit History

1. In the Audit Objects pane, expand the objects 
tree until the object of interest displays.

2. Highlight an object and then click  (Detail 
Panel) to display audit record details.

Note: Click the column headers to sort the read-
only records columns.
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Filter Command

The filter allows you to categorize audit history 
records. 

1. Click  (Filter).

The Filter Audit Records pane displays.

2. Enter search criteria in the applicable text boxes.

3. Click Find Now.

You can filter audit records by:

• Name

• Date (and, before or after a date or between 
two dates)

• User name

• Matching whole words

• Case sensitivity

Commands

Toolbar
Menu Command Function

File Reload Refreshes the Audit History Viewer with the latest changes

Report Customize and then print a report of the selected Audit 
History Record

Print Preview Customize and then preview a report of the selected Audit 
History Record

Page Setup Customize the page setup of the Report printout

Go To Displays a list of applications that are currently running; 
select an application to go to that application

Visual Print Displays Print Dialog

Visual Print Preview Displays Print Preview

Exit Application Exits the Audit Map Configuration application

Exit AB Navigator Exits the AB Navigator application

View Filter Displays the filter pane on the top of the frame when 
selected. It allows the user to specify criteria that limits the 
amount of audit records in the Audit Record table.
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Access Control Administration
The Access Control Administration tool allows an 
administrator to manage the creation and deletion of:

• Users

• Profiles

Also, Access Control allows an administrator to 
restrict or grant users access to features and functions 
of the software.

An administration user is always associated with the 
Administration User Group and cannot be deleted. 
And, only one administrator is allowed to modify 
Access Control data at one time. 

Starting the Access Control Administra-
tion Tool 

1. Start the following:

– Data Collection services: Start > Programs > 
Applied Biosystems > Data Collection > 
Run Data Collection 3100 v2.0 or Run Data 
Collection 3100-Avant v2.0.

– Administrator application: Start > Programs 
> Applied Biosystems > Administrator.

2. Double-click the Access Control Administration 
icon in the left pane tree.

3. In the System Authentication dialog box, type 
Administrator for the login name and type your 
password if you have changed it. If not, type 
Administrator.

4. Click OK.

IMPORTANT! You must start Data Collection 
services in order for AB Navigator to function 
properly. 
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The Access Control Administration tool displays.

Type Selection

In the left pane tree, Users and Applications are types. 
When you select a type, the List of Users pane 
displays a list of identifiers of the type selected.

Name Selection

When you highlight a name, properties of that name 
display in the User Properties pane. 

Properties Panes

Access control identifiers have an additional drop-list 
labeled “Control Properties”. This defines the access 
level an individual is allowed in the Data Collection 
software. 

The identifiers under access control are:

• User

• Profile

IMPORTANT! Do not remove any applications from 
the default list in the left pane tree.

Note: If you select the EULA (End User License 
Agreement) check box, the license agreement 
displays the next time the user is authenticated.
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Inherited Rights Each default user group has certain inherited rights related to their group profile.The 
group profile definitions are:

• Instrument Protocols include: Run Module Operations, Results Group Operations, 
Analysis Protocol Operations, Instrument Protocol Operations and Reextraction.

• Instrument Operation include: Plate Operations, Event Log, and Instrument 
Control Operations.

• Instrument Maintenance: Spatial Calibration Operations, Manual Instrument 
Control, and Miscellaneous Operations.

Commands Commonly used commands:

• Toolbar. Frequently used commands appear in the application toolbar. Tool tip help 
text appears when you place the cursor over a button in the toolbar.

– Save:  Save commits changes in the Admin Tool to data store and is 
accessible from the menu bar, keyboard shortcut, or toolbar.

– Exit: Exit is invoked by the standard upper-right-corner control or by the 
Files/Exit menu selection. If you have updated memory but have not yet 
committed changes to data store, the application asks, “Information has been 
modified, Save changes?” The message box provides buttons for Yes, No, and 
Cancel.

– Duplicate:  Duplicates the selected indentifier. Duplicate 

is accessible from the menu bar and toolbar.

– Find:  locates the name specified in the text field in the navigator tree

– Print: Prints all or some identifiers in various formats selected from the dialog 
shown below. Go to File > Report  to display the Print Options dialog box.
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Creating a New User

1. Click the New User icon 

The New User dialog displays.

2. Click Next.

The Configure pane displays.

IMPORTANT! You must set a default password for 
each new user.
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3. Complete the information in the window.

4. Click Set Password.

The Change Password dialog box displays.

5. Complete the new password, then click OK.

6. Click Finish to complete the creation of a new 
user.

7. Click  (Save).

8. Click Next.
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The Summary pane displays the new user profile 
data.

9. (Optional) To force the user to create a password 
when they login for the first time, enable the Pre-
Expire check box. If the Pre-Expire check box is 
not enabled, first time users use the default login 
password.

User Properties

A user must be assigned to a profile, which allows the 
administrator to grant or deny a user the right to 
execute functions defined by applications

When one user is selected in the left navigator tree, 
the user profile displays in the User Properties pane 
and the User Details pane. 
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Default Profiles

User Groups

Default profiles show the access each user group has. 
The default user groups and their default profiles are:

• Administrator: Complete access to Instrument 
Protocols, Instrument Operation, Instrument 
Maintenance

• Scientist: Complete access to Instrument 
Protocols, Instrument Operation, Instrument 
Maintenance

• Technician: Access to Instrument Operation and 
Maintenance 

Inherited Rights

Each default user group has certain inherited rights 
related to their group profile.The group profile 
definitions are:

• Instrument Protocols include: Run Module 
Operations, Results Group Operations, Analysis 
Protocol Operations, Instrument Protocol 
Operations and Reextraction.

• Instrument Operation include: Plate Operations, 
Event Log, and Instrument Control Operations.

• Instrument Maintenance: Spatial Calibration 
Operations, Manual Instrument Control, and 
Miscellaneous Operations.

Overriding Inherited Rights

To override the inherited rights of a group, simply 
deselect the OIR check box next to the function you 
want to deny. In the graphic below, the scientist group 
is denied access to Instrument Operation.

Default access 
rights for 
Technicians
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Creating a New Profile
1. Click the New Profile icon 

The New Profile dialog displays.

2. Click Next.

The Configure pane displays.

3. Complete:

a. Profile properties

b. From the drop list, select the control 
security group with which the new profile is 
to be associated.

c. Select OIR and/or Execute

Execute: Select this to give access to the 
function to any user assigned to this Profile.

OIR: Select this to override inherited rights. 
Any lower level in the hierarchy inherits the 
access rights of the node above it.

To override the inherited defaults, check the 
OIR check box. This allow the administrator 
to grant or deny the groups’ ability to 
execute a specific function on a lower level 
of the hierarchy tree.

4. Click Next.

The Summary pane displays the properties and 
associations of the new profile name.

5. Click Finish to complete the creation of a new 
User Profile Name.
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AAdditional Information About Plate
Records

This appendix covers:

� Run Priority Scheduling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 262
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Run Priority Scheduling

Priority Values The user-definable run priority scheduling function allows for scheduling of runs in 
custom order, thereby providing more flexibility when scheduling runs.

A default value of 100 is assigned to each sample in the plate record. Changing the value 
to a smaller number causes that set of 16 or 4 samples to run to before the others in the 
injection list. See “Run Scheduling” on page 160 for the default run schedule for 96- and 
384-well plates for the both 16 and 4 capillary arrays.

Scheduling Examples Using a 96-well Plate and 16 Capillary Arrary

Default Run
Scheduling

In this example, 100 is the priority value for all samples in the plate record. The default 
run priority schedule is used (see table below). Samples B07–D08 called out on the plate 
record, correspond to Run 4 as displayed in the Run Scheduler > Run View window.

Default run priority schedule, samples in wells A07–H08 are scheduled as Run 4

Well Numbers Run Number Priority

A01–H02 1

A03–H04 2

A05–H06 3

A07–H08 4

A09–H10 5

A11–H12 6
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User-definable
Run Priority
Scheduling

In this example, the priority value for sample G07 is 80 and all other samples remain 
100. Sample well G07 is contained in the A07–H08 injection set. All 16 samples now 
correspond to Run 1, as displayed in the Run Scheduler > Run View window. 

The table below shows the change in the run priority schedule.

User defined run priority schedule, samples in wells A07–H08 are scheduled as Run 1

Well Numbers Run Number Priority

A07–H08 1

A01–H02 2

A03–H04 3

A05–H06 4

A09–H10 5

A11–H12 6
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The rest of the samples are run after the samples in wells A07–H08. Samples in wells 
A01–H02 are now scheduled as Run 2.

User defined run priority schedule, samples in wells A01–H02 are now scheduled as Run 2
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Edit > Fill Down Special Option for Plate Records

Using Fill Down Special Option

Based on the plate type (96- or 384-well) and 
capillary array (16 or 4 capillaries) you are using, the 
software automatically fills in the appropriate well 
positions for a single run.

The Fill Down Special option works with all plate 
records (Spectral, Sequencing Analysis, SeqScape, 
GeneMapper and Mixed plates). 

Creating and Completing the Plate Record

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 
ga3100-Avant >  Plate Manager.

2. Click .

The New Plate Dialog dialog box opens.

3. Complete the information in the New Plate 
Dialog box, then click .

The Plate Editor opens.

4. Complete the columns for a single well position.

5. Highlight the entire row.

Note: You can start at any well position, the 
software automatically fills up or down based on 
the default run scheduling patterns (see 
Chapter 6, page 160). 
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6. Select Edit > Fill Down Special.

7. Click  to save the plate record.

Examples of Fill Down Special 

Examples of completed plate records and run 
scheduling for the 3100 and 3100-Avant instruments, 
and 96- and 384-well plates are shown below.

96-well plate on a 3100 instrument
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384-well plate on a 3100 instrument

96-well plate on a 3100-Avant instrument



Appendix A
Edit > Fill Down Special Option for Plate Records

268 ABI PRISM 3100/3100-Avant Genetic Analyzers User Guide

Notes

384-well plate on a 3100-Avant instrument
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Multi-application (Mixed) Plate Record

Required Files for
a Mixed Plate

Record

To run a mixed plate with sequencing, SeqScape and/or fragment analysis samples, the 
following files are required:

• Sequencing analysis (see Chapter 4, page 75)

– Results Group

– Instrument Protocol

– Analysis Protocol

• SeqScape analysis (see Chapter 4, page 101)

– Results Group

– Instrument Protocol

– Analysis Protocol

– Files created in SeqScape software

• Fragment analysis (see Chapter 5, page 127)

– Results Group

– Instrument Protocol

– Files created in GeneMapper software

Spectral Calibrations

Creating Spectral
Calibrations

For every dye set and capillary array length combination you use, a separate spectral 
calibration must be created. Refer to “Performing a Spectral Calibration” on page 45 for 
more information.

Setting the Active
Spectral

Calibration

If you changed the capillary arrary length to run multi-application samples, you must set 
the active spectral calibration for each dye set used. Refer to “Activating a Spectral 
Calibration” on page 59, for information on how to set the active calibrations, once 
calibrations are performed for each dye set on each capillary length.
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Creating and Completing a Mixed Plate Record

1. In the Tree pane of the Data Collection Software, 
click  GA Instruments >  ga3100 or 
ga3100-Avant >  Plate Manager.

2. Click .

The New Plate Dialog dialog box opens.

3. Complete the information in the New Plate 
Dialog:

a. Type a name for the plate.

b. Type a description for the plate (optional).

c. Select Mixed in the Application drop-down 
list.

d. Select 96-well or 384-well in the Plate Type 
drop-down list.

e. Type a name for the owner and operator.

f. Click . 

The Integrated Plate Dialog box opens.

3a

3b

3c

3d

3e

3f
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4. In the Set Application pane:

a. On the plate map, click a well position. The 
run of 16 or 4 capillaries is outlined.

b. In the Application drop-down list select the 
appropriate application.

c. Repeat the process for additional samples 
and applications.

4b

4a
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5. Create the Sequencing sample sheets (plate 
record).

a. On the plate map, click a well position that 
represents a sequencing sample.

b. Click Sample Sheet. 

The Sequencing Analysis Plate editor 
opens.

c. Complete the plate record.

d. Click  . You are automatically returned 
to the Integrated Plate dialog box.

5b

5a

Note: The well column contains only those 
wells that were designated as sequencing 
samples on the plate map.



Multi-application (Mixed) Plate Record
Examples of Fill Down Special

ABI PRISM 3100/3100-Avant Genetic Analyzers User Guide 273

Notes

6. Create the GeneMapper sample sheet (plate 
record).

a. On the plate map, click a well position that 
represents a GeneMapper sample.

b. Click Sample Sheet. 

The GeneMapper Plate editor opens.

c. Complete the plate record.

d. Click  . You are automatically returned 
to the Integrated Plate dialog box.

7. In the Integrated Plate dialog box, click 
.

6b

6a

Note: The well column contains only those 
wells that were designated as fragment 
analysis samples on the plate map.
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BBasecallers and DyeSet/Primer Files

This appendix covers:

���� ABI PRISM® 3100 Genetic Analyzer Files . . . . . . . . . . . . . . . . . . . . . . . . . . 276

���� ABI PRISM® 3100-Avant Genetic Analyzer Files . . . . . . . . . . . . . . . . . . . . . 278
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ABI PRISM® 3100 Genetic Analyzer Files
3100 Basecaller and DyeSet/Primer Files Used for Dye Terminator Chemistry 

DNA Sequencing Chemistry Capillary Array 
Length (cm) Basecaller DyeSet/Primer

KB Basecalling

ABI PRISM® BigDye® 
Terminator v1.1

36: ultra rapid KB.bcp KB_3100_POP4_BDTv1.mob

50: std read

80: long read

36: rapid read KB_3100_POP6_BDTv1.mob

50: std read

ABI PRISM® BigDye® 
Terminator v3.1

36: ultra rapid KB_3100_POP4_BDTv3_.mob

50: std read

80: long read

36: rapid read KB_3100_POP6_BDTv3.mob

50: std read

ABI Basecalling

• ABI PRISM BigDye 
Terminator v1.1

• ABI PRISM® dGTP 
BigDye® Terminator

36: ultra rapid Basecaller-3100POP4UR.bcp DT3100POP4LR{BD}v1.mob

80: long read Basecaller-3100POP4_80cmv3.bcp

36: rapid read Basecaller-3100POP6RRv2.bcp DT3100POP6{BD}v2.mob

50: std read Basecaller-3100POP6SR.bcp

• ABI PRISM BigDye 
Terminator v3.1

• ABI PRISM dGTP BigDye 
v3.0 Terminator

36: ultra rapid Basecaller-3100POP4UR.bcp DT3100POP4{BDv3}v1.mob

80: long read Basecaller-3100POP4_80cmv3.bcp

36: rapid read Basecaller-3100POP6RRv2.bcp DT3100POP6{BDv3}v1.mob

50: std read Basecaller-3100POP6SR.bcp

ABI PRISM® dRhodamine 
Terminator

36: ultra rapid Basecaller-3100POP4UR.bcp DT3100POP4{dRhod}v2.mob

80: long read Basecaller-3100POP4_80cmv3.bcp

36: rapid read Basecaller-3100POP6RRv2.bcp DT3100POP6{dRhod}v2.mob

50: std read Basecaller-3100POP6SR.bcp
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3100 Basecaller and DyeSet/Primer Files Used for Dye Primer Chemistry 

DNA Sequencing
Chemistry

Capillary Array 
Length (cm) Basecaller DyeSet/Primer

ABI Basecalling

ABI PRISM® BigDye® 
Primer v1.1

36: rapid read Basecaller-3100POP6RRv2.bcp DP3100POP6{BD-21M13}v1.mob

DP3100POP6{BD-M13Rev}v1.mob50: std read Basecaller-3100POP6SR.bcp

ABI PRISM® BigDye® 
Primer v3.1

36: rapid read Basecaller-3100POP6RRv2.bcp DP3100POP6{BDv3-21M13}v1.mob

DP3100POP6{BDv3-M13Rev}v1.mob50: std read Basecaller-3100POP6SR.bcp

ABI PRISM® BigDye® 
Primer (All primers)

36: ultra rapid Basecaller-3100POP4UR.bcp DP3100POP4{BDv3}v1.mob

80: long read Basecaller-3100POP4_80cmv3.bcp
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ABI PRISM® 3100-Avant Genetic Analyzer Files
3100-Avant Basecaller and DyeSet/Primer Files Used for Dye Terminator Chemistry 

DNA Sequencing 
Chemistry

Capillary Array 
Length (cm) Basecaller DyeSet/Primer

KB Basecalling

ABI PRISM BigDye 
Terminator v1.1

36: ultra rapid KB.bcp KB_3100_POP4_BDTv1.mob

50: std read

80: long read

36: rapid read KB_3100_POP6_BDTv1.mob

50: std read

ABI PRISM BigDye 
Terminator v3.1

36: ultra rapid KB_3100_POP4_BDTv3_.mob

50: std read

80: long read

36: rapid read KB_3100_POP6_BDTv3.mob

50: std read

ABI Basecalling

ABI PRISM BigDye 
Terminator v1.1

36: ultra rapid Basecaller-3100APOP4UR.bcp DT3100POP4LR{BD}v1.mob

80: long read Basecaller-3100APOP4_80cmv3.bcp

36: rapid read Basecaller-3100APOP6RRv2.bcp DT3100POP6{BD}v2.mob

50: std run Basecaller-3100APOP6SR.bcp

ABI PRISM BigDye 
Terminator v3.1

36: ultra rapid Basecaller-3100APOP4UR.bcp DT3100POP4{BDv3}v1.mob

80: long read Basecaller-3100APOP4_80cmv3.bcp

36: rapid read Basecaller-3100APOP6RRv2.bcp DT3100POP6{BDv3}v1.mob

ABI PRISM dRhodamine 
Terminator

36: ultra rapid Basecaller-3100APOP4UR.bcp DT3100POP4{dRhod}v2.mob

80: long read Basecaller-3100APOP4_80cmv3.bcp

36: rapid read Basecaller-3100APOP6RRv2.bcp DT3100POP6{dRhod}v2.mob

50: std run Basecaller-3100APOP6SR.bcp
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CTroubleshooting

This appendix covers:

���� Instrument Startup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 280

���� Spatial Calibration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 281
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���� Run Performance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 284

���� Software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292
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Instrument Startup

Troubleshooting instrument startup  

Observation Possible Cause Recommended Action

No communication between the 
instrument and the computer. 
The event viewer is blank.

Incorrect Ethernet configuration. Check the configuration of the IP address. 

1. Select Start > Programs > Command Prompt.

2. At the C:\ prompt, type
IPconfig /all.

3. Press Enter. The command prompt window 
displays information on the network.

4. Ensure the IP address for Ethernet adapter 1 is 
set for the machine (i.e., the motherboard 
Ethernet connection). The correct IP address is: 
192.168.0.1

Note: The local IT group should use Adapter 2 for 
networking.

Instrument red light is blinking. Incorrect start up procedure. Start up in the following sequence:

1. Log out of the computer.

2. Turn off the instrument.

3. Boot up the computer.

4. After the computer has booted completely, turn 
the instrument on. Wait for the green status light 
to come on.

5. Launch the Data Collection software.

Data Collection software will not 
launch.

Applications in the Service 
Console did not start properly.

(It takes several minutes before 
data collection software opens.)

Restart the computer.

Computer screen is frozen. Communication error. There will be no loss of data. However, if the 
instrument is in the middle of a run, wait for the run 
to stop. Then, exit the Data Collection software 
and restart as described above.

Autosampler does not move to 
the forward position.

Possible communication error. Restart the system, and then press the Tray button.

Oven or instrument door is not 
closed.

1. Close and lock the oven door.

2. Close the instrument doors.

3. Press the Tray button.

Instrument does not respond to 
commands immediately after 
closing the doors.

Autosampler reinitializes its 
location.

Wait for the autosampler to home before 
continuing.
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Spatial Calibration

Troubleshooting spatial calibration 

Observation Possible Cause Recommended Action

Unusual peaks or a flat line for 
the spatial calibration.

The instrument may need more 
time to reach stability. An 
unstable instrument can cause a 
flat line with no peaks in the 
spatial view.

Check or repeat spatial calibration.

Improper installation of the 
detection window.

Reinstall the detection window and make sure it 
fits in the proper position.

Broken capillary resulting in a 
bad polymer fill.

Check for a broken capillary, particularly in the 
detection window area. If necessary, replace the 
capillary array using the Install Array Wizard.

Dirty detection window. Place a drop of methanol onto the detection 
window, and dry with compressed air. Use only 
light air force. 

CHEMICAL HAZARD. Methanol is a 
flammable liquid and vapor. Exposure may cause 
eye, skin, and respiratory tract irritation, and 
central nervous system depression and blindness. 
Read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

Persistently bad spatial 
calibration results.

Bad capillary array. Replace the capillary array, and then repeat the 
calibration. Call Technical Support if the results do 
not improve.
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Spectral Calibration

Troubleshooting spectral calibration 

Observation Possible Cause Recommended Action

No signal. Incorrect preparation of sample. Replace samples with fresh samples 
prepared with fresh Hi-Di™ 
formamide.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and 
respiratory tract irritation. It is a 
possible reproductive and birth defect 
hazard. Read the MSDS, and follow 
the handling instructions. Wear 
appropriate protective eyewear, 
clothing, and gloves.

Air bubbles in sample tray. Centrifuge samples to remove air 
bubbles.

Autosampler not correctly aligned. The 
capillary tips may be hitting the bottom 
of the wells, or they may not be 
touching the samples.

Check the autosampler calibration. If 
necessary, recalibrate the autosampler 
using the Autosampler Calibration 
Wizard.

If the spectral calibration fails, or if a 
message displays “No candidate 
spectral files found.”

Clogged capillary. Refill the capillaries using manual 
control. Look for clogged capillaries 
during capillary fill on the cathode side.

Incorrect chemistry file, dye set, and/or 
run module selected.

Correct the files and rerun the 
calibration.

Insufficient filling of array. Check for broken capillaries and refill 
the capillary array.

Expired matrix standards. Check the expiration date and storage 
conditions of the matrix standards. If 
necessary, replace with a fresh lot.

Data Error - One or more peaks fall 
below the minimum required amplitude 
of 750.

One or more peaks fall below the 
minimum required amplitude of 750.

Rerun the spectral standards, and if 
necessary, increase the amount of 
spectral standard added.
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Spikes in the data. Expired polymer. Replace the polymer with a fresh lot 
using the Change Polymer Wizard.

CHEMICAL HAZARD. 
POP-4 polymer and POP-6 cause eye, 
skin, and respiratory tract irritation. 
Read the MSDS, and follow the 
handling instructions. Wear 
appropriate protective eyewear, 
clothing, and gloves.

Air bubbles, especially in the polymer 
block tubing assembly.

Refill the capillaries using manual 
control.

Possible contaminant or crystal 
deposits in the polymer.

Properly bring the polymer to room 
temperature; do not heat to thaw 
rapidly. Swirl to dissolve any solids.

Replace the polymer if it has expired.

Troubleshooting spectral calibration (continued)

Observation Possible Cause Recommended Action

WARNING!
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Run Performance

Troubleshooting run performance 

Observation Possible Cause Recommended Action

No data in all capillaries. • Bubbles in the system.

• No sample injection

Visually inspect the polymer block and the 
syringes for bubbles.

Remove any bubbles using the Change Polymer 
Wizard. 

If bubbles still persist, perform the following:

1. Remove the capillary array.

2. Clean out the polymer block and syringes. 

3. Replace polymer with fresh polymer. Make sure 
to draw the polymer into the syringe very 
slowly.

CHEMICAL HAZARD. POP-4 
polymer and POP-6 causes eye, skin, and 
respiratory tract irritation. Read the MSDS, and 
follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and 
gloves.

Possible contaminant in the polymer 
path.

Wash the polymer block with hot water. Pay 
attention to the upper polymer block, the ferrule, 
the ferrule screw, and the peek tubing. Dry the 
parts with compressed air before replacing them 
onto the instrument. 

IMPORTANT! Do not wash syringes in hot 
water because the Teflon plungers will get 
damaged.

Possible contaminant or crystal 
deposits in the polymer.

Bring the polymer to room temperature, swirl to 
dissolve any deposits.

Replace the polymer if it has expired.

CHEMICAL HAZARD. POP-4 
polymer and POP-6 cause eye, skin, and 
respiratory tract irritation. Read the MSDS, and 
follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

WARNING!

WARNING!
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No signal. Autosampler calibration is not optimal. Check the injection with 20-µL samples. 

• If the injection is OK, recalibrate the 
autosampler using the Autosampler Calibration 
Wizard. Pay particular attention to the Z-axis.

IMPORTANT! You must cycle the power on the 
instrument to use the new values.

• If the injection is not OK, perform the 
procedures below.

Dead space at bottom of sample tube. Centrifuge the sample tubes.

Bent capillary array. Replace the capillary array and recalibrate the 
autosampler using the Calibrate Autosampler 
Wizard.

Failed reaction. Repeat reaction.

Cracked or broken capillary Visually inspect the capillary array, including the 
detector window area for signs of breakage.

Signal too high. Sample concentration is too high. Dilute the sample.

Decrease the injection time.

Too much DNA added to the reaction, 
resulting in uneven signal distribution.

Optimize reaction conditions.

Troubleshooting run performance (continued)

Observation Possible Cause Recommended Action
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Low signal strength. Poor quality formamide. Use a fresh lot of Hi-Di formamide.

CHEMICAL HAZARD. Formamide 
causes eye, skin, and respiratory tract irritation. It 
is a possible reproductive and birth defect hazard. 
Read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

Pipetting error; not enough sample. Increase the amount of DNA added. 

Recalibrate the pipets.

Sample has high salt concentration. Dilute in high-quality water.

Desalt using a column purification method.

Insufficient mixing. Vortex the sample thoroughly, and then centrifuge 
the tube to condense the sample to the bottom of 
the tube.

Autosampler out of calibration. Check the injection with 20-µL samples. If the 
injection is OK, recalibrate the autosampler using 
the Autosampler Calibration Wizard. Pay particular 
attention to the Z-axis.

Cycle the power on the instrument to use the new 
calibration values.

Weak amplification of DNA. Reamplify the DNA.

Check DNA quality.

Troubleshooting run performance (continued)

Observation Possible Cause Recommended Action
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Elevated baseline. Possible contaminant in the polymer 
path.

Wash the polymer block with hot water. Pay 
attention to the upper polymer block, the ferrule, 
the ferrule screw, and the peek tubing. Dry the 
parts before replacing them onto the instrument. 

IMPORTANT! Do not wash syringes in hot water 
because the Teflon plungers will get damaged.

Possible contaminant or crystal 
deposits in the polymer.

Bring the polymer to room temperature, swirl to 
dissolve any deposits.

Replace the polymer if it has expired.

CHEMICAL HAZARD. POP-4 
polymer and POP-6 cause eye, skin, and 
respiratory tract irritation. Read the MSDS, and 
follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

Poor spectral calibration. Perform new spectral calibration.

Detection cell is dirty. Place a drop of methanol onto the detection 
window and dry with compressed air. Use only 
light air force. 

Troubleshooting run performance (continued)

Observation Possible Cause Recommended Action

WARNING!
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Loss of resolution. Too much sample injected. Dilute the sample and re-inject.

Poor quality water. Use high-quality, ultra-pure water.

Poor quality or dilute running buffer. Prepare fresh running buffer from 10X 3100 buffer 
with EDTA.

CHEMICAL HAZARD. 10X Genetic 
Analyzer Buffer with EDTA may cause eye, skin, 
and respiratory tract irritation. Read the MSDS, 
and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and 
gloves.

Poor quality or breakdown of polymer. Use a fresh lot of polymer.

Capillary array used for more than 100 
injections.

Replace with new capillary array.

Degraded formamide. Prepare fresh Hi-Di formamide and re-prepare 
samples.

CHEMICAL HAZARD. Formamide 
causes eye, skin, and respiratory tract irritation. It 
is a possible reproductive and birth defect hazard. 
Read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

High salt concentration in samples. Use a recommended protocol for salt removal. 
Dilute salts with water.

Poor resolution in some 
capillaries.

Insufficient filling of capillary array. Refill the capillary array and look for cracked or 
broken capillaries. If problem persists contact 
Technical Support.

Re-inject the same samples.

Poor quality samples. Check the sample preparation.

Troubleshooting run performance (continued)

Observation Possible Cause Recommended Action
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No current. Poor quality water. Use only high-quality ultra-pure water.

Water placed in buffer reservoir 
position 1.

Replace with fresh 3100 1X running buffer.

Not enough buffer in anode reservoir. Add buffer up to the fill line. 

Buffer too dilute. Prepare 1X running buffer.

Add 3 mL 10X Genetic Analyzer Buffer with EDTA 
to 27 mL deionized water.

CHEMICAL HAZARD. 10X Genetic 
Analyzer Buffer with EDTA may cause eye, skin, 
and respiratory tract irritation. Read the MSDS, 
and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and 
gloves.

Bubble(s) present in the polymer block 
and/or the capillary and/or PEEK 
tubing.

Pause run and inspect for the instrument for 
bubbles. They may be hidden in the PEEK tubing.

Remove any bubbles according to the remove 
bubble procedure in the Replace Polymer Wizard.

Elevated current. Decomposed polymer. Open fresh lot of polymer and store at 4 °C.

Incorrect buffer dilution. Prepare 1X running buffer.

Add 3 mL 10X Genetic Analyzer Buffer with EDTA 
to 27 mL deionized water.

CHEMICAL HAZARD. 10X Genetic 
Analyzer Buffer with EDTA may cause eye, skin, 
and respiratory tract irritation. Read the MSDS, 
and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and 
gloves.

Arcing in the gel block. Check for moisture in and around the septa, the 
reservoirs, the oven, and the autosampler.

Troubleshooting run performance (continued)

Observation Possible Cause Recommended Action



Appendix C
Run Performance

290 ABI PRISM 3100/3100-Avant Genetic Analyzers User Guide

Notes

Fluctuating current. Bubble in polymer block. Pause the run, check the polymer path for 
bubbles, and remove them if present.

A slow leak may be present in the 
system.

Check polymer blocks and syringes for leaks. 
Tighten all fittings.

Incorrect buffer concentration. Prepare 1X running buffer.

Add 3 mL 10X Genetic Analyzer Buffer with EDTA 
to 27 mL deionized water.

CHEMICAL HAZARD. 10X Genetic 
Analyzer Buffer with EDTA may cause eye, skin, 
and respiratory tract irritation. Read the MSDS, 
and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and 
gloves.

Not enough buffer in anode reservoir. Add buffer up to the fill line. 

Clogged capillary. Refill capillary array and check for clog.

Arcing Check for moisture in and around the septa, the 
reservoirs, the oven, and the autosampler.

Poor performance of 
capillary array used for 
fewer than 100 runs.

Poor quality samples, possible 
cleanup problems.

Desalt samples using a recommended purification 
protocol.

Poor quality formamide. Prepare fresh Hi-Di formamide and re-prepare 
samples.

CHEMICAL HAZARD. Formamide 
causes eye, skin, and respiratory tract irritation. It 
is a possible reproductive and birth defect hazard. 
Read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

Incorrect buffer. Use 10X Genetic Analyzer Buffer with EDTA to 
prepare 1X running buffer.

CHEMICAL HAZARD. 10X Genetic 
Analyzer Buffer with EDTA may cause eye, skin, 
and respiratory tract irritation. Read the MSDS, 
and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and 
gloves.

Troubleshooting run performance (continued)

Observation Possible Cause Recommended Action
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Migration time becomes 
progressively slower.

Leak in system. Tighten all ferrules, screws, and check valves. 
Replace any faulty parts.

Improper filling of polymer block. Polymer pump force may need to be adjusted, call 
a service representative.

Expired polymer. Check expiration of polymer. If necessary, change 
the lot.

Migration time becomes 
progressively faster.

Water in syringe resulting in diluted 
polymer.

Clean the syringe and dry it.

Extra peaks in the 
electropherogram.

Data off scale. Dilute the sample and re-inject the sample.

Possible contaminant in sample. Re-amplify the DNA.

Sample renaturation. Heat-denature the sample in good-quality 
formamide and immediately place on ice.

CHEMICAL HAZARD. Formamide 
causes eye, skin, and respiratory tract irritation. It 
is a possible reproductive and birth defect hazard. 
Read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

Peaks exhibit a shoulder 
effect in GeneMapper 
applications.

Sample renaturation. Heat-denature the sample in good-quality 
formamide and immediately place on ice.

CHEMICAL HAZARD. Formamide 
causes eye, skin, and respiratory tract irritation. It 
is a possible reproductive and birth defect hazard. 
Read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

Purging of polymer from 
the polymer reserve 
syringe.

Arcing in the anode gel block. Replace the lower polymer block.

Bubbles in syringes. Remove bubbles.

Leaking polymer at the top 
of either syringe.

Insufficient seal around the Teflon tip of 
the plunger.

Make sure to wet the Teflon before filling the 
syringe with polymer. If the leaking persists, 
replace the syringe.

Note: Do not mix and match barrels and plungers

Leaking polymer at the 
bottom of the polymer-
reserve syringe.

Improper tightening of the array ferrule 
knob to the syringe or/and to the 
polymer block.

Ensure the array ferrule knob is tightened. 

Error message, “Leak 
detected” appears. The run 
aborts.

Air bubbles in the polymer path. Check for bubbles and remove if present. Then, 
look for leaks. 

Troubleshooting run performance (continued)

Observation Possible Cause Recommended Action
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Software

Buffer jar fills very quickly 
with polymer.

Air bubbles in the polymer path. Check for bubbles and remove if present. Bubbles 
can cause polymer to fill the jar.

Detection window pops 
out while replacing the 
capillary array. Replacing 
the window in the correct 
orientation is difficult.

Tightening of the array ferrule knob at 
the gel block causes high tension.

Loosen the array ferrule knob to allow the secure 
placement of the window. Retighten and close the 
detection door.

Detection window stuck. It 
is difficult to remove when 
changing the capillary 
array.

To loosen the detection window:

1. Undo the array ferrule knob and pull the 
polymer block towards you to first notch.

2. Remove the capillary comb from the holder in 
oven.

3. Hold both sides of the capillary array around 
the detection window area, and apply gentle 
pressure equally on both sides.

4. Release.

Troubleshooting run performance (continued)

Observation Possible Cause Recommended Action

Troubleshooting software  

Observation Possible Cause Recommended Action

Autoanalysis does not occur. Do Autoanalysis was not selected in 
the Results Group.

Select Do Autoanalysis in the 
Analysis tab of the Results Group.

Autoanalysis using SeqScape and 
GeneMapper software does not 
occur, and Do Autoanalysis is 
selected in the Results Group.

For SeqScape and GeneMapper 
software, the log in name and 
password are incorrect or missing.

Enter the proper log in name and 
password in the Analysis tab of the 
Results Group.

Linked plates become unlinked and 
unlink plate message occurs.

Used a wizard. All linked plated are 
automatically unlinked when any of 
the wizards are used.

Relink the plates after completing all 
wizards.

Cannot set active spectral 
calibration.

Instrument is running a module. Set active spectral before starting a 
run.

Error message occurs while using 
manual control.

Restart the computer and instrument 
to recover.
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Cannot link a plate. Wrong array length installed for the 
Instrument protocol selected.

The software validates the array 
length in the database against the 
array length selected in the 
instrument protocol. 

Either change the array or edit the 
Instrument protocol using the correct 
length. Set or verify the active 
spectral calibration before starting 
the run.

Cannot import my plate record 
created in Microsoft® Excel.

Plate record was saved as an Excel 
document (.xl s extension).

Save the plate record as a tab 
deliminated text document (.txt 
extension), then import the plate 
record into data collection.

Run will not start, and System Status 
is blinking red.

Check the error messages in the 
Event Log:

• Database is full

1. Extract any unextracted data.

2. In the Database Manager, click 
Cleanup Processed Plates, then 
click OK to confirm.

3. Start run.

• Drive E is full 1. Archive sample files.

2. Delete files and empty the recycle 
bin.

3. Start run.

System Status is blinking red. Check error messages in the Event 
Log.

Take corrective action based on error 
messages.

Troubleshooting software  (continued)

Observation Possible Cause Recommended Action
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Computer Configuration
Applied Biosystems supplies or recommends certain configurations of computer 
hardware, software, and peripherals for use with its instrumentation. 
Applied Biosystems reserves the right to decline support for or impose extra charges for 
supporting nonstandard computer configurations or components that have not been 
supplied or recommended by Applied Biosystems. Applied Biosystems also reserves the 
right to require that computer hardware and software be restored to the standard 
configuration prior to providing service or technical support. For systems that have built-
in computers or processing units, installing unauthorized hardware or software may void 
the Warranty or Service Plan.

Limited Product Warranty

Limited Warranty Applied Biosystems warrants that all standard components of its ABI PRISM® 3100 and 
3100-Avant Genetic Analyzers will be free of defects in materials and workmanship for a 
period of one (1) year from the date the warranty period begins. Applied Biosystems will 
repair or replace, at its discretion, all defective components during this warranty period. 
After this warranty period, repairs and replacement components may be purchased from 
Applied Biosystems at its published rates. Applied Biosystems also provides service 
agreements for post-warranty coverage. Applied Biosystems reserves the right to use 
new, repaired, or refurbished instruments or components for warranty and post-warranty 
service agreement replacements. Repair or replacement of products or components that 
are under warranty does not extend the original warranty period.

Applied Biosystems warrants that all optional accessories supplied with its ABI Prism 
3100 and 3100-Avant Genetic Analyzers , such as peripherals, printers, and special 
monitors, will be free of defects in materials and workmanship for a period of ninety 
(90) days from the date the warranty begins. Applied Biosystems will repair or replace, 
at its discretion, defective accessories during this warranty period. After this warranty 
period, Applied Biosystems will pass on to the buyer, to the extent that it is permitted to 
do so, the warranty of the original manufacturer for such accessories.

With the exception of consumable and maintenance items, replaceable products or 
components used on or in the instrument are themselves warranted to be free of defects 
in materials and workmanship for a period of ninety (90) days.

Applied Biosystems warrants that chemicals and other consumable products will be free 
of defects in materials and workmanship when received by the buyer, but not thereafter, 
unless otherwise specified in documentation accompanying the product.

Applied Biosystems warrants that for a period of ninety (90) days from the date the 
warranty period begins, the tapes, diskettes, or other media bearing the operating 
software of the product, if any, will be free of defects in materials and workmanship 
under normal use. If there is a defect in the media covered by the above warranty and the 
media is returned to Applied Biosystems within the ninety (90) day warranty period, 
Applied Biosystems will replace the defective media.
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Applied Biosystems does not warrant that the operation of the instrument or its 
operating software will be uninterrupted or error free. 

Warranty Period
Effective Date

Any applicable warranty period under these sections begins on the earlier of the date of 
installation or ninety (90) days from the date of shipment for hardware and software 
installed by Applied Biosystems personnel. For all hardware and software installed by 
the buyer or anyone other than Applied Biosystems, and for all other products, the 
applicable warranty period begins the date the product is delivered to the buyer.

Warranty Claims Warranty claims must be made within the applicable warranty period, or, for chemicals 
or other consumable products, within thirty (30) days after receipt by the buyer.

Warranty
Exceptions

The above warranties do not apply to defects resulting from misuse, neglect, or accident, 
including without limitation: operation with incompatible solvents or samples in the 
system; operation outside of the environmental or use specifications or not in 
conformance with the instructions for the instrument system, software, or accessories; 
improper or inadequate maintenance by the user; installation of software or interfacing, 
or use in combination with software or products, not supplied or authorized by 
Applied Biosystems; and modification or repair of the product not authorized by 
Applied Biosystems.

THE FOREGOING PROVISIONS SET FORTH APPLIED BIOSYSTEMS’ 
SOLE AND EXCLUSIVE REPRESENTATIONS, WARRANTIES, AND 
OBLIGATIONS WITH RESPECT TO ITS PRODUCTS, AND 
APPLIED BIOSYSTEMS MAKES NO OTHER WARRANTY OF ANY KIND 
WHATSOEVER, EXPRESSED OR IMPLIED, INCLUDING WITHOUT 
LIMITATION, WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE, WHETHER ARISING FROM A STATUTE OR 
OTHERWISE IN LAW OR FROM A COURSE OF DEALING OR USAGE OF 
TRADE, ALL OF WHICH ARE EXPRESSLY DISCLAIMED.

Warranty
Limitations

THE REMEDIES PROVIDED HEREIN ARE THE BUYER'S SOLE AND 
EXCLUSIVE REMEDIES. WITHOUT LIMITING THE GENERALITY OF THE 
FOREGOING, IN NO EVENT SHALL APPLIED BIOSYSTEMS BE LIABLE, 
WHETHER IN CONTRACT, TORT, WARRANTY, OR UNDER ANY STATUTE 
(INCLUDING WITHOUT LIMITATION, ANY TRADE PRACTICE, UNFAIR 
COMPETITION, OR OTHER STATUTE OF SIMILAR IMPORT) OR ON ANY 
OTHER BASIS, FOR DIRECT, INDIRECT, PUNITIVE, INCIDENTAL, 
MULTIPLE, CONSEQUENTIAL, OR SPECIAL DAMAGES SUSTAINED BY 
THE BUYER OR ANY OTHER PERSON OR ENTITY, WHETHER OR NOT 
FORESEEABLE AND WHETHER OR NOT APPLIED BIOSYSTEMS IS 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, INCLUDING 
WITHOUT LIMITATION, DAMAGES ARISING FROM OR RELATED TO 
LOSS OF USE, LOSS OF DATA, FAILURE OR INTERRUPTION IN THE 
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OPERATION OF ANY EQUIPMENT OR SOFTWARE, DELAY IN REPAIR OR 
REPLACEMENT, OR FOR LOSS OF REVENUE OR PROFITS, LOSS OF 
GOOD WILL, LOSS OF BUSINESS, OR OTHER FINANCIAL LOSS OR 
PERSONAL INJURY OR PROPERTY DAMAGE.

NO AGENT, EMPLOYEE, OR REPRESENTATIVE OF 
APPLIED BIOSYSTEMS HAS ANY AUTHORITY TO MODIFY THE TERMS 
OF THIS LIMITED WARRANTY STATEMENT OR TO BIND 
APPLIED BIOSYSTEMS TO ANY AFFIRMATION, REPRESENTATION, OR 
WARRANTY CONCERNING THE PRODUCT THAT IS NOT CONTAINED IN 
THIS LIMITED WARRANTY STATEMENT, AND ANY SUCH 
MODIFICATION, AFFIRMATION, REPRESENTATION, OR WARRANTY 
MADE BY ANY AGENT, EMPLOYEE, OR REPRESENTATIVE OF 
APPLIED BIOSYSTEMS WILL NOT BE BINDING ON 
APPLIED BIOSYSTEMS, UNLESS IN A WRITING SIGNED BY AN 
EXECUTIVE OFFICER OF APPLIED BIOSYSTEMS.

THIS WARRANTY IS LIMITED TO THE BUYER OF THE PRODUCT FROM 
APPLIED BIOSYSTEMS AND IS NOT TRANSFERABLE.

Some countries or jurisdictions limit the scope of or preclude limitations or exclusion of 
warranties, of liability, such as liability for gross negligence or wilful misconduct, or of 
remedies or damages, as or to the extent set forth above. In such countries and 
jurisdictions, the limitation or exclusion of warranties, liability, remedies or damages set 
forth above shall apply to the fullest extent permitted by law, and shall not apply to the 
extent prohibited by law.

Damages, Claims, and Returns

Damages If shipping damage to the product is discovered, contact the shipping carrier and request 
inspection by a local agent. Secure a written report of the findings to support any claim. 
Do not return damaged goods to Applied Biosystems without first securing an inspection 
report and contacting Applied Biosystems Technical Support for a Return Authorization 
(RA) number.

Claims After a damage inspection report is received by Applied Biosystems, 
Applied Biosystems will process the claim unless other instructions are provided.

Returns Do not return any material without prior notification and authorization. 

If for any reason it becomes necessary to return material to Applied Biosystems, contact 
Applied Biosystems Technical Support or your nearest Applied Biosystems subsidiary 
or distributor for a return authorization (RA) number and forwarding address. Place the 
RA number in a prominent location on the outside of the shipping container, and return 
the material to the address designated by the Applied Biosystems representative.
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3100 basecaller and DyeSet/Primer files 276

3100/3100-Avant Data Collection software
starting 8

3100/3100-Avant software integration 99, 124

3100-Avant basecaller and DyeSet/Primer files 278

A
Administration Tool 253

air bubbles, clearing 228

Analysis Protocol
deleting 88, 114
editing 87, 114
export 88
import 89

analyzing GeneMaper data 193

and 99, 124

Applied Biosystems
contacting 306
customer feedback on documentation x
Services and Support 306
Technical Communications x
Technical Support 306

array-fill syringe
volume and function 216
See also syringe

assumptions, for using this guide ix

Australian EMC standards xxi

autoanalysis 99, 124

Autoanalysis Manager
components 180
explained 100
starting 166

automated SeqScape analysis 100

automatic analysis, before you start 101

autosampler 17, 204
calibrating 231
controlling. See manual control commands
placing plates 154
will not move forward 280

B
basecaller files 276, 278

biohazardous waste, handling xviii

bold text, when to use ix

buffer
discussed 15
hazards 22
making and storing 206

C
Canadian safety standards xxi

capillary array
installing and removing 209
maintenance 209–215
poor performance 290
selecting the length 11
storing off the instrument 215
storing on the instrument 215

CAUTION
description xii
example xii

characters
acceptable 73, 99, 124

chemical safety xvi

chemical safety guidelines xvi

chemical waste
hazards xvii
safety xvii
safety guidelines xvii

chemical waste disposal, guidelines xvii

claims, processing 298

cleaning instrument, routine 200

Commands 252, 255

compressed fluids, hazard xix

computer
checking hard drive space 236
configuration requirement 296
frozen 280
technical support for altered configuration 296

conventions
bold text ix
IMPORTANTS! ix
in this guide ix
italic text ix
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menu commands ix
Notes ix
user attention words ix

conventions, safety xii

creating
analysis protocol for autoanalysis 83, 110
GeneMapper plate record for autoanalysis 144
SeqScape plate record for autoanalysis 119
Sequencing Analysis plate record for 

autoanalysis 96
Creating a New Profile 259

Creating a New User 256

current, troubleshooting 289

customer feedback, on Applied Biosystems 
documents x

customizing run modules 82

D
damage, reporting 298

damaged items, returning 298

DANGER
description xii
example xii

data
none in capillaries 284
viewing analyzed sequencing data 193

data collection 124

Data Collection software
will not launch 280

data collection software
integration with SeqScape 99

data collection software, starting 8

database
deleting records 240

detection cell, cleaning 209

documentation
feedback x
related to this guide x

Dye Primer chemistry, files 277

Dye Terminator chemistry, files 276, 278

DyeSet/Primer files 276, 278
list of 85, 111

E
electrical hazard symbol xiii

electrical safety xviii

electrical shock hazards xviii

electrical symbols, on instruments xiii

electromagnetic compatibility standards. See EMC 
standards

elevated baseline 287

EMC standards xxi
Australian xxi
Canadian xxi
European xxi

ergonomic safety xx

European EMC standards xxi

European safety standards xxi

event viewer, blank 280

F
Fill Capillary Wizard 214

Filter Command 252

find all plate search 156

fragment analysis
data analysis 193
polymer to use 12
run modules 133
run times 167

G
gel block. See polymer blocks

GeneMapper
computer name 125
generic 125

GeneMapper automation required files
instrument protocol 127
results group 127

GeneMapper™ Software v3.5 and GeneMapper™ ID 
Software v3.1 124

general hazard symbol xiii

guidelines
chemical safety xvi
chemical waste disposal xvii
chemical waste safety xvii
waste disposal xviii

H
hard drive space

automatic checking 167
hard drive space, checking 236

hazard icons
accompanying safety alert words xii
components xii
described xii
in documents xii
on instruments xii, xiii
See also hazard symbols
See also safety symbols

hazard symbols
electrical xiii
general xiii
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hot surface xiii
in documents xii
laser hazard xiii
moving parts xiii
on instruments xiii
See also hazard icons
See also safety symbols

hazards
chemical waste xvii
electrical shock xviii
laser xix
moving parts xviii
moving/lifting instrument xv
physical xviii
pressurized fluids xix
repetitive motion xx
solvents xix

I
IMPORTANT

description xii
example xii

IMPORTANTS!, description ix

Install Capillary Wizard 211

installation category xviii

instrument
cleaning, routine 200
moving and leveling 200
operation 164
resetting 202
setup 10
shutdown 203

instrument operational safety, instructions for xv

integrating GeneMapper and data collection 
software 124

integrating SeqScape and data collection software 99

invalid characters in names 73, 99, 124

italic text, when to use ix

L
labels, instrument safety xiv

laser
controlling. See manual control commands

laser hazard xix
symbol xiii
warnings xx

laser safety xix
laser classification xix
requirements xix

Launching Data Collection software 8

"Leak detected" 291

linking a plate 155

loss of resolution 288

low signal strength 286

M
maintenance task lists 198

matrix standards
preparing for sequencing 37

menu commands, conventions for describing ix

migration time, too fast or too slow 291

moving and lifting
computer xv
monitor xv

moving and lifting instrument, safety xv

moving parts
hazard xviii
hazard symbol xiii
safety xviii
symbol xviii

moving the instrument 200

MSDSs
description xvi
obtaining xvi
referring to xvii
when to review xv

MSDSs, obtaining 306

N
Name Selection 254

"No candidate spectral files found" 282

Notes, description ix

O
oven, controlling. See manual control commands

Overview 246

overvoltage category (rating) xviii

overvoltage rating xviii

P
pausing a run 168

peaks, troubleshooting 291

physical hazard safety xviii

physical hazards xviii

plate record
creating for GeneMapper autoanalysis 144
creating for SeqScape autoanalysis 119
creating for Sequencing Analysis autoanalysis 96

plate records
discussed 75, 101, 127
linking and unlinking 155
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plate search
find all 156

plates
assembling 152
linking and unlinking from plate records 155–159
placing onto autosampler 154
unlinking from plate records 159

polymer
selecting 12
when to add or change 13

polymer blocks
air bubbles 228
cleaning 224
removing 223

polymer-reserve syringe
volume and function 216
See also syringe

pressurized fluids
hazards xix
safety xix
See also compressed gases

Properties Panes 254

R
RA number 298

RA number. See return authorization number

radioactive waste, handling xviii

Reason For Change 242

red status light 280

reextraction panel
effects of changes made in 186

removing air bubbles 228

repetitive motion hazard xx

reporting, damages 298

reservoirs
filling 16
positions on the autosampler 17, 204

resetting the instrument 202

resolution, loss 288

return authorization (RA) number 298

returning damaged items 298

returns 298

run
elevated baseline 287
elevated current 289
fast migration time 291
fluctuating current 290
high signal 285
length of time 167
loss of resolution 288
low signal 286
no current 289
no signal 285

scheduling 160
slow migration time 291
starting 164
starting, stopping, skipping, pausing 168
stopped before autoextraction is complete 186

run modules
selecting for fragment analysis 133
selecting for sequencing 44, 80, 107

running buffer, making and storing 15

S
safety

before operating the instrument xv
chemical xvi
chemical waste xvii
conventions xii
electrical xviii
ergonomic xx
instrument xv
instrument operation xv
laser xix
moving and lifting instrument xv
moving parts xviii
physical hazard xviii
solvents xix
standards xxi
workstation xx

safety alert words
accompanying hazard icons xii
CAUTIONS xii
DANGERS xii
description xii
IMPORTANTS xii
WARNINGS xii

safety labels, on instruments xiv

safety requirements, laser xix

Safety standards
U.S. xxi

safety standards
Canadian xxi
European xxi

safety symbols
on instruments xiii
See also hazard symbols

sample
preparation 22
run order 160

sample file destinations 186

samples
autoanalyzing 180

SeqScape automation required files
analysis protocol 101
instrument protocol 101
results group 101

SeqScape Software v2.1 99
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sequencing
data, automating the analysis 100
matrix standards 37
plate editor 75, 102
polymer to use 12
run modules 44, 80, 107
run times 167
viewing analyzed data 193

Sequencing Analysis Software v5.0 99

Sequencing Analysis Software v5.1 73

sequencing automation required files
analysis protocol 75
instrument protocol 75
results group 75

sequencing chemistry
supported kits 34

service console
using 8

Services and Support, obtaining 306

set (activate) spectral calibration 59

shut down 203

signal too high 285

software
integration 99, 124
starting 8

solvents, safety xix

spatial calibration
evaluating profiles 27
failed 29
persistently bad results 281
unusual peaks 281
when required 26

spatial maps 26

spectral calibration
evaluating results 52
failure 56
if a capillary fails 56
if all capillaries fail 57
no signal 282
override capillaries 56
preparing standards for 37
run times 49
set spectral calibration 59

standards
EMC xxi
safety xxi

starting
run 168
spectral calibration run 49

status lights
on instrument startup 7

stopping a run 168

supported sequencing chemistry kits 34

symbols

hazard xiii
hot surface xiii
moving parts xviii

symbols on instruments
electrical xiii
safety xiii

syringe
installing and removing 221
maintenance 216–222
priming and filling 218

syringes
controlling. See manual control commands
leaking 291

T
Technical Communications

contacting x
e-mail address x

Technical Support, contacting 306

technical support, for computers with altered 
configuration 296

toolbar 168

training, obtaining information about 306

tray. See plates

Type Selection 254

U
unlinking a plate 159

Update Cap Array Info wizard 212

US safety standards xxi

user attention words, defined ix

User Properties 258

using
service console 8

V
Viewing an Audit History 251

W
WARNING, description xii

warranty
damages, claims, returns 298
exceptions 297
for computers with altered configuration 296
limitations 297
period 296

warranty claims 297

warranty exceptions 297

warranty period, effective date 297

waste disposal, guidelines xviii
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Autosampler Calibration 231
Fill Capillary Wizard 214
Install Capillary Array 210
Install Capillary Wizard 211
Update Cap Array Info 212

workstation safety xx

Z
Audit Map Configuration Functions 247

Commands 248
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